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Preface

Preface

Audience

The Modeling Inventory Help is loaded into Oracle Communications Service Catalog and
Design - Design Studio when the Design Studio for Inventory feature is installed into Design
Studio. In Design Studio, clicking Help displays relevant Help topics.

This guide is intended for business analysts, architects, development managers, developers,
and designers who are responsible for system integration or solution development involving
the Oracle Communications operational support systems applications.

Ideally, you should be knowledgeable about your company's business processes, the
resources you need to model, and any products or services your company offers.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My
Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Diversity and Inclusion

ORACLE

Oracle is fully committed to diversity and inclusion. Oracle respects and values having a
diverse workforce that increases thought leadership and innovation. As part of our initiative to
build a more inclusive culture that positively impacts our employees, customers, and partners,
we are working to remove insensitive terms from our products and documentation. We are also
mindful of the necessity to maintain compatibility with our customers' existing technologies and
the need to ensure continuity of service as Oracle's offerings and industry standards evolve.
Because of these technical constraints, our effort to remove insensitive terms is ongoing and
will take time and external cooperation.

Xiv
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Getting Started with UIM

You use the Oracle Communications Unified Inventory Management (UIM) feature for Oracle
Communications Service Catalog and Design - Design Studio to create and maintain
specifications and other content that define inventory entities and their behavior in UIM.
Specifications can describe physical inventory items (such as routers or interface cards) or
intangible items such as roles, business interactions, and addresses. You use specifications as
blueprints for the various kinds of entities contained in your inventory.

When getting started with UIM, see the following topics:

About Creating Specifications and Other Inventory Content

Design Studio Users and Tasks

About Creating Specifications and Other Inventory Content

There is no set pattern to the way you use Design Studio to create specifications and other
inventory-related content for UIM. The following list provides a high-level overview of the tasks
you perform to create new content for UIM along with links to the help topics about those tasks:

ORACLE

Create a project to contain the specifications and rulesets that you develop.

Each project is mapped to directories in the file system and is a collection of files and
folders. See the “Working with Design Studio Projects” for information about creating and
opening projects.

Define entity specifications.

Specifications are the blueprints used to create inventory entities in UIM. There are many
different types of entities, such as logical devices, equipment, telephone numbers, roles,
places, and so on. See "Creating New Specifications" for general information about entity
specifications. See the sections about the various specification types for detailed
information about them.

When you define a specification, you enter its properties, establish relationships of various
kinds with other specifications, specify its layout, and more. See "Defining Specification
Properties", "Defining Specification Relationships”, and "About Specification Layouts" for
more information.

Define characteristics and add them to specifications.

Characteristics define items of data that you want to collect, such as serial numbers,
settings, dates, and so on. The same characteristic can be used in multiple specifications.
See "Creating Characteristics" and "Adding Characteristics to Specifications" for more
information.

Defining configurations.

Some types of entity specifications can be associated with configurations. Configurations
define the resources that can be assigned to an entity and provide a record of the evolution
of facts about the entity over time. See "Creating Configuration Specifications" for more
information.

Define rulesets and related entities.

1-1



Chapter 1
Design Studio Users and Tasks

You use rulesets to customize UIM behavior. Rulesets are associated with extension
points, which determine when the rule is applied. See UIM Developer's Guide and
"Working with Rulesets and Extension Points" for more information.

*  Prepare for deployment into UIM.

Design Studio automatically builds cartridges from UIM projects. Before deployment, you
should clean the project and resolve any errors. See “Reviewing the Error Log" and

“Problems View" for more information.

Design Studio Users and Tasks

There are three primary groups of users for the Inventory features of Design Studio:

*  Modelers
e Cartridge Developers

e Deployment Managers

Modelers

Modelers are responsible for developing and extending complex models of services, networks,
and other parts of your inventory. This involves the following tasks:

Task

Reference

Creating Entity Specifications

Creating New Specifications

For information about particular kinds of
specifications, see the individual sections about
them.

Creating Characteristics

Creating Characteristics

Creating Configurations

Creating Configuration Specifications

Cartridge Developers

Cartridge developers can perform the tasks mentioned previously, and also write the rulesets,
extension points, and other entities required to customize UIM behavior. See UIM Developer's
Guide for more information about development tasks and procedures.

In addition to modeling, this involves the following tasks:

Task

Reference

Creating entity identification specifications

Working with Entity Identification Specifications

Creating sequence specifications

Working with Sequence Specifications

Creating extension points

Working with Extension Points
Working with Enabled Extension Points

Creating rulesets

Working with Rulesets

Creating ruleset extension points

Working with Ruleset Extension Points

Extending cartridge packs

About Cartridge Packs and Cartridges
Extending Cartridge Packs and Cartridges

ORACLE
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Deployment Managers

Creating Inventory Cartridge Projects

ORACLE

Chapter 1

Creating Inventory Cartridge Projects

Deployment managers are responsible for build management and are usually advanced users
of the version control system. Activities performed by deployment managers may include:

Task

Reference

Importing cartridges

About Imported Inventory Cartridge Projects

Cleaning projects

Running Clean Builds

Resolving build issues

Reviewing the Error Log and Problems View

Reviewing error logs

Reviewing the Error Log

Design Studio cartridge projects are collections of folders and files that represent the content
you are working on. They are used for builds, version management, sharing, and resource
organization. Cartridge projects map to directories in the file system. When you create a
cartridge project, you specify a location for it in the file system. Design Studio uses the files
and folders in a project to build a cartridge that you can import into UIM. Each Inventory project
corresponds to a cartridge. See “Working with Design Studio Cartridge Projects"” for more

information.

Related Topics

Project Editor

1-3



Working with Specifications

Many entities in Oracle Communications Unified Inventory Management (UIM) are defined by
specifications, which you create in Oracle Communications Service Catalog and Design -
Design Studio. There are different types of specifications for different types of entities. For
example, UIM includes specifications for telephone numbers, networks, physical devices, and
inventory groups.

Specifications provide a way to classify entities and augment them with additional properties,
called characteristics. For example, you can create a Service specification to define a DSL
service and associate characteristics to the specification for the properties that you want to
capture on DSL services at run time.

In addition, you can associate rulesets and extension points to specifications to extend or
customize the run-time behavior of entities created from the specifications. See "Working with
Rulesets and Extension Points" for more information.

You can relate specifications to other specifications to affect behavior in UIM. For example, you
can relate Inventory Group specifications to Telephone Number specifications to limit the types
of inventory groups in which a telephone number can be included.

# Note:

The procedures for working with specifications assume that you are working in the
Studio Design perspective.

When working with specifications, see the following topics:

e About the Specification Editor

e About Specification Relationships

e About Configuration Specification Usage
e Creating New Specifications

e Configuring Specifications

e Specification Editor

e Inventory Entity Editor

About the Specification Editor

The Specification editor can contain many different tabs. Some of these tabs are specific to a
small subset of specifications, and others are relevant to most specifications. The following
tabs appear in most specification editors:

e Characteristics: Defines characteristics associated with the specification. See "Adding
Characteristics to Specifications" for more information.

ORACLE o1



Chapter 2
About Specification Relationships

* Specification Properties: Defines basic information about a specification. See "Defining
Specification Properties" for more information.

» Related Specifications: Defines relationships between a specification and other
specifications. See "Defining Specification Relationships" for more information.

* Configuration Spec Usage: Defines the configuration specifications and configuration
items in which a specification is listed as an option. This tab enables you to add
specification options to configuration items without having to modify the configuration
specification. See "Defining Configuration Specification Usage" for more information.

* Rules: Defines rulesets and extension points that extend or customize the behavior of
entities created from the specification. See "Associating Specification-Based Extension
Points to Rulesets" for more information.

* Layouts: Defines how the properties of entities created from the specification appear in
various pages of the UIM user interface. See "About Specification Layouts" for more
information.

* Media: Defines any media files associated with the specification. See "Adding Media to a
Specification” for more information.

* Extends: Defines the entity type that is defined by the specification. See "Reviewing
Specification Extensions" for more information.

Most Specification editor tabs include the Display Name field, where you can enter the name
that appears in Design Studio editors and in UIM. Design Studio supports multiple languages
for this field. The field adjacent to Display Name displays your list of languages. You can
define a display name for any language you select from the list.

If your preferences are set up to work in one language only, the system displays only the
[default] option. See “Defining Language Preferences" for more information.

Related Topics

Specification Editor

About Specification Relationships

ORACLE

You can relate a specification to other specifications to affect run-time behavior in UIM. For
example, UIM uses a Physical Port specification relationship to an Equipment specification to
automatically create ports on equipment. See UIM Information Model Reference for more
information about specification relationships recognized and used in UIM.

Specification relationships can also be used in customized logic using rulesets and extension
points. See "Working with Rulesets and Extension Points" for more information.

You can create child and parent relationships between any specifications in the current
workspace, including specifications in other projects. For example, you can create a
relationship between a specification you have created in a new project and another
specification in a sealed cartridge pack. See "Extending Cartridge Packs and Cartridges by
Adding Content" for more information.

Creating a relationship with a specification in another project creates a dependency between
the cartridges built from the two projects. The required cartridge must be deployed into UIM
before the cartridge that requires it.

Related Topics

Defining Specification Relationships
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Chapter 2
About Configuration Specification Usage

Specification Editor Related Specifications Tab

About Configuration Specification Usage

You can define the configuration items in which a specification is listed as an option. These
specification options define the type of entities that may be referenced or assigned to other
entities on a configuration. For example, you can define that telephone numbers created from
a certain specification can be assigned to entities that use a certain configuration specification.

You can add specification options to configuration items without having to modify the
configuration specification. This is a useful way to extend a cartridge pack. See "Extending
Cartridge Packs and Cartridges by Adding Content" for more information about extending
cartridge packs.

If you are not extending a cartridge pack or an external cartridge, define configuration items
and specification options from the configuration specification. See "Adding Configuration
ltems".

You can specify any configuration specification that is in the current workspace. If you specify a
configuration specification that is in another project, you create a dependency between the
cartridges. The cartridge containing the configuration specification must be deployed into UIM
before the cartridge that contains the specification that refers to the configuration.

Related Topics
Defining Configuration Specification Usage

Specification Editor Configuration Spec Usage Tab

Creating New Specifications

ORACLE

The procedure for creating specifications is the same for all specification types. When creating
new specifications, you must specify a project. See “Creating New Cartridge Projects" for more
information.

To create a new specification:

1. From the Studio menu, select New, then select Inventory, then select a conceptual
division, and then select a specification type.

The Specification Wizard appears.

2. Inthe Project field, select the name of the project to which the new specification should be
added.

3. Inthe Name field, enter a name for the new specification.

The name must be unique among specification types in the same namespace. This is the
name that will appear in UIM.

4. (Optional) Select a location for the new specification.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.
b. Navigate to the directory in which to save the entity.
c. Click OK.

2-3



Chapter 2
Configuring Specifications

5. Click Finish.

Design Studio creates the new specification and displays its information in a Specification
editor.

Related Topics
Configuring Specifications

Specification Editor

Configuring Specifications

After you create a specification, you can define how it relates to other specifications, use rules
to control its behavior in UIM, and add characteristics to capture details that are not included in
the entity type defined by the specification.

When configuring specifications, see the following topics:
» Defining Specification Properties

» Defining Specification Relationships

» Defining Configuration Specification Usage

e About Specification Layouts

e Adding Media to a Specification

* Reviewing Specification Extensions

«  Copying Specifications

Defining Specification Properties

ORACLE

You can define basic information about a specification, such as a display name, a description,
and the dates during which the specification is valid.

To define specification properties:

1. In a Specification editor, click the Specification Properties tab.
2. (Optional) In the Description field, enter a description for the specification.
3. (Optional) In the Start Date and End Date fields, enter the specification's validity dates.

If you leave the Start Date field blank, the application sets it to the date on which the
cartridge was built in Design Studio. Leaving the End Date field blank means that the
specification is valid indefinitely.

4. (Optional) If instances of this specification can be assigned to more than one instance of a
consumer entity at the same time, select the Can be assigned to multiple entities check
box.

This check box appears only if the entity type associated with the specification can be
assigned to entity types that are referred to as consumer entity. Consumer entity types
include Service, Geographic Site, Logical Device, Network, Pipe, and Pipe Termination
Point.

5. (Optional) If instances of this specification can assign entities whose specifications allow
them to be assigned to multiple instances of consumer entities at the same time, select the
Can assign entities that allow multiple assignments check box.
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This check box appears only if the entity type associated with the specification is a
consumer entity. Consumer entity types include Service, Geographic Site, Logical Device,
Network, Pipe, and Pipe Termination Point.

6. (Optional) To enter an ID for this entity instance, select Enter Id Manually.

If this check box is not selected, the ID for this entity instance is auto-generated.
7. (Optional) Associate to the specification an Entity ID specification.

Do one of the following:

» Click Entity ID Specification to associate with the specification a new Entity ID
specification.

* Click Select to associate with the specification an existing Entity ID specification.
See "Working with Entity Identification Specifications" for more information.

8. From the File menu, select Save.

Related Topics

Specification Editor Specification Properties Tab

Defining Specification Relationships

ORACLE

You can define relationships between specifications in the current workspace, including
specifications in other projects. These specification relationships affect the behavior of entities
in UIM. For example, listing Equipment Holder specifications in the Equipment Holders
section of the Related Specifications tab of an Equipment specification means that
Equipment entities based on this specification can provide only equipment holders based on
the related specifications.

Each entity type has a different set of valid possible specification relationships. The Related
Specifications tab has sections for the valid specification relationships. The Related
Specifications tab also includes an Others section where you can include specifications to
which you want to establish a custom relationship. Custom relationships require that you
create rulesets to trigger behaviors and actions in UIM.

When you define a specification relationship, its properties are set to default values. You can
modify the properties after the relationship has been defined.

To define specification relationships:
1. In a Specification editor, click the Related Specifications tab.
2. Scroll to the section for the entity type of the specification relationship you are defining.
3. Click Select.
The Selection Dialog dialog box appears.
4. Do one of the following:
« Select an existing specification and click OK.

e Click New to create and relate a new specification. See "Creating New Specifications"
for more information.

The specification appears in the Related Specifications tab, which lists the specification
name, the cartridge in which it is located, and the type of relationship (CHILD by default).

5. (Optional) If the relationship is child-to-parent, change the relationship type to PARENT.
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The normal relationship is defined as a child. You must specify a parent relationship only
when the related entity is in a separate cartridge that exists independently. See "Changing
Specification Relationship Properties" for more information.

6. From the File menu, select Save.

Related Topics
Changing Specification Relationship Properties

Specification Editor Related Specifications Tab

Changing Specification Relationship Properties

After you have defined a relationship between specifications, you can change the relationship's
properties.

To change relationship properties:

1. Open the Specification editor of a specification whose relationship properties you want to
change.

2. Click the Related Specifications tab.
3. Scroll to the section for the entity type of the specification relationship you are modifying.
4. Select a specification from the list and click Modify.
The Relationship Properties dialog box appears.
5. Enter or change relationship properties.

See "Specification Editor Related Specifications Tab" for more information about the
properties that you can change.

6. Click OK.

Design Studio sets the properties and closes the dialog box.

Related Topics

Defining Specification Relationships

Defining Configuration Specification Usage

You can define the configuration items in which a specification is listed as an option. This
process enables you to add specification options to configuration items without having to
modify the configuration specification. This is a useful way to extend a cartridge pack. See
"Extending Cartridge Packs and Cartridges by Adding Content" for more information about
extending cartridge packs.

# Note:

If you are not extending a cartridge pack or an external cartridge, define configuration
items and specification options from the configuration specification. See "Adding
Configuration Items".

To define configuration specification usage:
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1. Open the Specification editor of the specification for which you want to define configuration
specification usage.

2. Click the Configuration Spec Usage tab.
3. Click Select.
The Configuration Types Selection dialog box appears.
4. Select the type of configuration.
5. Click Next.

The Select a Configuration Specification dialog box appears, listing all configuration
specifications of the selected type in all projects in the workspace.

6. Select a configuration specification, then click OK.

The Configuration Iltem Selection dialog box appears, displaying the hierarchy of
configuration items in the selected configuration specification.

7. Do one of the following:
» Select a configuration item, then click OK.

» Click New to create and use a new specification. See "Creating New Specifications"
for more information.

The configuration item is added to the Configuration Spec Usage tab. The name of the
configuration specification, its type, and the cartridge in which it is located are displayed,
along with the path of the selected configuration item.

8. From the File menu, select Save.

Related Topics
About Configuration Specification Usage

Specification Editor Configuration Spec Usage Tab

About Specification Layouts

Specification layouts define how the default data elements, derived data, and characteristics
(of entities defined by the specification) appear in the UIM user interface. You can define this
configuration for each page and panel associated with an entity. In UIM, a page is an area that
serves a function for the entity, and a panel is a section on a page where default data elements
and characteristics of the entity appear.

You can define which default data elements and characteristics of an entity appear on a page
and panel. You can also configure the row on which a default data element or characteristic
appears and the order of elements and characteristics within the row.

Additionally, you can configure user interface settings for a characteristic of an entity. These
settings define how the characteristic appears and behaves on a page or panel.

When defining layouts, see the following topics:
« Defining Specification Layouts

e Defining Characteristic User Interface Settings
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Defining Specification Layouts

ORACLE

You define layouts for specifications to determine the data elements that appear as fields in
UIM. You can define layouts for the characteristics that you define for the specification, and for
all modeled and derived data elements of the entity.

To define layouts:

1.
2.

N

8.

In a Specification editor, click the Layouts tab.
In the Page/Panels field, select a page type for the specification.

You can define different attributes for a characteristic when it appears on different types of
pages. For example, you can define an edit mask for a characteristic when it appears on
an edit page and a display mask for the same characteristic when it appears on a
summary page.

< Note:

The options available in the Page/Panels field are defined in the ora_uim_mds
project. You must import and open this project and the ora_uim_model project in
your workspace before modeling UIM entities in Design Studio.

Select the elements that you want to appear as fields in the run-time user interface.
To select elements, you can:

* Select elements in the Available column, then click the arrow to move them to the
Selected column.

e Shift-select multiple elements to move them as a group.
Remove elements that you do not want to appear in the user interface.

Select an elemen in the Selected column then click the arrow to move it to the Available
column.

Change the order in which the elements appear.

Select an element in the Selected column and then click an arrow to reposition the
element.

For Edit Panel layouts, change the distribution of the elements in the layout.
Do any of the following:

* Right-click in the Selected Elements area at the desired location and select Insert
New Row to create a new row.

* Right-click in the Selected Elements area on an existing row and select Delete New
Row to remove an existing new row marker.

(Optional) To return the layout to the default version, click Reset.

From the File menu, select Save.

Related Topics

Specification Editor Layouts Tab

Defining Characteristic User Interface Settings
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Defining Characteristic User Interface Settings

You define user interface settings for each characteristic to determine how the characteristic
appears and behaves on each page and panel in UIM.

To define characteristic user interface settings:

1. In a Specification editor, click the Layouts tab.
2. Inthe Selected column, select a characteristic.

The configurable options for the characteristic appear in the Ul Settings area.

< Note:

You can configure user interface settings only for characteristics.

3. Define the user interface options for each characteristic.
See “Settings Tab" for information about the options.

4, From the File menu, select Save.

Related Topics
Specification Editor Layouts Tab

Defining Specification Layouts

Adding Media to a Specification

Media files can be associated to a specification and are used in UIM to display an image of an
entity instance created from the specification. Media files are used in UIM to display an entity
as anicon in a tree view, as a node in a network visualization, as a node in a service topology
visualization, and as a card in an equipment visualization.

To add a media file to a specification:
1. In a Specification editor, click the Media tab.
2. Click Add.
The Open dialog box appears.
3. Select afile, then click Open.
The path to the selected media file appears in the Media tab.

4. Click the Media Type field, then select a type.

# Note:

Only one media type can be selected per row. To use the same image for more
than one purpose, you must add it to a new row and select an additional media

type.

5. From the File menu, select Save.
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Related Topics

Specification Editor Media Tab

Reviewing Specification Extensions

To review a specification extension:

1.
2.

3.
4.

In a Specification editor, click the Extends tab.
Review the value in the Extends field.

Design Studio automatically populates the value in the Extends field when you create new
specifications. You can remove the value, but you cannot make a different selection.

(Optional) To open the business entity that is extended by the specification, click Extends.

(Optional) To remove the association, click Clear.

Related Topics

Specification Editor Extends Tab

Copying Specifications

You can copy specifications from one project to another. For example, you can extend a
cartridge pack by copying a specification into your own project and make any necessary
modifications.

To copy specifications:

1.
2
3.

From the Studio menu, select Show Design Perspective.
Click the Cartridge tab.

In the Solution view, locate the target specification.

The project must exist in the same workspace. See “Importing Projects" for information.
Right-click the target specification and select Copy.
Navigate to the source project.

Right-click the source project and select Paste.

The Set Name of Copy dialog box appears.

In the Name field, enter a uniqgue name for the specification.
Specification names must be unique in the workspace.
Click OK.

The specification is added to the source project.

Specification Editor

Use the Specification editor to configure properties for a specification. The specification tabs
referenced below are used by most specification types and are the same or similar for each
type. For information about tabs that are specific to a specification type, see the Help for that
specification type.

ORACLE

When working with specification tabs, see the following topics:
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e Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab

e Specification Editor Related Specifications Tab

«  Specification Editor Configuration Spec Usage Tab
e Specification Editor Rules Tab

e Specification Editor Layouts Tab

»  Specification Editor Media Tab

e Specification Editor Extends Tab

Specification Editor Characteristics Tab

Use the Characteristics tab to create, select, edit, and remove characteristics. See "Creating
Characteristics" and "Adding Characteristics to Specifications" for more information about
adding characteristics to Specification editors.

# Note:

The default data elements that appear in the Characteristics tab data tree are
inherited from the extended entity, defined in the ora_uim_model project. These
default data elements are read-only.

When working with the Specification editor Characteristics tab, see the following topics:
*  About the Characteristics Tab Context Menu

¢ Details Tab

* Notes Tab

e Usage Tab

e Characteristics Tab Data Values Subtab

About the Characteristics Tab Context Menu

The Characteristics tab context menu contains actions specific to data elements tagged as
characteristics. To access these actions, right-click in the left column of the tab. The context
menu options that are available depend on the selection in the editor. For example, the list of
context menu options that appear when you right-click in the white space is different than the
list that appears when you right-click a characteristic.

Command Use
Delete Select to delete the characteristic from the specification.
Refactoring Select to access a menu of options for improving names and locations of

the characteristics. See “Managing Data Element Names and Locations" for
more information.

Refresh Refreshes the view.
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Command

Use

Add Characteristic

Select to create a new data element (that is automatically tagged as a
characteristic) to add to the specification. See "Creating Characteristics" for
more information.

Note: You can add a ‘CLUSTER’ characteristic to the Business Interaction
Specification Characteristics so the Cluster field appears in UIM. You can
use this characteristic to group specifications, set a default cluster value,
and customize clusters as per requirements.

Select Characteristic

Select to add an existing data element (tagged as a characteristic) to the
specification. See “Tags Tab" for more information about tagging data
elements as characteristics.

Characteristics Tab Data Values Subtab

Use the Data Values subtab to define at the specification level values for a drop down list that
do not change (static values).

# Note:

See "Data Schema Editor Characteristics Tab" for information about defining
parameters for drop down lists at the schema level.

Field

Use

Included table

Click the text inside the Code and Description columns to
change the code name and description for the drop down
value.

The value you enter in the Code field is stored in the
database. The value you enter in the Description field is
displayed in the run-time user interface.

Values that are inherited from a base type are read-only.

Click inside the Default column and select Yes to make the
selected value the default value in the run-time environment.

Add

Click to add a new value to the Included table.

Remove

Click to remove a value from the Included table.

Excluded table

Displays inherited values that you want to exclude from the list
of values in the run-time environment. Move values between
the Included and Excluded tables using the arrows to display a
subset of the inherited values as valid values for the
characteristic in the UIM.

Language

Displays the language in which the selected value appears in
UIM.

Specification Editor Specification Properties Tab

Use the Specification Properties tab to enter identifying information about a specification.

ORACLE
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Field

Use

Display Name

Enter the name that appears in Design Studio editors and in
UIM.

Design Studio supports multiple languages for this field. The
field adjacent to Display Name displays your list of languages.
You can define a display name for any language you select
from the list.

If your preferences are set up to work in one language only,

the system displays only the [default] option. See “Defining
Language Preferences" for more information.

Start Date

Enter the first date on which this specification is valid.

End Date

Enter the last date on which this specification is valid.

System Provided

Indicates whether a specification is provided by Oracle.
System-provided specifications enable you to define entity-
level characteristics for IP Address Resource Extension, and
Property Location Extension entities. Additionally, system-
provided specifications can be selected as a specification
option on an item in a configuration specification.

Note: You must import the ora_uim_basespecifications
cartridge (which includes the specifications for extension
entities) before you define characteristics for the extension
entities. For information about the ora_uim_basespecifications
cartridge, see UIM Cartridge Guide.

Can be assigned to multiple entities

Select if the entity created using this specification can be
assigned to more than one instance of a consumer entity at
the same time.

Can assign entities that allow
multiple assighments

Select if an entity created using this specification can assign
entities whose specifications allow them to be assigned to
multiple instances of consumer entities at the same time.

Enter Id Manually

Select if you do not want data instances using this
specification to have an automatically-generated ID. This
check box is displayed only for the entities that are enabled for
auto-generation of ID.

The Entity Identification Specification field is not available
when you select this option.

Entity Identification Specification

Defines the format for an identifier generated for an instance of
the entity created from the specification. This option appears
only for the specification that is enabled for auto-generation of
ID.

Click the Entity Identification Specification to create a new
Entity Identification specification.

Select Click to select an existing Entity Identification specification.
Clear Click to deselect an Entity Identification specification.
Description Enter a description of the specification.

Related Topics

Defining Specification Properties

ORACLE
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Specification Editor Related Specifications Tab

Use the Related Specifications tab to relate a specification to another specification or to

change relationship properties.

The tab is divided into sections where you can define relationships to different entity types.
Only the entity types listed in the tab have meaningful relationships by default in UIM. The
Others section enables you to relate other specifications, but these relationships require
rulesets to trigger behaviors and actions in UIM.

The fields and controls listed below appear in each section.

Field

Use

Specification

Displays the name of the specification.

Cartridge Displays the name of the cartridge project into which the
specification is built.

Type Displays the type of the specification, such as Service
specification or Place specification.

Relationship Indicates that the related entity is designated as either a

parent or a child of the entity being edited. The normal
relationship is defined as a child. You must specify a parent
relationship only when the related entity is in a separate
cartridge that exists independently.

Minimum Quantity and
Maximum Quantity

Displays the minimum number of instances that may be
provided by the relationship and the maximum number of
instances that may be provided by the relationship. Select the
specification row and click Modify to change the values for
these fields.

These fields are not valid for relationships with Role
specifications.

Required

(Role specifications only) Indicates whether the relationship is
required in UIM for entities based on this specification.

Auto-Generated is selected automatically if you select
Required.

Auto-Generated

(Role specifications only) Indicates whether a Role entity
based on the listed specification should be created
automatically in UIM when you create an entity based on the
current specification.

Auto-Generated is selected automatically if you select
Required.

Select

Click to select an existing specification to which you can relate
the selected specification.

ORACLE
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Field Use
Modify Click to modify any of the following relationship properties:
*  Name
e Status
* Relationship
« Required
* Auto-Generated
*  Minimum Quantity.
e Maximum Quantity
*  Description
See "Changing Specification Relationship Properties” for more
information.
Remove Click to remove the related specification.

Related Topics

Defining Specification Relationships

Specification Editor Configuration Spec Usage Tab

Use the Configuration Spec Usage tab to define the configuration specifications and
configuration items in which a specification is listed as an option.

ORACLE

You can use this tab to add specification options to configuration items without having to
modify the configuration specification. This is useful for extending cartridge packs. See
"Extending Cartridge Packs and Cartridges by Adding Content" for more information about

extending cartridge packs.

# Note:

If you are not extending a cartridge pack or an external cartridge, define configuration
items and specification options from the configuration specification.

Field

Use

Configuration Spec

Displays the name of the configuration specification.

Cartridge Displays the name of the cartridge project into which the
configuration specification is built.

Type Displays the type of the configuration specification, such as
Service Configuration specification or Place Configuration
specification.

Item Path Displays the path to the configuration specification item where
the edited specification may be used as a specification option.

Select Click to select an existing configuration specification.

Remove Click to remove the configuration specification.

Related Topics

About Configuration Specification Usage
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Defining Configuration Specification Usage

Specification Editor Rules Tab

Use the Rules tab to extend or customize any UIM specification by adding ruleset extension
points. The ruleset extension point brings together a ruleset, which defines the customized
behavior, and the extension point, which defines when the rule will be run.

For information about extending specifications, see UIM Developer's Guide.

Field

Use

Ruleset Extension Point

Displays the ruleset extension points that are added to a UIM
specification.

Cartridge Displays the name of the cartridge project into which the
ruleset extension point is built.

Select Click to select a ruleset extension point that you want to add to
a UIM specification.

Remove Click to remove a ruleset extension point that is already added
to a UIM specification.

Add Click to add a new ruleset extension point to a UIM

specification.

Related Topics

Associating Specification-Based Extension Points to Rulesets

Specification Editor Layouts Tab

Use the Layouts tab to define which elements appear in UIM for the entities created from the

specification.

See “Settings Tab" for information about the fields that appear in the Ul Settings area.

Field

Use

Display Name

Enter the name that appears in Design Studio editors and in
UIM.

Design Studio supports multiple languages for this field. The
field adjacent to Display Name displays your list of languages.
You can define a display name for any language you select
from the list.

If your preferences are set up to work in one language only,
the system displays only the [default] option. See “Defining
Language Preferences" for more information.

Page/Panels

Select the UIM run-time application page layout type.

You can define different attributes for characteristics when they
appear on different types of pages. For example, you can
define an edit mask for a characteristic when it appears on an
edit page, and a display mask for the same characteristic when
it appears on a summary page.

The options available in this field are defined in the
ora_uim_mds project. You must import and open this project
and the ora_uim_model project in your workspace before
modeling UIM entities in Design Studio.

ORACLE
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Field

Use

Available column

Displays the elements that are available to be displayed as
fields in the run-time user interface, but which are not currently
selected. Use the arrow keys to move the elements between
the Available column and the Selected column.

Selected column

Displays the elements that will appear as fields in the run-time
Ul, and includes the characteristics (defined on the
Characteristics tab) and all derived data. The fields are
displayed in the order in which they appear in the product. Use
the up and down arrow keys to reposition the elements in this
column.

Select a characteristic to view the user interface (Ul) settings.
See “Settings Tab" for more information about the fields in the
Ul Settings area.

See UIM Help for information about how to use these fields in
the UIM run-time environment.

Reset

Click to revert the layout back to the most recently saved
version.

Related Topics

About Specification Layouts

Specification Editor Media Tab

Use the Media tab to add a media file, such as a JPG or GIF file, to a specification. When
adding media files, you can specify the media type to determine the orientation of the image
and how the image is used in the application.

ORACLE

For example, a media file of type front is used to display an entity as a node in a network
visualization, as a node in a service topology visualization, and as an equipment (if the
equipment is of the type CARD) in an equipment visualization. A media type of right would
indicated that the image be used when the right side of the object is displayed. A media of type
icon is used when displaying the equipment in a tree view.

# Note:

UIM uses the media types front and icon only.
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Field

Use

Media Type

Click to select how the media is to be used in the application.
Select:

«  front to represent the front view of the object.

e back to represent the back view of the object.

e top to represent the top view of the object.

*  bottom to represent the bottom view of the object.

* right to represent the right side of the object.

* left to represent the left side of the object.

e tiny to use a small version of the object in tree views.

e icon to use an icon to represent the object.

*  background to represent the background of a
visualization display.

Media File

Displays the path of the media file, such as JPG or GIF, which
you have added to the specification.

Remove

Click to remove a media file.

Add

Click to add a new media file.

Related Topics

Adding Media to a Specification

Specification Editor Extends Tab

Use the Extends tab to inherit the data elements of the corresponding business model entity.

Field

Use

Extends

Click the link to open the selected entity in a Specification
editor.

Click Clear to delete the selection and remove the association.

Click Select to select a business model entity. The
specification inherits all characteristics and default data
elements of the business model entity. Inherited data elements
are read-only.

Realizes

Appears only for specifications that realize conceptual model
entities.

Click the link to open the associated conceptual model entity.
Click Clear to delete the selection and remove the association.

Click Select to associate the specification with a conceptual
model entity from a list of available entities.

Related Topics

Reviewing Specification Extensions

Specification Editor Tags Tab

Use the Tags tab to view, add and remove tags for the entity specification.

ORACLE
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Inventory Entity Editor
Field Use
Add Click to select a tag to add to the specification.
Remove Click to remove the selected tag from the specification.

Related Topics

Working with Tags

Inventory Entity Editor

You use the Inventory Entity editor to review the inventory entities included in the
ora_uim_model project. The editor displays the default data elements defined for the entity
and (when applicable) the base entity from which the entity inherits data elements. This editor
is read-only and is for informational purposes only.

ORACLE 519



Working with Characteristics

A characteristic is a data element that you intend to associate with Oracle Communications
Unified Inventory Management (UIM) specification.

You use characteristics to add additional attributes to specification beyond those that are
available by default for the various specification types. A characteristic can be associated to
multiple entity specifications. When an entity instance is created in UIM from a specification,
that entity includes the characteristics defined at the specification level.

In Design Studio, characteristics are identified as such by a tag applied to the data element.

The tag is applied automatically when you create a characteristic explicitly. You can also create

a simple data element and add tag it later as a characteristic.

Characteristics have some capabilities not shared by other data elements, including the ability
to specify validity dates and the ability to populate drop-down lists dynamically.

When working with characteristics, see the following topics:

e Creating Characteristics

e Adding Characteristics to Specifications

*  Populating Drop-Down Lists Dynamically

e Overriding Default Values of Characteristics in Entity Specifications
«  Specifying Validity Dates for Characteristics

*  About Masks

« Data Schema Editor Characteristics Tab

Creating Characteristics

You can create characteristics in several ways. See the following topics:
*  Creating Characteristics in the Dictionary View
*  Creating Characteristics from the Specification Editor

e Tagging Data Elements as Characteristics

Creating Characteristics in the Dictionary View

ORACLE

In the Dictionary view, you can create data elements that are automatically tagged as a
characteristic.

To create a characteristic in the Dictionary view:

1. From the Studio menu, select Show Design Perspective.

2. Click the Dictionary tab.

3. Right-click in the Dictionary view and select Add Characteristic.

The Create Characteristic dialog box appears.
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4, Select Create new element and then click Next.

The Common Details dialog box appears. From this point, the procedure is the same as
that for other simple data elements. See “Creating New Simple Data Elements".

Related Topics
Creating Characteristics

Modeling Data

Creating Characteristics from the Specification Editor

When working in a Specification editor, you can create new data elements that are
automatically tagged as characteristics.

To create a characteristic from a Specification editor:

1. Create a new specification or open an existing specification in the Specification editor.
See "Creating New Specifications" for more information.

2. Click the Characteristics tab.

3. Inthe data tree area, right-click and select Add Characteristic.
The Create Characteristic dialog box appears.

4. Select Create new element and then click Next.

The Common Details dialog box appears. From this point, the procedure is the same as
that for other simple data elements. See “Creating New Simple Data Elements".

Related Topics
Creating Characteristics
Specification Editor Characteristics Tab

Modeling Data

Tagging Data Elements as Characteristics

ORACLE

You can identify a data element as a characteristic using Design Studio tags. When modeling
specifications, you can filter entities to display only those data elements tagged as
characteristics.

To tag data elements as characteristics:

1. From the Studio menu, select Show Design Perspective.

2. Click the Dictionary tab.

3. Select the data element that you want to tag as a characteristic.
The Data Element tab appears in the Data Schema editor.

4. Click the Tags subtab.

5. Click Add.
The Tag Selection dialog box appears.

6. Select Characteristic and click OK.

7. (Optional) Select a tag and click Remove to delete the association.
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8. From the File menu, select Save.

Related Topics
Creating Characteristics

Modeling Data

Adding Characteristics to Specifications

You can add existing characteristics to specifications. For example, you can add a
characteristic that was originally created for use in one specification to a different specification.

You can also create new characteristics in Specification editors. See "Creating Characteristics
from the Specification Editor" for more information.

To add existing characteristics to a specification:

1. Create a new specification or open an existing specification in the Specification editor.
See "Creating New Specifications" for more information.
2. Click the Characteristics tab.
3. Inthe data tree area, right-click and select Select Characteristic.
The Select Characteristic dialog box appears.
See "Select Characteristic Dialog Box" for more information.
4. Select a characteristic and click OK.
The characteristic appears in the Characteristics tab data tree.

5. From the File menu, select Save.

Related Topics

Specification Editor Characteristics Tab

Select Characteristic Dialog Box

ORACLE

Use the Select Characteristic dialog box to search for and select existing characteristics.

Field Use
Element and Entity Name Search for specific characteristics or for specific
entities.

*  The search is not case sensitive.

* Use a space between terms to search on
multiple terms.

*  Add OR between terms to search for either one
or the other. For example, entering 32 OR aa
returns names with either 32 or aa.

e Variations of a word are returned. For example,
a search query for ID returns productID,
customerID and orderID.

* Use a negative sign (-) before a second search
term to omit specific variations of words (ensure
there is a space before the negative sign). For
example, a search query for ID -product returns
customerlID and orderID, but not productID.
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Populating Drop-Down Lists Dynamically

You can populate the contents of a drop-down list characteristic in three ways:

Static Values: Enables you to populate the drop-down list with a group of values that do
not change. See "Populating a Drop-Down list with Static Values" for more information.

Entity Link: Enables you to populate the drop-down list with the names of all entities
created from the selected specification. See "Populating Drop-Down Lists with Entity Links
Using Existing Specifications" and "Populating Drop-Down Lists with Entity Links Using
New Specifications" for more information.

Query: Enables you to populate the drop-down list with the results of a query that you
define. See "Populating Drop-Down Lists with Query Results" for more information.

# Note:

See "Overriding Values for Drop Down List Characteristics" for information about
defining values for drop down lists at the Specification editor level.

Populating a Drop-Down list with Static Values

You can populate a drop-down list with values that do not change.

ORACLE

To populate a drop-down list with static values:

1.
2.
3.

10.

11.

From the Studio menu, select Show Design Perspective.

Click the Dictionary tab.

Select the data element that you want to tag as a characteristic.

The Data Element tab appears in the Data Schema editor.

Click the Settings tab.

In the Control Type field, ensure that the DropDown value is selected.
See “About Control Types" for more information.

Click the Characteristics tab.

The fields on this tab are read-only if the data element is not tagged as a characteristic.
See "Tagging Data Elements as Characteristics" for more information.

In the Data Values area, select Enumerations.
Click the Enumerations tab.
Click Add.

Design Studio creates a new row in the Included table and uses placeholder text for the
Code and Description values.

Click the placeholder text in the Code or Description columns.
The placeholder text becomes editable.

Edit the placeholder text.
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The contents of these fields are stored in the database, but only the Description field is
displayed to the user in UIM. For example, you may want Red as the label displayed to the
user, but 1 as the value stored in the database.

You can enter text in the Code field without entering text in the Description field. In this
case, the Code text is displayed.

12. (Optional) To make the enumeration the default value in the run-time environment, click
inside the Default column and select Yes.

13. (Optional) To remove a value from the table, select any value and click Remove.

14. From the File menu, select Save.

Populating Drop-Down Lists with Entity Links Using Existing Specifications

ORACLE

Entity links enable you to populate the drop-down list with the names of all entities created
from the selected specification. For example, if you specify a Logical Device specification
named Customer Edge Router, the drop-down list includes the names of all Logical Device
instances created from the Customer Edge Router specification.

Also, you can use SQL commands to filter the entity instances for a selected entity link. By
default, the drop-down list is populated with label and value pairs. For example, if you define a
Logical Device instance with the ID 1234 and with the name as LD1, the label in drop-down
displays 1234-LD1. You can change the default behavior of a drop-down label by writing the
custom extension for the following API:

CharacteristicHelper.getEntityLinkDisplaySelectSQL()

To populate a drop-down list with the names of entity instances created from an existing
specification:

1. From the Studio menu, select Show Design Perspective.

2. Click the Dictionary tab.

3. Select the data element that you want to tag as a characteristic.
The Data Element tab appears in the Data Schema editor.

4. Click the Settings tab.

5. In the Control Type field, ensure that DropDown is selected.
See “About Control Types" for more information.

6. Click the Characteristics tab.

The fields on this tab are read-only if the data element is not tagged as a characteristic.
See "Tagging Data Elements as Characteristics" for more information.

7. In the Drop Down Options field, select Entity Link.
8. Inthe Entity Link area, click Select.

The Entity Selection dialog box appears, containing a list of available specifications.
9. Select a specification in the list.

To shorten the list of specifications, enter characters in the Select an item to open field.
The list displays specifications whose names begin with the characters you enter. You can
use the wildcard characters shown in the dialog box.

10. Click OK.

The specification you selected is displayed in the Entity Link area.
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11. (Optional) To view the selected specification in its editor, click the Entity link.
12. (Optional) To remove a selected specification from the Entity Link area, click Clear.
13. (Optional) In the Parameters field, do one of the following:

* To select a characteristic to use in a filtered SQL query, click Select. The Add Element
Selection dialog box appears.

When you use a filtered data query, you must use the following syntax to indicate
where in the query the characteristic parameter is to be used:

:Characteristic Parameter Name

For example, if you select Charl in the Parameters table, then you would include the
following parameter binding in the additional SQL filter:

:Charl

» To create a new characteristic for use in the filtered data query, click the Parameter
link.

The Create Data Schema Element dialog box appears.
14. (Optional) To enter an additional SQL filter, enter the filter in the Body field.

15. From the File menu, select Save.

Populating Drop-Down Lists with Entity Links Using New Specifications

ORACLE

Entity links enable you to populate the drop-down list with the names of all entities created
from the selected specification. For example, if you specify a Logical Device specification
named Customer Edge Router, the drop-down list includes the names of all Logical Device
instances created from the Customer Edge Router specification.

To populate a drop-down list with the names of entity instances created from a new
specification:

1. From the Studio menu, select Show Design Perspective.

2. Click the Dictionary tab.

3. Select the data element that you want to tag as a characteristic.
The Data Element tab appears in the Data Schema editor.

4. Click the Settings tab.

5. In the Control Type field, ensure that DropDown is selected.
See “About Control Types" for more information.

6. Click the Characteristics tab.

The fields on this tab are read-only if the data element is not tagged as a characteristic.
See "Tagging Data Elements as Characteristics" for more information.

7. Inthe Drop Down Options field, select Entity Link.
8. Inthe Entity Link area, click the Entity link.

The New Studio Entity dialog box appears.
9. Select an entity type, then click Next.

The Entity Specification Wizard appears. See "Creating New Specifications" for more
information.

10. Configure the properties of the new specification.
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See "Specification Editor" for more information.
11. When you finish configuring the new specification, return to the Data Schema editor.
The new specification is displayed in the Entity Link area.

12. From the File menu, select Save.

Populating Drop-Down Lists with Query Results

You can populate drop-down lists with the results of a query that you define. You use Java
Persistence Query Language (JPQL) or SQL commands to write the query to search for values
that are stored in instance data.

For example, you can create a City Name characteristic as a drop-down list populated with all
Place entities created from the City specification.

The JPQL query for this data is as follows:

Select name from GeographicPlace where specification.name.contains (“City")

You can also populate a drop-down list with the results of pre-defined query that returns all
authorized UIM users.

To populate a drop-down list from the results of a query:

1. From the Studio menu, select Show Design Perspective.

2. Click the Dictionary tab.

w

Select the data element that you want to tag as a characteristic.
The Data Element tab appears in the Data Schema editor.
Click the Settings tab.

In the Control Type field, ensure that DropDown is selected.
Click the Characteristics tab.

In the Drop Down Options field, select Query.

In the Data Source field, select JIPQL, SQL or USERS.

© ®& N o g

(Optional) If you selected JPQL or SQL, do one of the following:
« In the Parameters field, select one or more characteristics.

* In the Body field, enter a query to use in a filtered data query. When you use a filtered
data query, you must include a question mark(?) in the query string to indicate where
in the query the characteristic parameter is to be used.

10. From the File menu, select Save.

Overriding Default Values of Characteristics in Entity
Specifications

ORACLE

You can override the default values of characteristics when you add them to entity
specifications and entity configuration specifications. Additionally, you can override the values
defined for drop down lists. This capability enables you to adjust values to meet specific
circumstances without having to create new characteristic specifications.

When overriding characteristic default values, see the following topics:
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e About Characteristic Attribute Overrides
e Overriding Characteristic Default Values

e Overriding Values for Drop Down List Characteristics

About Characteristic Attribute Overrides

Characteristics that you add to specifications can have attributes defined at the data schema
level. You can override the values defined at the data schema level by editing the characteristic
attributes for a specific specification. In this case, the override applies only in the entity or entity
configuration specification where you made the change. For example, if you change the values
for a drop-down list in a particular Logical Device specification, those changes apply only to
that specification. If you use the drop-down list in another specification, it retains its originally
defined values.

You must ensure that override values meet all restrictions defined in the characteristic
specification. For example:

*  The value must be within the valid values that you defined on the characteristic. For
example, for numeric text type characteristic, if the valid value range is from 3 to 5, you get
an error message if you enter 6.

e The value must conform to an edit mask or display mask if one is defined for the
characteristic.

e The value must conform to the length defined for the characteristic.

Related Topics
Overriding Characteristic Default Values

Overriding Values for Drop Down List Characteristics

Overriding Characteristic Default Values

To override default values of characteristics:

1. Create a new specification or open an existing specification in the Specification editor.
See "Creating New Specifications" for more information.

2. Click the Layouts tab.

3. Inthe PagelPanels field, select a page type for the specification.

You can define different attributes for a characteristic when it appears on different types of
pages. For example, you can define an edit mask for the characteristic when it appears on
an edit page and a display mask for the same characteristic when it appears on a
summary page.

# Note:

The options available in the PagelPanels field are defined in the ora_uim_mds
project. You must import and open this project and the ora_uim_model project in
your workspace before modeling UIM entities in Design Studio.

4. In the Panels/Element area, select a characteristic in the Select column.
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The characteristic attribute fields appear in the Ul Settings area. The fields that appear are
determined by the value in the Control Type field.

Specify override values for the characteristic.

The values that you define here override the values defined for the characteristic at the
data schema level. See “Settings Tab" for information about the fields that appear in the Ul
Settings area.

From the File menu, select Save.

Related Topics

About Characteristic Attribute Overrides

Overriding Values for Drop Down List Characteristics

Overriding Values for Drop Down List Characteristics

To override default values of characteristics defined as drop down lists:

1.

6.

Create a new specification or open an existing specification in the Specification editor.
See "Creating New Specifications" for more information.

Click the Characteristics tab.

In the data tree area, select a characteristic with a control type defined as DropDown.
The characteristic attribute subtabs appear.

See “Settings Tab" for information about defining the control type.

Click the Data Values subtab.

Do any of the following:

e Click Add to add additional values to the drop down list.

* Select a value listed in the table and click the arrow to move the value to the Excluded
table.

You cannot delete values defined at the data schema level. However, you can prevent
these values from appearing in the list for specific specifications by moving them to the
Excluded table.

Select a value and click Remove to delete a value from the drop down list. You cannot
delete values defined at the data schema level.

¢ Click inside the Default column and select Yes to make the selected value the default
value in the run-time environment.

From the File menu, select Save.

Related Topics

About Characteristic Attribute Overrides

Overriding Characteristic Default Values

Enumerations Tab

ORACLE
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Specifying Validity Dates for Characteristics

You can specify validity dates for characteristics. Validity dates can be set for characteristics of
all primitive and control types.

# Note:

Validity dates are not the same as the date range that you specify when you set a
characteristics control type to Calendar.

You do not have to specify both a start and end date. You can specify only one. For example,
you can specify a start date but no end date.

To specify validity dates for a characteristic:

1. From the Studio menu, select Show Design Perspective.
2. Click the Dictionary tab.
3. Select the data element that you want to tag as a characteristic.
The Data Element tab appears in the Data Schema editor.
4. Click the Characteristics tab.
5. To specify a start date, do the following:
a. Select the Start Date check box.
b. Enter or select a date on which the characteristic becomes valid.
6. To specify an end date, do the following:
a. Select the End Date check box.
b. Enter or select a date after which the characteristic becomes invalid.

7. From the File menu, select Save.

About Masks

Masks control the way characteristics (defined with a control type of Numeric or Text) are
formatted and displayed in UIM.

e The edit mask controls how text is formatted in editable fields, such as those that appear
during creation or update.

e The display mask controls how text is formatted in read-only fields.

You use Java regular expressions to define the edit and display masks. For example, to format
the text as an IPv4 address, you could use the following regular expression for both masks:

Wd{3}.\d{3}.\d{3}.\d{3}
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# Note:

When a user enters text in a field, only the text is stored in the UIM database. If you
do not specify a display mask, the unformatted text is displayed in pages.

You can use the following Java regular expressions:

Characters, Predefined Character Classes, or | Description

Greedy Quantifier

X The character x

\\ The backslash character
\d A digit: [0-9]

\D A non-digit: [*0-9]

\s A whitespace character: [\t]
\w A word character: [a-z A-Z_0-9]
X? X, once or not at all

X* X, zero or more times

X+ X, one or more times

For additional information, see the Java regular expression documentation:

http://docs.oracle.com/javase/6/docs/api/java/util/regex/Pattern.html

Related Topics

About Control Types

Data Schema Editor Characteristics Tab

Use the Data Schema editor Characteristics tab to define valid dates for calendar-type
characteristics and to define enumerations (also known as drop down list values) for drop
down-type characteristics.

# Note:

You can define valid values for characteristics at two different levels: at the schema
level (general) and at the specification level (specific). Design Studio evaluates the
values defined for characteristics from the general level to the specific level. For
example, the characteristic properties defined at the data element level (defined for
data elements in the Data Schema editor) are overridden if you define properties for
the same characteristic at the specification level (properties defined in the
Specification editor).

See "Specification Editor Characteristics Tab" for more information about defining
characteristic attributes at the specification level.
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Field Use

Start Date Select the date on which the characteristic becomes
valid.

End Date Select the date after which the characteristic

becomes invalid.

Drop Down Options

Select one of the following:

e Select Enumerations to populate the drop down
list with a set of statically-defined values. See
“Creating Data Element Enumerations" and
“Enumerations Tab" for more information.

*  Select Entity Link to populate the drop down list
with the names of all entities created from the
selected specification. Use the options in the
Entity Link area to complete the configuration.

*  Select Query to populate a drop-down list with
the results of the query that you define. Use the
options in the Query area to complete the
configuration.

Entity Link

If you selected Entity Link in the Drop Down

Options field, you can populate the drop down list

with the names of all entities created from the

selected specification.

Do one of the following:

*  Click the Entity link to create and use a new
specification.

*  Click Select to use an existing specification.

Query

If you selected Query in the Drop Down Options

field, you can populate a drop-down list with the

results of the query that you define.

To specify the syntax of the query, select from the

Data Source list, select JPQL, SQL or USERS.

*  Select JPQL to use JPQL syntax.

e Select SQL to use SQL syntax.

*  Select USERS to specify a query that populates
the drop-down list with all UIM users.

If you want to use a filtered data query, do one of the

following:

e Click Parameter if you to want to create a new
data element to use in a filtered data query.

*  Click Select to select an existing data element in
a filtered data query for the query parameter.

Enter the query in the Body field using the selected

syntax. No query text is required in you selected

USERS.
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Working with Configurations

Oracle Communications Unified Inventory Management (UIM) Service, Place, Network, Pipe,
Logical Device, and Logical Device Account specifications can have configurations associated
with them. A configuration describes details about how an entity is realized, and how it is
supported by the resources that enable it.

When working with configurations, see the following topics:

e About Configurations

e About Configuration Items

«  Creating Configuration Specifications
* Adding Configuration Items

*  Configuration Specification Editor

About Configurations

ORACLE

A configuration is a hierarchically organized collection of facts (configuration items) in the form
of characteristics, resource allocations, and entity references. Configurations can be versioned
such that a collective set of facts can be organized, managed and referenced as a unit
(version) with its own life cycle. Service, Place, Network, Pipe, Logical Device, and Logical
Device Account specifications can have configurations associated with them.

# Note:

The term Place Configuration specification applies to places that are of type
Geographic Site.

In general, configurations should contain the bulk of the information about the specification.
They should contain the characteristics that are likely to change over time, while the service
itself should contain attributes that are unlikely to change: name, description, and so on.

Configurations are separate entities that are defined by specifications. Configurations include
the following features that are not available in other entities:

e Configuration items: Define the content of the configuration. Configuration items can
include child items, which are arranged hierarchically. Each configuration item can have its
own properties, characteristics, layout, and specification options. See "Adding
Configuration Items" for more information.

« Specification options: Define the entities that can be assigned or referenced to a
configuration item.

Related Topics
Adding Existing Configurations to a Service Specification

Adding Existing Configurations to a Network Specification
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Adding Existing Configurations to a Logical Device Specification

Adding Existing Configurations to a Logical Device Account Specification

About Configuration ltems

Configuration items enable you to create a hierarchy of items within a configuration.
Configuration items can contain other configuration items, so you can nest information to
capture how resources are organized.

In Design Studio, configuration items appear in a hierarchical format in the Configuration area
of the entity Configuration Specification editor.

Configuration items enable you to assign or reference resources to the configuration and to
configure those resources appropriately (entities referenced to the configuration are not
consumed by the configuration). You can add any of the following to configuration items:

¢ Minimum and maximum quantities: These determine how many instances of the item
can be included in the configuration. The minimum quantity also dictates the items that are
automatically created when you create a configuration version or add a new configuration
item, with child configuration items, to a configuration version.

e Characteristics: You use characteristics to capture specific attributes about the
configuration item. You can override the default values defined in a characteristic
specification. See "Overriding Default Values of Characteristics in Entity Specifications" for
more information.

« Specification options: You use specification options to determine which entities can be
referenced by or assigned to a service, place, pipe, network, logical device, logical device
account, and so forth. When you create a specification option, you associate one or more
specifications with it. See "Configuration Specification Editor Specification Options Subtab"
for more information.

Related Topics

Adding Configuration Items

Creating Configuration Specifications

You can create a configuration specification independently or create a new configuration
specification in the processing of adding it to a Service, Place, Network, Pipe, Logical Device,
or Logical Device Account specification.

# Note:

Place configurations apply only to places defined as sites.

To create a configuration specification:

1. Do one of the following:

* If you are creating the configuration independently, from the Studio menu select New,
then select Inventory, then select a conceptual division, then select one of the
configuration specifications.
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* If you are creating a configuration while adding it to a specification, open the
Specification editor, click the configurations tab (for example, in the Service
Specification editor, click the Service Configurations tab), then click Add.

The Entity Configuration Specification Wizard appears.

In the Project field, select the name of the project to which the new configuration
specification should be added.

In the Name field, enter a name for the new configuration specification.
The name you enter appears in UIM.
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.

b. Navigate to the directory in which to save the entity.
c. Click OK.

Click Finish.

Design Studio creates the new configuration specification and displays its information in an
editor.

Related Topics

Adding Configuration Items

Adding Existing Configurations to a Service Specification

Adding Existing Configurations to a Network Specification

Adding Existing Configurations to a Logical Device Specification

Adding Configuration Items

Configuration items enable you to create a hierarchy of items within a configuration.

ORACLE

To add configuration items:

1.

In the Studio Projects view, double-click any entity configuration specification to open it in
an entity Configuration Specification editor.

Click the Details tab.
In the Details tab data tree area, do one of the following:

* Right-click a configuration item that will be the parent of the new configuration item in
the hierarchy.

* Right-click in the white space to add a configuration item at the top level.
Select Configuration Items, then select Add Item.

The Create Configuration Item dialog box appears.

Enter a name for the configuration item, then click OK.

The new configuration item appears in the Details tab data tree area.

Select the new configuration item.
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7. On the Details tab Details subtab, select minimum and maximum quantities in the

Multiplicity fields.

Set the Minimum field to a non-zero value to indicate that the configuration item is
required in the configuration and that the specified number of items will be created
automatically in UIM when an instance of the configuration is created.

See “Details Tab" for more information about the fields on this subtab.
8. Add characteristics to the configuration item.
See "Adding Characteristics to Configuration Items" for more information.
9. Add specification options to the configuration item.
See "Adding Specification Options to Configuration Iltems" for more information.

10. From the File menu, select Save.

Adding Characteristics to Configuration Items

Characteristics enable you to add attributes to the configuration item.

# Note:

When necessary, you can override the default values defined for a characteristic at
the data schema level. The override applies only to the characteristic as it is used in
a specific configuration specification. See "Overriding Default Values of
Characteristics in Entity Specifications".

When adding characteristics to configuration items, you can add existing characteristics or you
can create new characteristics to add to the configuration item. See the following topics for
more information:

e Adding Existing Characteristics to Configuration Iltems

e Adding a New Characteristic to Configuration Items

Adding Existing Characteristics to Configuration ltems

ORACLE

To add existing characteristics to configuration items:

1. Inthe Solution view, double-click any entity configuration specification.
The entity Configuration Specification editor opens.
2. Click the Details tab.

3. Inthe Details tab data tree area, right-click a configuration item and select Select
Characteristic.

The Select Characteristic dialog box appears. See "Select Characteristic Dialog Box" for
more information.

4. Select a characteristic from the list and click OK.
The characteristic is added to the configuration item in the Details tab data tree.

5. From the File menu, select Save.
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Related Topics
Adding New Specification Options to Configuration Items

Configuration Specification Editor

Adding a New Characteristic to Configuration ltems

You can create new characteristics to add to a configuration item.

To add a new characteristic to configuration items:

1. Inthe Solution view, double-click any entity configuration specification.
The entity Configuration Specification editor opens.

2. Click the Details tab.

3. Inthe Details tab data tree area, right-click a configuration item and select Add
Characteristic.

The Create Characteristic dialog box appears.
4. Select Create new element and then click Next.

The Common Details dialog box appears. From this point, the procedure is the same as
that for other simple data elements. See “Creating New Simple Data Elements".

5. Click Finish.

The characteristic is added to the configuration item in the Details tab data tree.
6. Inthe Details tab data tree, select the characteristic.
7. Inthe Details tab subtabs, define the attribute information for the characteristic.

See “Design Studio Common Editor Tabs" for more information about the fields on these
subtabs.

8. From the File menu, select Save.
Related Topics
Adding Existing Characteristics to Configuration Items

Configuration Specification Editor

Adding Specification Options to Configuration Items

ORACLE

Specification options enable UIM users to associate entities to configuration items. There are
two kinds of specification options:

* Assignments (or allocations) mean that a resource (such as a logical device or pipe) is
consumed by the configuration.

* References indicated the interest in or significance of an entity to the configuration. The
entity is not consumed, but referenced.

In Design Studio, when you add specifications as reference or assignment options to a
configuration item, entities based on the specification will be available for assignment or
reference in UIM. The entities that are available to assign or reference depend on the
specification type. For example, you can use a service configuration to assign telephone
numbers, but you cannot use a network configuration to assign telephone numbers.
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You can add existing specifications as specification options to configuration items or create
new specifications in process of adding them. See the following topics for more information:

Adding Existing Specifications to Configuration Items

Adding New Specification Options to Configuration Items

Adding Existing Specifications to Configuration ltems

To add existing specifications to configuration items:

1.

o & W DN

In the Solution view, double-click any entity configuration specification.
The entity configuration specification editor opens.

Click the Details tab.

In the Details tab data tree area, select a configuration item.

Click the Specification Options tab.

In the Item Option Type field, select an option type.

You can select Assignment or Reference. The default value is None. See "Configuration
Specification Editor Specification Options Subtab" for more information.

Click Add.

The Specification Option dialog box appears.
Click Select.

The Selection Dialog dialog box appears.
Select a specification, then click OK.

The specification name appears in the Specification field of the Specification Option
dialog box.

Click OK.

The entity specification appears in the Specification Options tab.

10. From the File menu, select Save.

Related Topics

Adding New Specification Options to Configuration Items

Configuration Specification Editor

Specification Editor Configuration Spec Usage Tab

Adding New Specification Options to Configuration ltems

ORACLE

You can create new specification options to add to the configuration item.

To add a new specification option to configuration items:

1.

In the Solution view, double-click any entity configuration specification.
The entity Configuration Specification editor opens.

In the Configuration area, select a configuration item.

Click the Specification Options tab.

In the Item Option Type field, select an option type.
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You can select Assignment or Reference. The default value is None. See "Configuration
Specification Editor Specification Options Subtab" for more information.

Click Add.
The Specification Option dialog box appears.
Click New.

The New Studio Entity dialog box appears. See “Selecting Entity Types" for information
about selecting entity types in the dialog box.

Select an entity type, then click Next.

The Entity Specification Wizard appears.

Create the new specification.

See "Creating New Specifications" for more information.

In the Specification Option dialog box, click OK.

10. From the File menu, select Save.

Related Topics

Adding Existing Specifications to Configuration Items

Configuration Specification Editor

Adding Rules to Configurations

You can define ruleset extension points for the entire configuration. When adding rules to
configurations, you can add existing rules or you can create new rules to add to the
configuration. See the following topics for more information:

Adding Existing Rules to Configurations

Adding New Rules to Configurations

Adding Existing Rules to Configurations

ORACLE

You can add existing rules to a configuration.

To add rules to a configuration:

1.

In the Solution view, double-click any entity configuration specification.
The entity Configuration Specification editor opens.

Click the Rules tab.

Click Select.

The Selection Dialog dialog box appears, containing a list of available ruleset extension
points.

Select a rule in the list.
Click OK.

The rule that you selected is displayed in the Ruleset Extension Point area.

Related Topics

Adding New Rules to Configurations
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Configuration Specification Editor

Adding New Rules to Configurations

You can create new rules to add to a configuration.
To add a new rule to a configuration:

1. Inthe Solution view, double-click any entity configuration specification.
The entity Configuration Specification editor opens.
2. Click the Rules tab.
3. Click Add.
The Ruleset Extension Point Wizard appears.
4. In the Project field, select the name of the project to which the new rule should be added.
5. Inthe Name field, enter a name for the new rule.
The name you enter appears in UIM.
6. (Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.
b. Navigate to the directory in which to save the entity.
c. Click OK.

7. Click Finish.

The rule that you added is displayed in the Ruleset Extension Point column.

Related Topics

Configuration Specification Editor

Associating Tags with Configuration ltems

Tags are keywords that you can use to categorize data elements and instances of entities.
Tags help you filter and search for data elements that are associated with specific Oracle
Communications applications. See “Working with Tags" for more information.

You can create your own tags and associate your tags to configuration items that you add to
Service, Place, Logical Device, Logical Device Account, and Network entity Configuration
specifications. Associating tags with configuration items that you add to Configuration
specifications enables UIM users to search for tags using the Tags Search page. At run time,
the tag is visible (on the Configuration Summary page) for all instances of entities that were
created from the Configuration specification. These tags are also visible in the
getConfiguration and getConfigurationDifferences web service operations, which are
included in the Service Fulfillment web service. The getConfiguration web service operation
response contains the tag information from the request.
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# Note:

You cannot associate tags with configuration items that you add to Pipe Configuration
specifications.

To associate a tag with configuration items:

1.

Create a new tag in a Model project.

When creating the new tag, complete the optional step to define the Build Directives
attribute with the system-delivered Generate Inventory Runtime Tag tag. See “Creating
Tags" for more information.

Create a dependency between the Model project and the Design Studio for Inventory
project in which you intent to save the Configuration specification.

See “Managing Project Dependencies" for more information.

Open the Configuration Specification editor for the entity with which you want to associate
the tag.

On the Details tab, select a configuration item.
Click the Tags tab.
Click Add.

A list of tags appears. The list includes all user-defined tags with a Build Directives
attribute defined as Generate Inventory Runtime Tag.

Select a tag from the list and click OK.
The tag appears on the Tags tab and is now associated with the configuration item.
Deploy the Design Studio for Inventory Cartridge project to the run-time environment.

UIM users can search for tags using the Tags Search page. At run time, the tag is visible
(on the Configuration Summary page) for all instances of entities that were created from
the Configuration specification. See UIM Help for more information.

Configuration Specification Editor

You use a Configuration Specification editor to model a hierarchically organized collection of
configuration items, which can contain characteristics and resource allocations.

When working with a Configuration Specification editor, see the following topics:

ORACLE

About the Configuration Specification Editor Context Menu
Configuration Specification Editor Details Tab
Configuration Specification Editor Layouts Tab

Configuration Specification Editor Rules Tab

# Note:

Some types of configuration specifications also contain a Specs tab. See the Help
topics specific to those editors for more information.

4-9



Chapter 4
Configuration Specification Editor

Configuration Specification Editor Details Tab

Use the Details tab to create, select, and remove characteristics and configuration items.

When working with the Details tab, see the following topics:

* About the Configuration Specification Editor Context Menu

¢ Details Tab
*« Notes Tab
e Usage Tab

*  Configuration Specification Editor Data Values Subtab

»  Configuration Specification Editor Layouts Subtab

e Configuration Specification Editor Tags Subtab

*  Configuration Specification Editor Specification Options Subtab

About the Configuration Specification Editor Context Menu

The Details tab context menu contains actions specific to characteristics. To access these
actions, you right-click in the left column of the tab. The context menu options that are
available depend on the selection in the editor. For example, the list of context menu options
that appear when you right-click in the white space is different than the list that appears when
you right-click a characteristic.

Command

Use

Add Characteristic

Select to create a new characteristic to add to the configuration
specification. See "Creating Characteristics" for more information.

Select Characteristic

Select to add an existing characteristic to the configuration specification.

Configuration Items

Select to add a new configuration item to the configuration specification.

Delete Select to delete a characteristic or a configuration item from the
configuration specification.

Move Up Repositions a characteristic or a configuration item in the view by moving it
up in the list.

Move Down Repositions a characteristic or a configuration item in the view by moving it

down in the list.

Refactoring

Select to access a menu of options for improving names and locations of
the characteristics. See “Managing Data Element Names and Locations" for
more information.

Refresh

Refreshes the view.

Configuration Specification Editor Data Values Subtab

ORACLE

Use the Data Values subtab to define sets of valid enumeration values for elements.
Enumerations (also referred to as look-up or drop-down values) represent actual values that
characteristics can take as valid values.
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Field

Use

Included table

Click the placeholder text inside the Code and Description
columns to change the code name and description for the
enumeration.

The value you enter in the Code field is stored in the
database. The value you enter in the Description field is
displayed to the user.

Enumerations that are inherited from a base type are read-
only. Additionally, enumerations can be inherited from an
ancestor if the base type does not specifically define its own
value space but derives the enumerations from an ancestor.

Click inside the Default column and select Yes to make the
selected value the default value in the run-time environment.

Add

Click Add to add an enumeration for the characteristic you
selected in the Included table.

Excluded table

Displays inherited enumerations that you want to exclude from
the list of values in the run-time environment. Move
enumerations between the Included and Excluded tables using
the arrow buttons. Use this capability to display a subset of the
inherited enumerations as valid values for the element in the
run-time application.

Language

For some data elements, you can specify the language in
which to display the selected enumeration value.

This field is not applicable to data elements tagged as
characteristics.

Related Topics

Configuration Specification Editor Details Tab

Configuration Specification Editor Layouts Subtab

Use the Layouts subtab to define how the characteristics appear for a configuration item in an
instance of a configuration specification.

See “Settings Tab" for information about the fields that appear in the Ul Settings area.

Field

Use

Page/Panels

Select the page type in the UIM run-time environment.

You can define different attributes for a characteristic when it
appears on different types of pages. For example, you can
define an edit mask for the characteristic when it appears on
an edit page, and a display mask for the same characteristic
when it appears on a summary page.

Note: The options available in this field are defined in the
ora_uim_mds project. You must import and open this project
and the ora_uim_model project in your workspace before
modeling UIM entities in Design Studio.

Available column

Displays the elements that are available to be displayed as
fields in the run-time user interface, but which are not currently
selected. Use the arrow keys to move the elements between
the Available column and the Selected column.

ORACLE
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Field Use

Selected column Displays the elements that will appear as fields in the run-time
user interface, and include the characteristics (defined on the
Characteristics tab) and all derived data. The fields are
displayed in the order in which they appear in the product. Use
the up and down arrow keys to reposition characteristics in this
column.

Select an element to view the user interface (Ul) settings. See
“Settings Tab" for more information about the fields in the Ul
Settings area.

See UIM Help for information about how to use these fields in
the UIM run-time environment.

Reset Click to revert the layout to the default version.

Related Topics

About Specification Layouts

Configuration Specification Editor Tags Subtab

Use the Tags subtab to associate a tag with a configuration item.

Field Use

Name Displays the list of tags associated with the selected
configuration item.

Description Displays a description of the tag that will appear in the UIM
run-time application.

Build Directives Indicates whether the user-defined tag is associated with the
system-delivered Generate Inventory Runtime Tag tag.

Remove Click to remove the association of the selected tag.

Add Click to associate a user-defined tag with the configuration
item.

Related Topics
Associating Tags with Configuration Items
Configuration Specification Editor Details Tab

Working with Tags

Configuration Specification Editor Specification Options Subtab

Use the Specification Options subtab to assign resources by associating instances of
specifications with the configuration.

Field Use
Assignment Select to add a specification option as an assignment.
Reference Select to add a specification option as a reference.
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Field

Use

None

Select to indicate that the configuration item cannot consume
or reference resources. The configuration item, however, can
include child configuration items that consume or reference
resources.

Specification

Displays the selected specification.

Cartridge

Displays the name of the cartridge project into which the
specification option is built.

Add

Click to add a specification option for an existing specification
or for a new one. See "Adding Existing Specifications to
Configuration Items" and "Adding New Specification Options to
Configuration Items" for more information.

Modify

Click to modify a specification option for an existing
specification.

Remove

Click to remove a specification option for an existing
specification.

Related Topics

Adding Specification Options to Configuration Items

Specification Editor Configuration Spec Usage Tab

Configuration Specification Editor Layouts Tab

Use the Layouts tab to define how the characteristics appear for the configuration

ORACLE

specification.

See “Settings Tab" for information about the fields that appear in the Ul Settings area.

Field

Use

Page/Panels

Select the page type in the UIM run-time environment.

You can define different attributes for a characteristic when it
appears on different types of pages. For example, you can
define an edit mask for a characteristic when it appears on an
edit page, and a display mask for the same characteristic when
it appears on a summary page.

Note: The options available in this field are defined in the
ora_uim_mds project. You must import and open this project
and the ora_uim_model project in your workspace before
modeling UIM entities in Design Studio.

Available column

Displays the elements that are available to be displayed as
fields in the run-time user interface, but which are not currently
selected. Use the arrow keys to move the elements between
the Available column and the Selected column.
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Field

Use

Selected column

Displays the elements that will appear as fields in the run-time
user interface, and includes the characteristics (defined on the
Characteristics tab) and all derived data. The fields are
displayed in the order in which they appear in the product. Use
the up and down arrow keys to reposition characteristics in this
column.

Select a characteristic to view the user interface (Ul) settings.
See “Settings Tab" for more information about the fields in the
Ul Settings area.

See UIM Help for information about how to use these fields in
the UIM run-time environment.

Reset

Click to revert the layout to the default version.

Related Topics

About Specification Layouts

Configuration Specification Editor Rules Tab

Use the Rules tab to extend or customize a UIM specification by adding extension points and

rulesets.

Field

Use

Ruleset Extension Points

Displays the ruleset extension points that are added to a UIM
specification.

Cartridge Displays the name of the cartridge project into which the
ruleset extension point is built.

Select Click to select a ruleset extension point that you want to add to
a UIM specification.

Remove Click to remove a ruleset extension point that is already added
to a UIM specification.

Add Click to add a new ruleset extension point to a UIM

specification.

Related Topics

Adding Rules to Configurations

Working with Rulesets and Extension Points

ORACLE
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Working with Product and Service
Specifications

In Oracle Communications Unified Inventory Management (UIM), products and services are
closely related. Products are marketed and sold to customers, whereas services are provided
to support the product. Products and services represent the commercial and technical aspects
of the inventory: products represent the commercial view, and the corresponding services
represent the technical view.

# Note:

Product specifications are included in Oracle Communications Service Catalog and
Design - Design Studio for Inventory only for backward compatibility with customized
solutions that require mapping services to corresponding products.

See UIM Concepts for more information about using Products in UIM.

See Design Studio Concepts for more information about using Products in a
conceptual model.

When working with products and services, see the following topics:
*  Working with Product Specifications
*  Working with Service Specifications

*  Working with Service Configuration Specifications

Working with Product Specifications

ORACLE

# Note:

Product specifications are included in Design Studio for Inventory only for backward
compatibility with customized solutions that require mapping services to
corresponding products.

See UIM Concepts for more information about using Products in UIM.

See Design Studio Concepts for more information about using Products in a
conceptual model.

Product specifications can represent any or all of the following items in your inventory:

* A service to which a customer or subscriber subscribes, such as Broadband Internet
access

* A service that a service provider performs for a customer, such as equipment installation
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* A piece of hardware that a customer purchases or leases

You are not required to create products in UIM. You can create services without the service
being associated to a product. You can create products as a way to map to other systems that
can send product information to UIM.

Product specifications can also be related to other Product specifications to constrain what
products can be hierarchically related in UIM. A Product specification can be related to one or
more Service specifications which constrains which services can be related to a product in
UIM.

When working with Product specifications, see the following:

» Defining Product Specifications
e Product Specification Editor

e Configuring Backward Compatibility for Product Specifications

Defining Product Specifications

ORACLE

# Note:

Product specifications are included in Design Studio for Inventory only for backward
compatibility with customized solutions that require mapping services to
corresponding products.

See UIM Concepts for more information about using Products in UIM.

See Design Studio Concepts for more information about using Products in a
conceptual model.

When you create Product specifications, you define which Service specifications are included
in the product. For example, if you create a product called MPLS VPN, you can specify that
only instances of the MPLS VPN Service specifications can be included in the product. You
can also relate child product specifications to a product specification.

In Design Studio, you define the list of valid Service specifications in the Product Specification
editor. You can select from existing Service specifications or create new ones. If you do not
specify particular Service specifications, then the product can include any service in the
inventory.

To define Product specifications:

1. Create a new Product specification or navigate to the editor of an existing one.
See "Creating New Specifications" for more information.

2. Click the Related Specifications tab.

3. Click Select.
The Selection Dialog dialog box opens.

4. In the Selection Dialog dialog box, do one of the following:

» Select a specification from the list and click OK to add an existing Service specification
to the Product specification.
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» Click New to create and add a new Service specification to the Product specification.
See "Creating New Specifications" for more information.

In both scenarios, the Service specification appears in the Related Specification tab.
(Optional) Double-click a Service specification in the table.

The appropriate specification editor opens. For example, after creating a new Service
specification, you can double-click the new row in the table to configure the specification.

(Optional) Select a Service specification in the table and click Modify.

The Relationship Properties dialog appears, where you can view or change information
about the relationship between the Service and Product specifications.

See "Specification Editor Related Specifications Tab" for more information about the fields
on the Relationship Properties dialog box.

(Optional) Select a Service specification in the table and click Remove.
The relationship between the Service specification and Product specification is deleted.

From the File menu, select Save.

Related Topics

Product Specification Editor

Product Specification Editor

ORACLE

# Note:

Product specifications are included in Design Studio for Inventory only for backward
compatibility with customized solutions that require mapping services to
corresponding products.

See UIM Concepts for more information about using Products in UIM.

See Design Studio Concepts for more information about using Products in a
conceptual model.

Use the Product Specification editor to define Product specifications. When working with
Product specifications, see the following topics:

Specification Editor Characteristics Tab
Specification Editor Specification Properties Tab
Specification Editor Related Specifications Tab
Specification Editor Configuration Spec Usage Tab
Specification Editor Rules Tab

Specification Editor Layouts Tab

Specification Editor Media Tab

Specification Editor Extends Tab
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Configuring Backward Compatibility for Product Specifications

Product specifications are included in Design Studio for Inventory for backward compatibility
with customized solutions that require mapping services to corresponding products.

See UIM Concepts for more information about using Products in UIM.
See Design Studio Concepts for more information about using Products in a conceptual model.

If you require Design Studio for Inventory Product specifications for backward compatibility, see
the following topics:

e Copying Existing Product Specifications into an Inventory Project

e Creating New Product Specifications Entities Using the Java Perspective

Copying Existing Product Specifications into an Inventory Project

Product specifications are included in Design Studio for Inventory for backward compatibility
with customized solutions that require mapping services to corresponding products.

If you require Design Studio for Inventory Product specifications for backward compatibility,
and if you have existing Product specifications in your workspace that you want to continue to
use, you can copy the existing Product specification to a new Inventory project.

To copy existing Product specifications to a new Inventory project:

1. Inthe Solution view, locate the existing Inventory Product specification in your workspace.
2. Right-click the Product specification and select Copy.

3. Right-click the target Inventory project and select Paste.

4. Click Save.

Creating New Product Specifications Entities Using the Java Perspective

ORACLE

Product specifications are included in Design Studio for Inventory for backward compatibility
with customized solutions that require mapping services to corresponding products.

If you require Design Studio for Inventory Product specifications for backward compatibility,
and to create new Product specifications in your workspace, you can create the .product
Design Studio entity in the Java perspective.

To create new Product specifications using the Java perspective:
1. From the Java perspective, click the Package Explorer tab.

The Package Explorer view appears.

2. Navigate to the Inventory project where you want to create a new Product specification,
and select the model folder.

3. Right-click the model folder, then select New, and then select File.
The New File dialog box appears.

4. In the File Name field, enter a name for the file and include the .product extension.
For example, name the file SampleProduct.product.

The new file appears in the model folder in the Package Explorer view.
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Right-click the new file, select Open With, and then select Text Editor.
The file opens in the Design Studio default text editor.
Copy the following XML fragment into the file:

<?xml version="1.0" encoding="UTF-8"?>
<com:modelEntity
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:com="http://www.mslv.com/studio/core/model/common"
xmlns:data="http://www.oracle.com/communications/studio/core/model/common/
data"
xmlns:inv="http://www.mslv.com/studio/inventory/model/specification"
xmlns="http://www.mslv.com/studio/inventory/model/specification"
xsi:type="inv:ProductSpecificationType"
name="SampleProduct">

<com:baseEntityRef>
<com:entity>Product</com:entity>
<com:entityType>inventoryEntity</com:entityType>
<com:relationship>unknown</com:relationship>
</com:baseEntityRef>

<com:id>Wodf--+0--+fkI4A---+Fg</com:1id>

<data:dataElementNode virtual="true">
<com:id>Wodf--+0--+fkI4A---+Fg</com:id>
<com:elementType>oracle.communications.studio.model.data.StudioModelDataElement</

com:elementType>

<data:name>SampleProduct</data:name>
<data:displayName lang="[default]">SampleProduct</data:displayName>
<data:primitiveType>none</data:primitiveType>

</data:dataElementNode>

<data:dataElementDetails xsi:type="data:dataElementCommonDetail">
<com:1id>z+127sgB--+0-mVX--+ml1Q</com:id>

<com:elementType>oracle.communications.studio.model.data.StudioModelDataElementCommon

Details</com:elementType>
<data:dataElementId>Wodf--+0--+fkI4A---+Fg</data:dataElementId>
<data:defaultValue></data:defaultvValue>
<data:deprecated>false</data:deprecated>
<data:sensitive>false</data:sensitive>
<data:minLength>0</data:minLength>
<data:maxLength>40</data:maxLength>
<data:minMultiplicity>0</data:minMultiplicity>
<data:maxMultiplicity>-1</data:maxMultiplicity>

</data:dataElementDetails>
</com:modelEntity>

Click Save.

Switch to the Studio Design perspective.

Click the Studio Projects tab.

The Studio Projects view appears.

Expand your Inventory project, then expand the Product Specifications folder.

The Product specification that represents the new .product entity appears in the folder.
Right-click the new Product specification, then select Copy.

Right-click the Inventory project and then select Paste.
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The Set Name of Copy dialog box appears.
13. Rename the copy of the Product specification to the desired name.
14. Delete the original Product specification that you created in the Java perspective.

15. Click Save.

Working with Service Specifications

In UIM, a service represents the way that a product is realized and delivered to a customer. For
example, a DSL Gold product is delivered as a DSL Gold service, enabled by appropriate
resources.

You define Service specifications to record basic information about the service. You define
Service Configuration specifications to record versionable sets of facts about the service. As
these facts evolve over time, you can create new configuration versions. See "About
Configurations" for more information.

Network-oriented services are a specialization that support multipoint and point-to-point packet
connectivity. These services are part of a larger network-oriented service arrangement that
includes other entities, such as networks and service locations.

For network-oriented services that support multipoint connectivity, you determine whether the
service is the network service (the parent of the service arrangement) or a member service.
The Network Oriented Service Type data element in the Service Specification editor includes
Network and Member values for this purpose. If no value is set, the service can be a point-to-
point network-oriented service or a service that is not involved with packet connectivity.

See UIM Concepts for more information about network-oriented services.

When working with Service specifications, see "Service Specification Editor" for reference
information about the tabs you use to define a Service specification.

Related Topics
Creating New Specifications

Working with Service Configuration Specifications

Service Specification Editor

ORACLE

You use the Service Specification editor to define Service specifications. When working with
the Service Specification editor, see the following topics:

e Specification Editor Characteristics Tab

e Specification Editor Specification Properties Tab

e Service Specification Editor Service Properties Tab

e Service Specification Editor Service Configurations Tab
e Service Specification Editor Related Specifications Tab
e Specification Editor Configuration Spec Usage Tab

e Specification Editor Rules Tab

e Specification Editor Layouts Tab

e Specification Editor Media Tab

e Specification Editor Extends Tab
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Service Specification Editor Service Properties Tab

Use the Service Properties tab to set and view the Network Oriented Service Type value.

Field

Use

Network Oriented Service Type

Displays the name of the Service Configuration
specification.

*  None. (Default) Select if this is not a network-
oriented service or represents a point-to-point
network service.

*  Network. Select if this specification represents
the parent service in a network-oriented
service arrangement. For example, in an E-
LAN service arrangement, a service of this
type represents the network as a whole.

*  Member. Select if this Service specification
represents a member service in a network-
oriented service arrangement. A separate
member service is created for each service
location in the arrangement. All member
services have a Network service parent and
appear as configuration items in the parent
Service configuration.

Related Topics

Service Specification Editor

Service Specification Editor Service Configurations Tab

Use the Service Configurations tab to select, add, and remove a service configuration.

Field

Use

Service Configuration

Displays the name of the Service Configuration
specification.

Cartridge Displays the name of the cartridge project into
which the Service Configuration specification is
built.

Select Click to select and add an existing service
configuration to the Service specification.

Open Click to open the selected service configuration in
the Service Configuration Specification editor.

Remove Click to remove the selected service configuration
from the Service specification.

Add Click to create a new service configuration and add

it to the Service specification. See "Adding Existing
Configurations to a Service Specification" for more
information.

Related Topics

Service Specification Editor

ORACLE
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Service Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or
behavior based on those relationships.

Section Use

Inventory Groups Lists the specifications of inventory groups to
which services based on this specification can
belong.

Others Lists specifications of entities that have a
customized relationship with entities based on this
specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Service Configuration Specifications

Service Configuration specifications capture the details about the resources used by the
service. Because these details can change frequently, service configurations provide a
versioning capability that enables the management of the changes to a service over time. As
the facts about a service changes over time, new versions of the service configuration can be
created.

When you define a Service Configuration specification in Design Studio, you determine the
collection of resources that can be assigned to the service. You define these resources as
configuration items. The configuration items can have characteristics that enable you to
express details about the configuration. The configuration items can be arranged hierarchically.
See "Working with Configurations" for more information.

When working with Service Configuration specifications, see the following topics:

* Adding Existing Configurations to a Service Specification
* Adding New Configurations to a Service Specification

e Service Configuration Specification Editor

Adding Existing Configurations to a Service Specification

ORACLE

You can add existing service configurations to a Service specification. The service
configuration and the Service specification do not have to be in the same project.

To add an existing service configuration to a Service specification:

1. Open an existing Service Specification entity in the Service Specification editor or create a
new Service Specification entity.

See "Creating New Specifications" for more information.

2. Click the Service Configurations tab.
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Click Select.

The Add Entities dialog box appears.

Select the service configuration and click OK.

The service configuration you selected appears in the table.

From the File menu, select Save.

Related Topics

Adding Configuration Items

Adding New Configurations to a Service Specification

Adding New Configurations to a Service Specification

You can create and add a new service configurations to a Service specification. The service
configuration and the Service specification do not have to be in the same project. You add a
service configuration in the Service Configurations tab in the Service Specification editor.

ORACLE

To add a new service configuration to a Service specification:

1.

8.

Open an existing Service Specification entity in the Service Specification editor or create a
new Service Specification entity.

See "Creating New Specifications" for more information.
Click the Service Configurations tab.

Click Add.

The Service Configuration Specification Wizard appears.

In the Project field, select the name of the project to which the new specification should be
added.

In the Name field, enter a name for the new specification.
This is the name that will appear in UIM.
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.

b. Navigate to the directory in which to save the entity.
c. Click OK.

Click Finish.

The service configuration you added appears in the table.

From the File menu, select Save.

Related Topics

Creating Configuration Specifications

Adding Configuration Items

Adding Existing Configurations to a Service Specification
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Service Configuration Specification Editor

Use the Service Configuration Specification editor to define Service Configuration
specifications.

When working with the Service Configuration Specification editor, see the following topics:
*  Configuration Specification Editor Details Tab

»  Configuration Specification Editor Layouts Tab

*  Configuration Specification Editor Rules Tab

* Service Configuration Specification Editor Service Specs Tab

Service Configuration Specification Editor Service Specs Tab

ORACLE

Use the Service Specs tab to select, add, and remove the Service specifications that use the
Service Configuration specifications. This tab identifies the Service specifications that use the
Service Configuration specification. You must use this tab to relate a Service specification to its
Service Configuration specification only when the Service specification and Service
Configuration specification need to be in separate cartridges, and the Service specification can
exist without the Service Configuration specification. If both the Service specification and
Service Configuration specification are in the same cartridge, make the association in the
Service Specification editor.

Field Use

Service Specification Displays the name of the Service specification.

Cartridge Displays the name of the cartridge project into
which the Service specification is built.

Select Click to select an existing Service specification.

Open Click to open the selected Service specification in
the Service Specification editor.

Remove Click to remove a Service specification.

Add Click to add a new Service specification.

Related Topics

Service Configuration Specification Editor
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Working with Specifications for Geographic
Location

In Oracle Communications Unified Inventory Management (UIM), you use Place specifications
to define entities that represent places that can be located on maps.

You can also use Property Location entities for geographic locations involved in connectivity
scenarios. Unlike Place entities, Property Location entities are all based on a single entity. You
can extend this predefined specification in Oracle Communications Service Catalog and
Design - Design Studio to include characteristics.

When working with Place and Property Location Extension specifications, see the following
topics:

*  Working with Place Specifications
*  Working with Place Configuration Specifications

*  Property Location Extension Specification Editor

Working with Place Specifications

ORACLE

You use Place specifications to define geographic entities that can be located on a map, such
as a state, city, street, postal address, campus, or building. Place entities answer the business
guestion of where other inventory entities (such as subscribers, services, equipment, service
terminations, and so on) are located.

There are four different types of Place specification that describe different geographical
entities:

* Location defines places based on geographic references.
* Address defines ways to locate places based on textual information.

* Address Range defines a group of addresses as a range, such as an address defined with
a low street number and high street number.

» Site define places that do not have a single, precise location like a regional office or a cell
site that may change physical locations over time.

When working with Place specifications, see the following topics:

e About the Site Place Type

e About the Address Place Type

e About the Address Range Place Type
e About the Location Place Type

» Defining Place Types

*  Place Specification Editor
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About the Site Place Type

A site is a loosely defined place such as a campus, cell site, or VPN site. Unlike a location, a
site is not necessarily bound to specific geographic coordinates. Because sites are only loosely
defined, they can evolve over time. For example, you might need to plan a VPN without
knowing the specific locations of the VPN sites. You can create configurations to keep track of
the changes.

If a site includes multiple specific locations, you can include them in a Place hierarchy for the
site. For example, if you create a Site specification instance for a campus, you can create
Location specification instances for its individual buildings and include them in the site's Place
hierarchy.

Related Topics
Defining Place Types

Place Specification Editor

About the Address Place Type

An Address specification can be used to define a standard address format to meet your
business requirements and national postal standards. For example, you could define an
Address specification that includes the following information:

e Street address

e City name

e State or province
e Country

* Postal code

These individual pieces of information are called address components. You define them as
characteristics and add them to a Place specification with the entity type of Address.

Address components are classified into the following categories:

* Geographically based: Values for these components can be defined as a geographic
location based on Location-type Place specification.

* Non-geographically based: Values for these components cannot be defined as
geographic locations, so they are typically captured as text.

For geographically-based address components, you can add characteristics to an Address
specification that provide lists of entities of the appropriate type. See "Populating Drop-Down
Lists Dynamically" for more information.

Related Topics
Defining Place Types

Place Specification Editor
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About the Address Range Place Type

You use Address Range specifications to define collections of addresses such as those used in
Master Street Address Guide (MSAG) implementations. You can include individual addresses
in the Place hierarchy of an address range instance.

Related Topics
Defining Place Types

Place Specification Editor

About the Location Place Type

You use the Location type for places that can be specifically defined by geographic references.
Locations can be very specific places, such as a residence, or more general places, such as a
city or province. In UIM, you create these hierarchies in the Place Hierarchy section of the
Place Summary page.

You can geocode a location to identify its placement on the face of the earth and to enable
geographic visualizations of your network or business.

Using geographic coordinates also makes it possible to calculate distances between locations.

Related Topics
Defining Place Types

Place Specification Editor

Defining Place Types

You select from the four types of places when modeling Place specifications.
To select a place type:

1. Create a new Place specification or navigate to the editor of an existing one.
See "Creating New Specifications" for more information.

2. Click the Properties tab.

3. Inthe Entity Type field, select a place type.
See "Place Specification Properties Tab" for more information.

4. From the File menu, select Save.

Related Topics

Place Specification Editor

Working with Place Specifications

Place Specification Editor

You use the Place Specification editor to model Place specifications. When working with Place
specifications, see the following topics:

*  Specification Editor Characteristics Tab
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»  Specification Editor Specification Properties Tab

* Place Specification Properties Tab

*  Place Specification Editor Place Configurations Tab
* Place Specification Editor Related Specifications Tab
»  Specification Editor Configuration Spec Usage Tab

e Specification Editor Rules Tab

»  Specification Editor Layouts Tab

e Specification Editor Media Tab

e Specification Editor Extends Tab

»  Specification Editor Tags Tab

Place Specification Properties Tab

Use the Properties tab to define the entity type for the Place specification. In the Entity Type
field, select one of the following values:

Field Use

Site Select to define a place that does not have a
single, precise location. See "About the Site Place
Type" for more information.

Address Select to define a place using the standard
address format to meet your business
requirements and national postal standards. See
"About the Address Place Type" for more
information.

Address Range Select to define a place using groups of related
addresses. See "About the Address Range Place
Type" for more information.

Location Select to define a place based on geographic
references. See "About the Location Place Type"
for more information.

Related Topics
Defining Place Types

Place Specification Editor

Place Specification Editor Place Configurations Tab

Use the Place Configurations tab to relate Place specifications defined as Site (on the Place
Specification editor Properties tab) to Place configurations.

# Note:

You use this tab for geographic sites only. The buttons on this tab are disabled for all
other types of Place specifications.
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Field Use

Place Configurations Displays the name of the Place Configuration
specification.

Cartridge Displays the name of the cartridge project into
which the Place Configuration specification is built.

Select Click to select an existing Place Configuration
specification.

Open Click to open the selected configuration in the
Place Configuration Specification editor.

Remove Click to remove a Place Configuration
specification.

Add Click to add a new Place Configuration
specification.

Place Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or
behavior based on those relationships.

Section Use

Inventory Groups Lists the specifications of inventory groups to
which places based on this specification can
belong.

Roles Lists roles to which entities based on this Place
specification can be assigned.

Others Lists specifications of entities that have a
customized relationship with entities based on this

specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Place Configuration Specifications

ORACLE

Place Configuration specifications capture the details about the resources used by the Place
specification. Place configurations only apply to Place entities defined as sites.

You can add existing Place Configuration specifications to a Place specification or you can
create new Place Configuration specifications in the process of adding it to a Place
specification. The place configuration and the Place specification do not have to be in the
same project.

When working with Place Configuration specifications, see "Place Configuration Specification
Editor" for more information.
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Place Configuration Specification Editor

Use the Place Configuration Specification editor to model Place Configuration specifications.
When working with Place Configuration specifications, see the following topics:

Chapter 6
Property Location Extension Specification Editor

e Configuration Specification Editor Details Tab

e Configuration Specification Editor Layouts Tab

e Configuration Specification Editor Rules Tab

« Place Configuration Specification Editor Place Specs Tab

Place Configuration Specification Editor Place Specs Tab

Use the Place Specs tab to select, add, and remove the Place specifications that use the
Place Configuration specifications. The Place Specs tab identifies the Place specifications that
use the Place Configuration specification. You must use this tab to relate a Place specification
to its Place Configuration specification only when the Place specification and Place
Configuration specification need to be in separate cartridges, and the Place specification can
exist without the Place Configuration specification. If both the Place specification and Place
Configuration specification are in the same cartridge, make the association on the Place

specification.

Field

Use

Place Specification

Displays the name of the Place specification.

Cartridge Displays the name of the cartridge project into
which the Place specification is built.

Select Click to select an existing Place specification.

Open Click to open the selected specification in the
Place Specification editor.

Remove Click to remove a Place specification.

Add Click to add a new Place specification.

Related Topics

Place Specification Editor

Property Location Extension Specification Editor

You use the Property Location Extension Specification editor to extend the predefined Property
Location specification. When working with the Property Location Extension Specification editor,

ORACLE

see the following topics:

«  Specification Editor Characteristics Tab
e Specification Editor Layouts Tab

e Specification Editor Rules Tab

e Specification Editor Extends Tab
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Working with Party and Role Specifications

You use Part and Role specifications to define the people and organizations in your inventory
and to define the functions that entities serve in your inventory.

When working with Party and Role specifications, see the following topics:

Working with Party Specifications

Working with Role Specifications

Working with Party Specifications

You create Party specifications to model the people or organizations that interact with your

inventory. Party specifications answer the business question of who is involved in your
inventory.

Parties often play roles in your inventory. You can assign roles that are defined by Role
specifications. You can assign one or more roles to an instance of a Party specification.

When working with Party specifications, see "Party Specification Editor" for reference
information about the tabs you use to define a Party specification.

Related Topics

Creating New Specifications

Party Specification Editor

Use the Party Specification editor to model Party specifications. When working with Party
specifications, see the following topics:

Specification Editor Characteristics Tab
Specification Editor Specification Properties Tab
Party Specification Editor Related Specifications Tab
Specification Editor Configuration Spec Usage Tab
Specification Editor Rules Tab

Specification Editor Layouts Tab

Specification Editor Media Tab

Specification Editor Extends Tab

Party Specification Editor Related Specifications Tab

ORACLE

Use the Related Specifications tab to define and review specification relationships. Only

relationships with the entity types listed in this tab are meaningful by default in UIM. If you add

specifications to the Others section, you must define custom rulesets that trigger actions or

behavior based on those relationships.
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Section Use

Inventory Groups Lists the specifications of inventory groups to
which party entities based on this specification can
belong.

Roles Lists roles to which entities based on this Party
specification can be assigned.

Others Lists specifications of entities that have a
customized relationship with entities based on this
specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Role Specifications

You create Role specifications to define the functions played by entities in an inventory. For
example, an instance of a Party specification called Individual could have the role of subscriber
or employee.

When working with Role specifications, see the following topics:

* About Role Specifications
*  Configuring a Role Specification

* Role Specification Editor

About Role Specifications

ORACLE

An entity can play multiple roles simultaneously and its roles can change over time. For
example, an instance of a Party specification called Organization could be both a supplier and
a customer, either at the same time or at different times.

When a role specification is created you must select one or more role-enabled entity types to
which the role applies. When an instance of the selected entity type is created in UIM, the role
may be optionally applied to the entity. For example the role of MPLS can be applied to a
Logical Device and a Pipe, indicating that they both support MPLS technology.

An entity's role might be relevant to its involvements with other entities. See "Working with
Involvement Specifications" for more information about involvements.

Not all entity types can be assigned roles. In UIM, role-enabled entities have Role areas on
their Summary pages.

When you create a Role specification, you can optionally select a role type.
The following are the role types:

» Technology: This role defines the technology that an entity operates under or supports.
e Function: This role defines the function that an entity plays.

» Topology: This role defines the role the topology plays in the network topology, such as
hub or spoke.
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e Target: This role identifies the entity as a target for activation systems. See "About
Network Targets" for more information.

Related Topics
Configuring a Role Specification

Role Specification Editor

About Network Targets

A network target is a resource on which services or other resources must be activated. For
example, in a GSM network, a voice mail service must be activated on a voice mail server. In
this scenario, the voice mail server is the target for the voice mail account.

In Oracle Communications Service Catalog and Design - Design Studio, you can create Role
specifications with the Target role type. In UIM, Role entities based on specifications of the
Target role type can be associated to logical devices and parties to identify them as network
targets.

When you assign a Target role to a Logical Device or Party entity, it becomes a target for other
entities associated with it in various ways. Logical devices are network targets for:

e Logical device accounts associated with them

« Logical devices in their hierarchies (unless those logical devices are themselves network
targets)

*  Device interfaces in their hierarchies

e Any entities with which they have custom involvements based on the Manages (Oracle
Provided) base specification

Parties can be network targets for:

* Any entities associated with them

* Any entities with which they have custom involvements based on the Manages (Oracle
Provided) base specification

Related Topics
Configuring a Role Specification

Role Specification Editor

Configuring a Role Specification

ORACLE

When configuring Role specifications, you specify role types and valid entity types.
To configure Role specifications:

1. Create a new Role specification or navigate to the editor of an existing one.
See "Creating New Specifications” for more information.

2. Inthe Role Specification editor, click the Properties tab.

3. Inthe Role Type field, select Technology, Function, Topology, or Target.
See "About Role Specifications” for more information.

4. Inthe Available Entity Types list, select the entity type or types that you want to be able
to have this role.
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5. Click the right arrow button to move the entity types to the Selected Entity Types list.

If necessary, you can use the left arrow button to move entity types back to the Available
Entity Types list.

6. From the File menu, select Save.

Related Topics

Role Specification Editor

Role Specification Editor

Use the Role Specification editor to define the functions played by entities in an inventory.
When working with the Role Specification editor, see the following topics:

*  Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab
* Role Specification Editor Properties Tab

e Specification Editor Related Specifications Tab
*  Specification Editor Rules Tab

*  Specification Editor Layouts Tab

*  Specification Editor Media Tab

*  Specification Editor Extends Tab

*  Specification Editor Tags Tab

Role Specification Editor Properties Tab

ORACLE

Use the Properties tab to select a role type for the role specification that you create.

Field Use

Role Type Select a role type when you create a role

specification. Select one of the following:

*  Technology: Defines the technology that an
entity operates under or supports.

*  Function: Defines the function that an entity
plays.

*  Topology: Defines the role the topology plays
in the network topology, such as hub or spoke.

*  Target: This role identifies the entity as a
target for activation systems.

Available Entity Types Displays the entity types that are available for
selection.
Selected Entity Types Displays the entity types that have been selected.

Related Topics
Configuring a Role Specification

Role Specification Editor
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Working with Business Interactions and
Workflow-Related Specifications

ORACLE

In Oracle Communications Unified Inventory Management (UIM), you use business
interactions, engineering work orders, and projects to plan and organize how you build and
maintain your network. You can optionally associate workflow templates with business
interactions and engineering work orders. Workflow templates enable you to manage work and
the people you assign to complete it.

In Oracle Communications Service Catalog and Design - Design Studio, you define
specifications for entities related to planning and workflow:

Business Interaction specifications define arrangements for completing a set of activities,
such as adding resources to the network to increase capacity or to support new locations.
See "Working with Business Interaction Specifications" for more information.

Process specifications define ordered sequences of activities and transitions that
accomplish a goal, such as installing a device or designing a network. When deployed to
UIM, Process specifications become workflow templates that you can associate with
business interactions and engineering work orders. See "Working with Process
Specifications" for more information.

Task specifications define activities that must be completed as part of a workflow. In
Design Studio, you associate Task specifications with the activities that are included in a
Process specification. See "Working with Task Specifications" for more information.

Checklist specifications define steps that must be included to complete an activity. You
associate Checklist specifications with activities in a Process specification. See "Working
with Checklist Specifications" for more information.

You use two other types of entities in UIM for related purposes:

Engineering work orders are specialized versions of business interactions with some
added functionality. In UIM, all engineering work orders are based on the same Business
Interaction specification (Engineering Work Order), which is supplied as part of the
ora_uim_workorder base cartridge.

# Note:

The engineering work orders you create in Design Studio are not the same as
engineering work orders in UIM. Engineering work orders in Design Studio are
used as containers for Process, Task, and Checklist specifications. Engineering
work orders and the specifications they contain become workflow templates in
UIM. See "Designing Workflows" for more information.

UIM projects enable you to manage grooming and rehoming activities for channelized
connectivity. You can also use them to group related business interactions and engineering
work orders so that you can manage them together. All UIM projects are based on the
same specification, called Managed Project, to differentiate them from Design Studio
cartridge projects. You can modify the Managed Project specification to include
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characteristics that you define. See "Working with the Managed Product Specification” for
more information.

Working with Business Interaction Specifications

You use Business Interaction specifications to define arrangements or transactions that provide
context to actions performed on entities in the inventory. You can define specifications for
business interactions such as service orders, projects, work orders, tasks, and plans.

A business interaction in UIM provides a context for tracking the transactions that are
performed against the inventory. Any additions, changes, or deletions to items in the inventory
made under the context of a business interaction are included in its transactions. The
transactions associated with a business interaction become effective when the business
interaction is completed, and they are canceled when the business interaction is canceled.
Business interactions provide traceability and auditability. They also enable transaction
cancellations and changes. Business interactions can include child business interactions.

You create Business Interaction specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.

See "Business Interaction Specification Editor" for reference information about the tabs you
use to define a Business Interaction specification.

Business Interaction Specification Editor

Use the Business Interaction Specification editor to define arrangements or transactions that
affect entities in the inventory.

When working with the Business Interaction Specification editor, see the following topics:

*  Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab

* Specification Editor Related Specifications Tab

*  Specification Editor Configuration Spec Usage Tab
e Specification Editor Rules Tab

*  Specification Editor Layouts Tab

*  Specification Editor Media Tab

*  Specification Editor Extends Tab

*  Specification Editor Tags Tab

Working with the Managed Product Specification

ORACLE

All Project entities in UIM are based on the Managed Project specification. You can extend this
specification by defining entity-level characteristics. When you define entity-level
characteristics for this specification and deploy the cartridge that contains it to UIM, the new
characteristics apply to all Project entities.

Related Topics
Extending Predefined Specifications

Entity Extension Editor
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Designing Workflows

In UIM, you can add workflow templates to engineering work orders and business interactions.
Workflow templates define an ordered sequence of activities that must be completed. For
example, a workflow template could define the activities required for an access site rollout.

In Design Studio, you design workflow templates by creating Engineering Work Order
specifications that include Process specifications. Process specifications include Task
specifications and Checklist specifications.

< Note:

The engineering work orders you create in Design Studio are not the same as
engineering work orders in UIM. Engineering work orders in Design Studio are used
as containers for Process, Task, and Checklist specifications. Engineering work
orders and the specifications they contain become workflow templates in UIM.

When designing workflows, see the following topics:

* Associating a Process Specification to an Engineering Work Order Specification
* Engineering Work Order Editor

*  Working with Process Specifications

*  Working with Task Specifications

*  Working with Checklist Specifications

Associating a Process Specification to an Engineering Work Order
Specification

You associate a Process specification with an Engineering Work Order specification to define
the process flow for work orders based on that specification. (In UIM, process flows are called
workflows.) You can associate an existing Process specification or create a new one. An
Engineering Work Order specification is empty until you associate a Process specification with
it.

To associate a Process specification:

1. In an Engineering Work Order editor, click the Properties tab.
2. Do one of the following:

To select an existing Process specification:

a. Click the Select button.

The Select Process dialog box appears.

b. Select a Process specification, and then click OK.

To create a new Process specification:

a. Click the Process link.

The Process Wizard dialog box appears.
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b. Enter a name, and then click Finish.

The dialog box closes and the Process specification name is displayed in the Process field
on the Properties tab. You can click the Process link to open the editor for the Process
specification.

Related Topics
Working with Process Specifications

Engineering Work Order Editor

Engineering Work Order Editor

Use the Engineering Work Order editor to define work orders that organize workflows and
activities in UIM.

When working with the Engineering Work Order editor, see the following topics:

e Order Data Tab
*  Engineering Work Order Properties Tab

Order Data Tab

Use the Order Data tab to view the contents of the Engineering Work Order specification. All
information in this tab is read-only.

Field Use

Task List Displays a list of the activities and associated tasks
in the Engineering Work Order specification.

Related Specifications Displays a list of related specifications for the task
selected in the Task List table.

Related Tasks Displays a list of the Task specifications that
include the specification selected in the Related
Specifications table.

Engineering Work Order Properties Tab

Use the Engineering Work Order Properties tab to select and view a Process specification
for this Engineering Work Order specification.
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Field

Use

Process Displays the Process specification (if any)

associated to this Engineering Work Order

specification.

Click the Process link to:

*  Open the editor for the associated Process
specification.

»  Create a new Process specification and
associate it to the Engineer Work Order
specification.

»  Select an existing Process specification for
this Engineering Work Order specification.

See "Associating a Process Specification to an

Engineering Work Order Specification”.

Related Topics

Working with Process Specifications

Working with Process Specifications

You create Process specifications to define process flows. Process flows are available in UIM
as workflow templates that define ordered sequences of activities and transitions that you can
include in engineering work orders and business interactions. The Process specification name
in Design Studio becomes the name of the workflow template in UIM.

You include Process specifications in Engineering Work Order specifications in Design Studio.
You deploy the Engineering Work Order specifications into UIM to create workflow templates.

< Note:

The engineering work orders you create in Design Studio are not the same as
engineering work orders in UIM. Engineering work orders in Design Studio are used
as containers for Process, Task, and Checklist specifications. Engineering work
orders and the specifications they contain become workflow templates in UIM. See
"Designing Workflows" for more information.

When working with Process specifications, see the following topics:

e Creating a Process Flow

*  Process Editor

Creating a Process Flow

A process flow is an ordered set of activities and transitions. You define Process specifications
so that you can deploy reusable patterns to UIM to manage workflows. For example, you could
define an access site rollout process that describes the steps that must be repeated each time
you bring a new access site online in your network. In UIM, you can modify the exact steps to
account for the peculiarities of each situation.

ORACLE
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In UIM, process flows are called workflows. You can include them in both engineering work
orders and business interactions. See UIM Concepts and UIM Help for more information.

The following rules govern process flows:

* Every flow begins with a Start activity and ends with an End activity. These activities are
predefined.

* Backward flows are not valid.

* You can include any number of activities between the start and end of the flow.
*  You can include multiple, parallel flows from a single parallel activity.

*  Two or more parallel flows can converge on the same activity.

* In UIM workflows, activities must be completed in sequence. Work on the next activity (or
activities in the case of parallel flows) cannot begin until the preceding activity is complete.

You can create process flows for Process specifications in three ways:

* By using the palette in the Process Flow tab to add activities and flows graphically. See
"Creating a Process Flow Graphically".

* By dragging Task specifications into the Process Flow tab. See "Creating a Process Flow
by Dragging and Dropping".

* By using the Activities tab to add activities and the Transitions tab to define flows. See
"Creating a Process Flow in the Activities and Transitions Tabs".

Creating a Process Flow Graphically

ORACLE

You can create a process flow by using the palette in the Process Flow tab of the Process
editor.

To create a process flow graphically:

1. Open or create a Process specification.
The Process specification editor appears.

2. Click the Process Flow tab.

3. Click the Activity item in the Palette menu.
The cursor is replaced by crosshairs.

4. Click where you want the activity to appear in the palette. You can reposition the activity
later if necessary.

The Create Activity dialog box appears.
5. In the Name field, enter a name for the activity.

6. (Optional) In the Display Name field, enter a name for the activity that will be visible in
UIM. If you do not enter a display name, the activity name is used instead.

7. Inthe Task field, do one of the following:
To associate the activity with an existing Task specification:
a. Click the Select button.
The Select Task dialog box appears.

b. Select a Task specification, and then click OK.
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The Select Task dialog box closes and the Create Activity dialog box displays the
name of the task.

To create and select a new Task specification:
a. Click the New button.
The Task Specification Wizard dialog box appears.
b. Enter a name for the Task specification.
c. (Optional) Enter or select a location for the Task specification.
d. Click OK.

The Task Specification Wizard dialog box closes and the Create Activity dialog box
displays the name of the task.

(Optional) To flag the activity as critical, select the Critical check box. Critical activities are
displayed with special icons in UIM.

Click OK.

The Create Activity dialog box closes and the activity appears as a box in the palette.
Repeat steps 3 through 9 for each activity you want to include in the process flow.
Click the End item in the Palette menu.

The cursor is replaced by crosshairs.

Click where you want the end item to appear in the palette. You can reposition the activity
later if necessary.

The End icon appears in the palette.

Repeat the following steps for each transition in the flow, starting with the Start icon and
ending with the End icon:

a. Inthe Flows area of the palette, click the Next item.
The cursor is replaced by crosshairs.

b. Position the crosshairs in the Start icon or an activity box until the icon or box is
highlighted.

c. Drag to the next activity in the flow, and then click when the activity is highlighted.

An arrow connects the boxes in the palette.

Creating a Process Flow by Dragging and Dropping

ORACLE

You can create a process flow by dragging Task specifications to the Process Flow tab of the
Process editor.

To create a process flow by dragging and dropping:

1.

While in the Studio Design perspective, open or create a Process specification.

The Process specification editor appears.

Click the Process Flow tab.

In the Studio Projects editor, click and drag a Task specification into the Process Flow tab.

An activity is added to the process flow based on the Task specification. You can edit the
activity to change its properties.
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Related Topics
Editing A Process Flow

Creating a Process Flow in the Activities and Transitions Tabs

ORACLE

You can create a process flow by creating activities in the Activities tab and defining
transitions in the Transitions tab.

To create a process flow in the Activities and Transitions tabs:

1. Open or create a Process specification.
2. Click the Activities tab.
3. In the Activities section, click Add.
The Create Activity dialog box appears.
4. Inthe Name field, enter a name for the activity.

5. (Optional) In the Display Name field, enter a name for the activity that will be visible in
UIM. If you do not enter a display name, the activity name is used instead.

6. Inthe Task field, do one of the following:
To associate the activity with an existing Task specification:
a. Click the Select button.
The Select Task dialog box appears.
b. Select a Task specification, and then click OK.

The Select Task dialog box closes and the Create Activity dialog box displays the
name of the task.

To create and select a new Task specification:
a. Click the New button.
The Task Specification Wizard dialog box appears.
b. Enter a name for the Task specification.
c. (Optional) Enter or select a location for the Task specification.
d. Click OK.

The Task Specification Wizard dialog box closes and the Create Activity dialog box
displays the name of the task.

7. (Optional) To flag the activity as critical, select the Critical check box. Critical activities are
displayed with special icons in UIM.

8. Click OK.

The Create Activity dialog box closes and the activity appears as a row in the Activities
table. Its details are shown in the Activity Area to the right of the table. (Activities you
create in the Activities tab are also visible in the Process Flow tab.)

9. Repeat steps 3 through 8 for each activity you want to include in the process flow.
10. Click the Transitions tab.
11. Click Add below the Transitions table.

The Create Transitions Element dialog box appears.
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12. Repeat the following steps for each transition in the flow, beginning with the Start icon and

ending with the End icon:
a. Inthe From Activity field, click Select.

The Select From Activity dialog box appears.
b. Select an activity, and then click OK.

The Select From Activity dialog box closes and the activity appears in the From
Activity field.

c. Inthe To Activity field, click Select.
The Select To Activity dialog box appears.
d. Select an activity (or End), and then click OK.

The Select To Activity dialog box closes and the activity appears in the To Activity
field.

Editing A Process Flow

You can edit the activities and transitions in a process flow.

To edit activities:

1.

2.

In the Activities tab, select an activity.
The activity details appear in the Activity area.

Edit the details as necessary. Your changes are effective immediately.

To edit transitions:

1.

In the Transitions tab, select a transition.
The transition details appear in the Transition area.

To replace an activity in the transition, click the Select button in the From Activity or To
Activity area.

The Select From Activity or Select To Activity dialog box appears. The list of activities is
filtered to prevent you from making invalid selections.

Select an activity, and then click OK.

The dialog box closes and the new activity appears in the transition.

Changing Palette Settings

You can change the appearance of the palette controls in the Process Flow tab in several
ways.

ORACLE

1.

Right-click in the heading of the Activities or Transitions section of the palette, and then
select Settings from the menu that appears.

The Palette Settings dialog box appears.
Do any combination of the following:

e Inthe Font area, click Change and select a different font for the palette. Click Restore
Default to revert to the original font.

* Inthe Layout area, select an option for the arrangement of items in the palette.

* Inthe Drawer Options area, select an option for how sections in the palette behave.
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The dialog box closes and your changes take effect.

Process Editor

Use the Process editor to define process flows that you can include in Engineering Work Order

and Business Interaction specifications.

When working with the Process editor, see the following topics:

*  Process Flow Tab
e Activities Tab

¢ Transitions Tab

Process Flow Tab

Activities Tab

ORACLE

Use the Process Flow tab to design process flows. You use a graphical palette to add

activities and transitions between activities.

Section

Use

Canvas

Displays activities and transitions that you have
defined for the process. A Start activity appears
automatically.

You can drag activities to reposition them. The
lines representing transitions automatically adjust
to reflect your changes.

Double-click an activity to open the Task editor for
the Task specification associated with the activity.

Palette

Displays tools for adding activities and transitions
to the process.

Click Activity to add an activity that you associate
with a Task specification.

Click End to add an End activity.
Click Next to add a transition between activities.

Related Topics

Creating a Process Flow Graphically
Editing A Process Flow

Changing Palette Settings

Use the Activities tab to define and view activities in the Process specification.
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Section

Use

Activities

Lists the activities that have been defined for this
process. The table includes activities that you
define on this tab and those you define graphically
in the Process Flow tab.

Click Add to add an activity. Select an activity and
click Remove to remove it.

Activity

Displays information about the activity selected in
the Activities table.

Click Select in the Task area to change the task
associated with the activity. Click the Task link to
go to the Task editor.

Related Topics

Creating a Process Flow in the Activities and Transitions Tabs

Editing A Process Flow

Transitions Tab

Use the Transitions tab to define and view transitions between activities in the Process

specification.

Section Use

Transitions Lists the transitions that have been defined for this
process. The table includes transitions that you
define on this tab and those you define graphically
in the Process Flow tab.
Click Add to add a transition. Select a transition
and click Remove to remove it.

Transition Displays information about the transition selected

in the Transitions table.

Click Select in the From Activity or To Activity area
to change the activity. Click the From Activity or
To Activity link to go to the Activities tab.

Related Topics

Creating a Process Flow in the Activities and Transitions Tabs

Editing A Process Flow

Working with Task Specifications

Task specifications define units of work that you can associate with activities in engineering
work orders. Task specifications can include Checklist specifications that define steps that

ORACLE

must be completed to complete the task.

See "Task Specification Editor" for reference information about the tabs you use to define a
Task specification. See "Defining Task Properties” for information about selecting a checklist

and defining other properties.
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Defining Task Properties

After you create a Task specification, you can specify its properties, including the task duration
and a checklist. All of the properties are optional.

To specify task properties:
1. Go to the Task specification editor Properties tab.

2. Inthe Duration (in days) field, enter the estimated duration of the task.

3. Inthe Allowed User Group field, enter a user group name to restrict UIM users who can
be assigned the task.

4. Select the Is Milestone check box if you want the task to serve as a milestone in UIM.
Milestone activities are displayed as diamonds in Gantt charts.

5. Inthe Checklist field, click Select.

The Select Checklist dialog box appears.
6. Select a checklist and click OK.

The Checklist field is updated.

Relating Resource Specifications with Task Specifications

ORACLE

You can use the Related Specifications tab in the Task editor to relate resource specifications
with Task specifications. In UIM, these relationships result in the creation of items in the
Actions menu of Activity Workspace sections for activities based on the Task specification.
The menu item takes UIM users directly to the New page for entity type and specification.

For example, you could relate the Cisco 3063 Logical Device specification to a Task
specification in Design Studio. In UIM, users can create Cisco 3063 logical devices directly
from the Activity Workspace section.

You can relate the following types of specifications with Task specifications:
e Connectivity

*  Custom Network Address
e Custom Object

e Equipment

e Logical Device

e Logical Device Account

* Media Stream

e Property Location

* Party

*  Physical Device

* Pipe

e Telephone Number

To relate resource specifications to Task specifications:

1. Go to the Task specification editor Related Specifications tab.
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Click Select.

The Select Dialog dialog box appears, displaying a list of specifications in the current
cartridge project.

Do one of the following:
» Select a specification, and then click OK.

« Click New, and then create a new specification. See "Creating New Specifications" for
more information.

The specification you selected or created appears in the Related Specifications tab.

Task Specification Editor

Use the Task Specification editor to define Task specifications. When working with Task
specifications, see the following topics:

Specification Editor Characteristics Tab

Task Specification Properties Tab

Task Specification Editor Related Specifications Tab
Specification Editor Rules Tab

Specification Editor Layouts Tab

Specification Editor Extends Tab

Specification Editor Tags Tab

Task Specification Properties Tab

Use the Properties tab to define properties for the Task specification.

Section Use

Duration (in days) Displays the estimated duration of the task. This
duration is used for charting and workflow planning
in UIM.

Allowed User Group Limits the UIM users who can be assigned this
task to members of the specified user group.

Is Milestone Determines whether the task serves as a
milestone in UIM.

Checklist Displays the checklist associated with the Task
specification.

Click Select to select or change the checkilist.

Related Topics

Defining Task Properties

Task Specification Editor

Task Specification Editor Related Specifications Tab

Use the Related Specifications tab to relate a resource specification to the Task specification.
A specification listed here becomes an item in the Actions menu in the Activity Workspace

ORACLE
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section of Activity Details pages in UIM. Resource entities are not created automatically as the
result of relationships defined in this tab.

Field Use

Specification Displays the name of the resource specification.

Cartridge Displays the name of the cartridge project into which the
specification is built.

Type Displays the type of the specification, such as Service
specification or Place specification.

Select Click to select an existing specification or to create a new one.

Modify Click to modify the relationship properties. The properties

related to requirements or to quantity are not meaningful in this
case because UIM entities are not created automatically as
the result of relationships established in this tab.

Remove Click to remove the related specification.

Related Topics
Relating Resource Specifications with Task Specifications

Task Specification Editor

Working with Checklist Specifications

You define Checklist specifications that you can associate with Task specifications. The
Checklist specification defines the individual steps that must be completed to complete a task.

In UIM, all checklist items must be marked as complete before an activity can be completed.
When working with Checklist specifications, see the following topics:

* Creating a Checklist
*  Checklist Specification Editor

Creating a Checklist

To create a checklist:

1. Repeat the following steps for each item you want to include in the checklist:
a. Create a Checklist specification.
b. Inthe Properties tab, click Add.
The Checklist Item dialog box appears.
c. Enter a description for the checklist item, and then click OK.
The dialog box closes and the Checklist ltems table displays the item you added.

2. (Optional) To adjust the order of the checklist items, select an item and click Move Up or
Move Down.

3. (Optional) To remove an item from the checklist, select it and click Remove.
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Checklist Specification Editor

Use the Checklist Specification editor to define steps to be completed sequentially as part of
an activity. You associate Checklist specifications with Task specifications.

When working with Checklist specifications, see the following topics:

*  Checklist Specification Properties Tab

e Specification Editor Rules Tab

Checklist Specification Properties Tab

Use the Properties tab to define checklist items.

Section Use

Checklist ltem Displays a list of the items in the checklist.

Click Add to add an item. Select items, and then
click Move Up or Move Down to change the order
of items.

Tagging Task and Resource Specifications for Bills of Material

In UIM, you can generate bills of materials (BOMs) for engineering work orders and business
interactions. To enable this functionality, you apply the following tags to Task specifications and
resource specifications:

e The billable tag applies to both Task specifications and resource specifications. When you
apply this tag to a specification, entities based on it are included in BOMs created in UIM.

e The billofmaterials tag applies only to Task specifications. When you apply this tag to a
specification, Activity Summary pages for activities based on this specification include an
Actions menu item that enables you to create a BOM directly.

Generating cost data for BOMs requires the use of custom tags. For example, you can create
a custom tag named costreferenceid that includes an ID for the task or resource. Generating
cost data also requires extending UIM to retrieve data from external systems or from custom
tables in the UIM database. See “Working with Tags" and UIM Developer's Guide for more
information.
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Working with Logical Device, Physical Device,
and Equipment Specifications

You can model equipment in Oracle Communications Service Catalog and Design - Design
Studio using several different methods. You can inventory all of your physical hardware
resources down to the port level for asset-tracking purposes and you can model your network
elements as logical devices for activation purposes.

When working with Equipment and Logical Device specifications, see the following topics:

*  Working with Logical Device Specifications

*  Working with Logical Device Configuration Specifications

*  Working with Device Interface Specifications

*  Working with Flow Interface Specifications

*  Working with Logical Device Account Specifications

*  Working with Logical Device Account Configuration Specifications
*  Working with Physical Device Specifications

*  Working with Equipment Specifications

*  Working with Equipment Holder Specifications

*  Working with Physical Port Specifications

*  Working with Physical Connector Specifications

Working with Logical Device Specifications

A logical device represents a functional view of a set of resources. The logical device itself is
not physical, but it can be supported by one or more physical resources that support it and act
together logically to perform one or more functions.

In the telecommunications industry, logical devices are often called network elements, but the
terms are not interchangeable. In Unified Inventory Management (UIM), a logical device can
also be a non-intelligent device that does not qualify as a network element. Logical devices
that are network elements are addressable and manageable and can be managed through an
element management system (EMS). See UIM Concepts for information on relating Logical
Device specifications to Device Interface specifications.

Logical devices can be supported by one hardware item like a desktop router or by many
pieces of hardware such as:

*  Central office switches
» Digital cross-connect systems (DCS)
» Digital subscriber line access multiplexers (DSLAM)

e Main distribution frames (MDF)
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A logical device can support other logical devices to create a hierarchy. You create Logical
Device specifications in the same manner as other types of specifications. See "Creating New

Specifications" for more information.

When working with Logical Device specifications, see "Logical Device Specification Editor" for
reference information about the tabs you use to define a Logical Device specification.

Logical Device Specification Editor

Use the Logical Device Specification editor to model logical devices. When working with the

Logical Device Specification editor, see the following topics:

Logical Device Specification Editor Properties Tab

Specification Editor Characteristics Tab

Specification Editor Specification Properties Tab

Logical Device Specification Editor Properties Tab

Logical Device Specification Editor Logical Device Configurations Tab

Specification Editor Related Specifications Tab

Specification Editor Configuration Spec Usage Tab

Specification Editor Rules Tab
Specification Editor Layouts Tab
Specification Editor Media Tab
Specification Editor Extends Tab
Specification Editor Tags Tab

Use the Properties tab to enter information about the logical device.

Field

Use

Vendor

Enter the vendor name of the logical device.

Model Number

Enter the model number of the logical device.

Part Number

Enter the part number of the logical device.

Related Topics

Logical Device Specification Editor

Logical Device Specification Editor Logical Device Configurations Tab

Use the Logical Device Configurations tab to enter information about the Logical Device
Configuration specification.

Field

Use

Logical Device Configuration

Displays the name of the Logical Device
Configuration specification.

Cartridge

Displays the name of the cartridge project into
which the Logical Device Configuration
specification is built.

ORACLE
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Field Use

Select Click to select an existing Logical Device
Configuration specification.

Open Click to open the selected configuration in the
Logical Device Configuration Specification editor.

Remove Click to remove the Logical Device Configuration
specification.

Add Click to add a new Logical Device Configuration

specification.

Related Topics

Logical Device Specification Editor

Logical Device Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or

ORACLE

behavior based on those relationships.

Section

Use

Inventory Groups

Lists specifications of inventory groups to which
logical devices based on this specification can
belong.

Device Interfaces

Lists specifications of device interfaces that can be
provided by logical devices based on this
specification.

Roles

Lists roles to which logical devices based on this
specification can be assigned.

Logical Device Accounts

Lists specifications of logical device accounts that
can be associated with logical devices based on
this specification.

Network Nodes

Lists specifications of network nodes that can
represent logical devices based on this
specification.

Logical Devices

Lists specifications of logical devices that can be
children of logical devices based on this
specification.

Others

Lists specifications of entities that have a
customized relationship with entities based on this
specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab
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Working with Logical Device Configuration Specifications

The Logical Device Configuration specification captures the details about the resources used
by the logical device. A Logical Device Configuration specification can include configuration
items. Configuration items can have characteristics and can also consume a resource.

You can associate only the following specifications to the Logical Device Configuration
specification:

e Custom network address

e Custom object

* Device interface

When working with Logical Device Configuration specifications, see the following topics:
* Adding Existing Configurations to a Logical Device Specification

* Adding New Configurations to a Logical Device Specification

* Logical Device Configuration Specification Editor

Adding New Configurations to a Logical Device Specification

ORACLE

You can add new configurations to a Logical Device specification. The logical device
configuration and the Logical Device specification do not have to be in the same project.

To add new logical device configurations to a Logical Device specification:

1. Open a Logical Device Specification entity in the Logical Device Specification editor.
See "Creating New Specifications" for more information.

2. Click the Logical Device Configurations tab.

3. Click Add.
The Logical Device Configuration Specification Wizard appears.

4. In the Project field, select the name of the project to which the new specification should be
added.

5. In the Name field, enter a name for the new specification.
This is the name that will appear in UIM.
6. (Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.
b. Navigate to the directory in which to save the entity.
c. Click OK.

7. Click Finish.

The logical device configuration you added appears in the Logical Device Configurations
tab.

8. From the File menu, select Save.
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Related Topics
Adding Existing Configurations to a Logical Device Specification
Adding Configuration Items

Logical Device Configuration Specification Editor

Logical Device Configuration Specification Editor

Use the Logical Device Configuration Specification editor to model Logical Device
configurations.

When working with the Logical Device Configuration Specification editor, see the following
topics:

e Configuration Specification Editor Details Tab

e Configuration Specification Editor Layouts Tab

e Configuration Specification Editor Rules Tab

« Logical Device Configuration Specification Editor Logical Device Specs Tab

e Specification Editor Tags Tab

Logical Device Configuration Specification Editor Logical Device Specs Tab

Use the Logical Device Specs tab to select, add, and remove the Logical Device
specifications that use the Logical Device Configuration specifications. This tab identifies the
Logical Device specifications that use the selected Logical Device Configuration specification.
You must use this tab to relate a Logical Device specification to its Logical Device
Configuration specification only when the Logical Device specification and Logical Device
Configuration specification need to be in separate cartridges and the Logical Device
specification can exist without the Logical Device Configuration specification. If both the
Logical Device specification and Logical Device Configuration specification are in the same
cartridge, make the association on the Logical Device specification.

Field Use

Logical Device Configuration Displays the name of the Logical Device
specification.

Cartridge Displays the name of the cartridge project into
which the Logical Device specification is built.

Select Click to select an existing Logical Device
specification.

Open Click to open the selected specification in the
Logical Device Specification editor.

Remove Click to remove a Logical Device specification.

Add Click to add a new Logical Device specification.

Related Topics
Adding Existing Configurations to a Logical Device Specification

Adding Configuration Items
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Logical Device Configuration Specification Editor

Adding Existing Configurations to a Logical Device Specification

You can add existing configurations to a Logical Device specification. The Logical Device
configuration and the Logical Device specification do not have to be in the same project.

To add an existing Logical Device Configuration to a Logical Device specification:

1. Open a Logical Device Specification entity in the Logical Device Specification editor.
See "Creating New Specifications" for more information.

2. Click the Logical Device Configurations tab.

3. Click Select.
The Add Entities dialog box appears.

4. Select the configuration and click OK.

The logical device configuration you selected appears in the Logical Device
Configurations tab.

5. From the File menu, select Save.

Related Topics

Adding Existing Configurations to a Logical Device Specification
Adding Configuration Items

Logical Device Configuration Specification Editor

Working with Device Interface Specifications

Logical devices often provide device interfaces. A device interface represents an access point
into the device. These device interfaces may be for connectivity, power, timing, or any other
means of interaction with the device.

You use Logical Device and Device Interface specifications to define the various types of
logical devices and interfaces in your inventory.

You create Device Interface specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.

You relate Logical Device specifications to Device Interface specifications on the Related
Specifications tab in the Logical Device Specification editor.

When working with Device Interface specifications, see the following topics:

About Rate Codes

» Device Interface Specification Editor

About Rate Codes

ORACLE

A rate code is an industry-recognized form of identification for transmission signals, or the
speed at which data flows from one point to another, through some type of logical or physical
medium. For example, a DS1 rate code refers to a transmission rate of 1.544 megabits per
second (Mb/s) for T-Carrier technology.
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You can associate a device interface specification with a rate code; the rate code will be
applied to all new device interfaces created from the specification. The rate code on a device
interface determines the technology and transmission rate the interface can support to
terminate connectivity.

There are two types of validations associated with rate codes. First, Design Studio creates a
problem marker if you attempt to associate a device interface specification with an
incompatible rate code when parent-child relationships between the device interface
specifications are defined.

The bit rate defined for a rate code associated with a child-level device interface cannot
exceed a bit rate of the rate code defined at the parent level. For example, you cannot define a
parent entity with a DS1 rate code (1.544 Mb/s) and define the child entity with a DS3 rate
code (44.736 Mb/s) because the rate code associated with the child device interface has a bit
rate that is higher than the bit rate for the rate code associated with the parent.

Additionally, Design Studio ensures that the sum of the bit rates defined for all child entities
does not exceed the bit rate of the parent. For example, you cannot define a parent entity with
a DS3 rate code (44.736 Mb/s) and define more than 28 child entities with DS1 rate codes
(1.544 Mb/s), as the product of 29 and 1.544 exceeds 44.736, the M/bs defined for DS3.

Second, if you change the rate code associated with a device interface specification in a
previously deployed cartridge in which device interface instances have been created in UIM,
UIM generates a deployment error upon subsequent deployments if:

* You changed the rate code from an existing value to a different value. For example, you
cannot change the rate code value from DS3 to DS1.

* You deleted an existing value and left the Rate Code field blank. For example, you cannot
delete the DS3 value and leave the Rate Code field blank.

The error message appears in the Environment perspective Console view.

Related Topics

Device Interface Specification Editor Properties Tab

Device Interface Specification Editor

ORACLE

Use the Device Interface Specification editor to model Device Interface specifications.
When working with the Device Interface Specification editor, see the following topics:
e Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab

« Device Interface Specification Editor Properties Tab

e Specification Editor Related Specifications Tab

e Specification Editor Configuration Spec Usage Tab

e Specification Editor Rules Tab

e Specification Editor Layouts Tab

e Specification Editor Media Tab

e Specification Editor Extends Tab

e Specification Editor Tags Tab
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Device Interface Specification Editor Properties Tab

Use the Device Interface Specification editor Properties tab to associate a rate code to the

device interface.

# Note:

You must import the ora_uim_basetechnologies base cartridge and add the
ora_uim_basetechnologies base cartridge as a dependency to your cartridge project
to have access to the delivered set of rate codes.

Field

Use

Display Name

Enter the name that appears in Design Studio editors
and in UIM.

Design Studio supports multiple languages for this
field. The field adjacent to Display Name displays
your list of languages. You can define a display name
for any language you select from the list.

If your preferences are set up to work in one
language only, the system displays only the [default]
option. See “Defining Language Preferences" for
more information.

Rate Code

Displays the rate code of the device interface. Click
Select to access a set of available rate codes.

If this field is populated, you can click the Rate Code
link to review the attributes of the rate code.

Clear

Click to remove the selection in the Rate Code field.

Select

Click to select a rate code to associate with the
device interface specification. Rate codes are
available only if you have imported the
ora_uim_basetechnologies base cartridge and added
the ora_uim_basetechnologies base cartridge as a
dependency to the project in which the device
interface specification is saved.

Related Topics

About Rate Codes

Device Interface Specification Editor Related Specifications Tab

ORACLE

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or

behavior based on those relationships.

Section

Use

Device Interfaces

Lists the specifications of device interfaces that can
be sub-device interfaces of device interfaces based
on this specification.
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Section

Use

Roles

Lists roles to which entities based on this Device
Interface specification can be assigned.

Logical Devices

Lists specifications of logical devices that can
provide device interfaces based on this
specification.

Network Nodes

Lists specifications of network nodes that can
represent device interfaces based on this
specification.

Others

Lists specifications of entities that have a
customized relationship with entities based on this
specification.

Related Topics

Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Flow Interface Specifications

Flow interfaces partition media interfaces (device interfaces at the top of their hierarchies) into
virtual channels based on bit rate. Flow interfaces are used with flow identifiers (such as VLAN
IDs) to trace the path of services through the device interfaces and connectivities in multipoint

and point-to-point service arrangements.

Flow interfaces terminate packet connectivity only. They specify the termination type of the
connectivities terminated on their parent device interfaces. There are four termination types

defined by Flow Interface specifications:

* Access. Indicates that the purpose of an interface is to terminate connectivity that provides
access to a service provider network, such as Ethernet UNI connectivity.

* Internetwork. Indicates that the purpose of an interface is to terminate connectivity that
interconnects two service provider networks, such as Ethernet E-NNI connectivity.

* Trunk. Indicates that the purpose of an interface is to terminate connectivity that connects
equipment and devices in the same network, such as Ethernet I-NNI connectivity.

* Unknown. Indicates that the purpose of the interface is unknown. Used to support
scenarios not covered by the Access, Internetwork, and Trunk termination types.

Flow interfaces are similar to sub-device interfaces, but have configurations that capture their

attributes.

When working with Flow Interface specifications, see the following topics:

*  Flow Interface Specification Editor

e Working with Flow Interface Configuration Specifications

Flow Interface Specification Editor

Use the Flow Interface Specification editor to model flow interfaces. When working with the
Flow Interface Specification editor, see the following topics:

e Specification Editor Characteristics Tab

ORACLE
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»  Specification Editor Specification Properties Tab

*  Flow Interface Specification Editor Flow Interface Configuration Tab
«  Specification Editor Configuration Spec Usage Tab

* Flow Interface Specification Editor Properties Tab

e Specification Editor Rules Tab

e Specification Editor Layouts Tab

»  Specification Editor Media Tab

e Specification Editor Extends Tab

e Specification Editor Tags Tab

Flow Interface Specification Editor Flow Interface Configuration Tab

Use the Flow Interface Configurations tab to enter information about the Flow Interface
Configuration specification. Only one Flow Interface Configuration specification can be
associated to a Flow Interface specification.

Field Use

Flow Interface Configuration Displays the name of the Flow Interface
Configuration specification.

Cartridge Displays the name of the cartridge project into
which the Flow Interface Configuration
specification is built.

Select Click to select an existing Flow Interface
Configuration specification.

Open Click to open the selected configuration in the Flow
Interface Configuration Specification editor.

Remove Click to remove the Flow Interface Configuration
specification.

Add Click to add a new Flow Interface Configuration
specification.

Related Topics

Flow Interface Specification Editor

Flow Interface Specification Editor Properties Tab

Use the Properties tab to enter information about the Flow Interface specification.

Field Use
Display Name Enter the specification name as it should be
displayed.
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Field Use
Technology Select the technology. Only packet technologies
are valid. Available by default are:
*  Ethernet
c ATM
*  Frame Relay
« MPLS

These technologies are supplied in the
ora_uim_basetechnologies cartridge. You can edit
the specifications but you cannot create new ones.

Termination Type Select the termination type:
* Access
*  Trunk

* Internetwork

* Unknown

The Termination Type and Termination Packet
Rider values interact. If you select a Termination
Type value, Termination Packet Rider check box
is deselected. If you select the Termination

Packet Rider check box, the Termination Type list

becomes unavailable.

Related Topics
Flow Interface Specification Editor

Technology Editor

Working with Flow Interface Configuration Specifications

Flow interface configurations can include references to flow identifiers (such as VLAN IDs) that
trace the path of services through the device interfaces and connectivities in multipoint and
point-to-point service arrangements.

A Flow interface configuration is created automatically when you create a flow interface. As
with other entities and entity configurations, you specify the Flow Interface Configuration
specification in the Flow Interface specification. Unlike other entities, however, Flow Interface
specifications can be associated with only one configuration specification.

When working with Flow Interface Configuration specifications, see the following topics:

*  Working with Configurations

* Flow Interface Configuration Specification Editor

Flow Interface Configuration Specification Editor

ORACLE

Use the Flow Interface Configuration Specification editor to model flow interface configurations.

When working with the Flow Interface Configuration Specification editor, see the following
topics:

e Configuration Specification Editor Details Tab

e Configuration Specification Editor Layouts Tab

9-11



Chapter 9
Working with Logical Device Account Specifications

«  Configuration Specification Editor Rules Tab
*  Flow Interface Configuration Specification Editor Flow Interface Specs Tab

e Specification Editor Tags Tab

Flow Interface Configuration Specification Editor Flow Interface Specs Tab

Use the Flow Interface Specs tab to select, add, and remove the Flow Interface specifications
that use this Flow Interface Configuration specification. A Flow Interface specification can be
associated with only one Flow Interface Configuration specification, but a Flow Interface
Configuration specification can be associated with multiple Flow Interface specifications.

You must use this tab to relate a Flow Interface specification to its Flow Interface Configuration
specification only when the Flow Interface specification and Flow Interface Configuration
specification are in separate cartridges and the Flow Interface specification can exist without
the Flow Interface Configuration specification.

If both the Flow Interface specification and Flow Interface Configuration specification are in the
same cartridge, make the association from the Flow Interface specification.

Field Use

Flow Interface Configuration Displays the name of the Flow Interface
specification.

Cartridge Displays the name of the cartridge project into
which the Flow Interface specification is built.

Select Click to select an existing Flow Interface
specification.

Open Click to open the selected specification in the Flow
Interface Specification editor.

Remove Click to remove a Flow Interface specification.

Add Click to add a new Flow Interface specification.

Related Topics
Flow Interface Specification Editor

Adding Configuration Items

Working with Logical Device Account Specifications

ORACLE

Logical device accounts are a special type of network address that are hosted or managed by
a logical device. For a service provider, a logical device account could be a management
account, such as a login name, for configuring a logical device. You use Logical Device
Account specifications to define these accounts in your inventory. The information captured in
a Logical Device Account specification depends on the account that you are modeling. For
example, you might need to add characteristics for subscriber information such as a login
name, mailbox, or accounting record.

You create Logical Device Account specifications in the same manner as you create other
types of specifications. See "Creating New Specifications" for more information.

See "Logical Device Account Specification Editor" for reference information about the tabs you
use to define a Logical Device Account specification.
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Use the Logical Device Account Specification editor to model special types of network address

that are hosted or managed by a logical device.

When working with the Logical Device Account Specification, see the following topics:

Specification Editor Characteristics Tab

Specification Editor Specification Properties Tab

Logical Device Account Specification Editor Logical Device Account Configuration Tab

Specification Editor Related Specifications Tab

Specification Editor Configuration Spec Usage Tab

Specification Editor Rules Tab
Specification Editor Layouts Tab
Specification Editor Media Tab
Specification Editor Extends Tab
Specification Editor Tags Tab

Logical Device Account Specification Editor Logical Device Account Configuration

Tab

ORACLE

Use the Logical Device Account Configurations tab to enter information about the Logical
Device Account Configuration specification.

Field

Use

Logical Device Account Configuration

Displays the name of the Logical Device Account
Configuration specification.

Cartridge Displays the name of the cartridge project into
which the Logical Device Configuration
specification is built.

Select Click to select an existing Logical Device Account
Configuration specification.

Open Click to open the selected configuration in the
Logical Device Account Configuration Specification
editor.

Remove Click to remove the Logical Device Account
Configuration specification.

Add Click to add a new Logical Device Account

Configuration specification.

Related Topics

Logical Device Account Specification Editor
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Working with Logical Device Account Configuration
Specifications

The Logical Device Account Configuration specification captures the details about the
resources used by the logical device account. A Logical Device Account Configuration
specification can include configuration items. Configuration items can have characteristics and
can also consume resources.

You can assign the following types of specifications as specification options to the Logical
Device Account Configuration specification:

e Custom network address
e Custom object
e Telephone number

You can include all reference-enabled specification types as references in logical device
account configuration items.

When working with Logical Device Account Configuration specifications, see the following
topics:

e Adding Existing Configurations to a Logical Device Account Specification
e Adding New Configurations to a Logical Device Account Specification

« Logical Device Account Configuration Specification Editor

Adding Existing Configurations to a Logical Device Account Specification

ORACLE

You can add existing configurations to a Logical Device Account specification. The Logical
Device Account configuration and the Logical Device Account specification do not have to be
in the same project.

To add an existing Logical Device Account Configuration to a Logical Device Account
specification:

1. Open a Logical Device Account Specification entity in the Logical Device Account
Specification editor.

See "Creating New Specifications" for more information.
2. Click the Logical Device Account Configurations tab.
3. Click Select.

The Add Entities dialog box appears.
4. Select the configuration and click OK.

The logical device account configuration you selected appears in the Logical Device
Account Configurations tab.

5. From the File menu, select Save.

Related Topics
Adding New Configurations to a Logical Device Account Specification

Adding Configuration Items
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Logical Device Account Configuration Specification Editor

Adding New Configurations to a Logical Device Account Specification

You can add new configurations to a Logical Device Account specification. The logical device
account configuration and the Logical Device Account specification do not have to be in the
same project.

To add new logical device account configurations to a Logical Device Account specification:

1. Open a Logical Device Account Specification entity in the Logical Device Specification
editor.

See "Creating New Specifications" for more information.
2. Click the Logical Device Account Configurations tab.
3. Click Add.
The Logical Device Account Configuration Specification Wizard appears.

4. In the Project field, select the name of the project to which the new specification should be
added.

5. In the Name field, enter a name for the new specification.
This is the name that will appear in UIM.
6. (Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.
b. Navigate to the directory in which to save the entity.
c. Click OK.

7. Click Finish.

The logical device account configuration you added appears in the Logical Device
Account Configurations tab.

8. From the File menu, select Save.

Related Topics

Adding Existing Configurations to a Logical Device Account Specification
Adding Configuration Items

Logical Device Account Configuration Specification Editor

Logical Device Account Configuration Specification Editor

ORACLE

Use the Logical Device Account Configuration Specification editor to model Logical Device
Account configurations.

When working with the Logical Device Account Configuration Specification editor, see the
following topics:

e Configuration Specification Editor Details Tab

»  Configuration Specification Editor Layouts Tab
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«  Configuration Specification Editor Rules Tab

* Logical Device Account Configuration Specification Editor Logical Device Account Specs
Tab

»  Specification Editor Tags Tab

Logical Device Account Configuration Specification Editor Logical Device Account

Specs Tab

Use the Logical Device Account Specs tab to select, add, and remove the Logical Device
Account specifications that use the Logical Device Account Configuration specifications. This
tab identifies the Logical Device Account specifications that use the selected Logical Device
Account Configuration specification. You must use this tab to relate a Logical Device Account
specification to its Logical Device Account Configuration specification only when the Logical
Device Account specification and Logical Device Account Configuration specification need to
be in separate cartridges and the Logical Device Account specification can exist without the
Logical Device Account Configuration specification. If both the Logical Device Account
specification and Logical Device Account Configuration specification are in the same cartridge,
make the association on the Logical Device Account specification.

Field Use

Logical Device Account Configuration Displays the name of the Logical Device Account
specification.

Cartridge Displays the name of the cartridge project into
which the Logical Device Account specification is
built.

Select Click to select an existing Logical Device Account
specification.

Open Click to open the selected specification in the
Logical Device Account Specification editor.

Remove Click to remove a Logical Device Account
specification.

Add Click to add a new Logical Device Account
specification.

Related Topics
Adding Existing Configurations to a Logical Device Specification
Adding Configuration Items

Logical Device Configuration Specification Editor

Working with Physical Device Specifications

ORACLE

A physical device is a collection of hardware resources that have a common function in the
network. Physical devices are the counterpart of logical devices. They are aggregations of
hardware, which can include other physical devices, equipment, physical ports, and physical
connectors. In UIM, you can map a physical device to its corresponding logical device. You can
also map the ports and connectors in a physical device to the device interfaces in a logical
device.

You create Physical Device specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.
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When working with physical devices, see the following topics:

e About Physical Device Specification Ports and Connectors

e Physical Device Specification Editor

About Physical Device Specification Ports and Connectors

In Design Studio, you can include Physical Port and Physical Connector specifications in the
Related Specifications tab of a Physical Device specification. When you create the physical
device in UIM, instances of the ports and connectors are created automatically. The minimum
guantity that you set governs the number of ports and connectors that are automatically added.
The maximum quantity limits the number of ports and connectors that can be added. The
minimum and maximum values are typically the same for ports or connectors of a physical
device. See "Defining Specification Relationships" for instructions about adding related
specifications.

# Note:

When you include a physical port or physical connector in a Physical Device
specification, you should set the minimum and maximum quantities to the same
value. Ports and connectors are fixed parts of a physical device.

Related Topics
Working with Logical Device Specifications
Working with Device Interface Specifications

Physical Device Specification Editor

Physical Device Specification Editor

ORACLE

Use the Physical Device Specification editor to model collections of hardware resources that
have a common function in the network.

When working with the Physical Device Specification editor, see the following topics:

»  Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab

* Physical Device Specification Editor Related Specifications Tab
«  Specification Editor Configuration Spec Usage Tab

e Specification Editor Rules Tab

»  Specification Editor Layouts Tab

e Specification Editor Media Tab

»  Specification Editor Extends Tab

«  Specification Editor Tags Tab
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Physical Device Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or
behavior based on those relationships.

Section Use

Inventory Groups Lists the specifications of inventory groups to
which physical devices based on this specification
can belong.

Roles Lists roles to which entities based on this Physical
Device specification can be assigned.

Physical Connectors Lists specifications of physical connectors that can
be provided by physical devices based on this
specification.

Network Nodes Lists specifications of network nodes that can
represent physical devices based on this
specification.

Physical Ports Lists specifications of physical ports that can be
provided by physical devices based on this
specification.

Others Lists specifications of entities that have a
customized relationship with entities based on this

specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Equipment Specifications

ORACLE

Equipment specifications represent physical items of hardware. Modules and cards that
occupy equipment holders are examples of equipment. But Equipment specifications can also
model more complex devices such as shelves or racks. You can also use Equipment
specifications for self-contained, independent devices such as routers or desk-top modules.
You define the composition of the Equipment specification in the following ways:

* Inthe Visualization tab of the Equipment Specification editor.

* By relating physical ports, connectors, or equipment holder specifications to the Equipment
specification.

When working with Equipment specifications, see the following topics:

e About Equipment Specification Ports, Connectors, and Equipment Holders
e Defining Equipment Specification Properties

e Configuring Equipment Specifications in the Visualization Tab

e Defining Visualization Tab Iltem Elements

e Equipment Specification Editor
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About Equipment Specification Ports, Connectors, and Equipment Holders

You can configure an Equipment specification so that instances of the specification
automatically include physical ports, physical connectors, and equipment holders. If you
include Physical Port, Physical Connector, or Equipment Holder specifications in the Related
Specifications tab of an Equipment specification, instances of the ports, connectors, or
holders are created automatically when you create instances of the equipment.

See "Defining Specification Relationships" for instructions about adding related specifications.

# Note:

When you include a physical port or physical connector in an Equipment
specification, you should set the minimum and maximum quantities to the same
value. Ports and connectors are fixed parts of equipment.

Defining Equipment Specification Properties

ORACLE

When you define Equipment specifications, you can specify its properties, including its
equipment category.

To define Equipment specification properties:

1. Create a new Equipment specification or navigate to the editor of an existing one.
See "Creating New Specifications" for more information.

2. Inthe Equipment Specification editor, click the Properties tab.

3. (Optional) In Equipment Category, select CARD, SHELF, or RACK.

The Visualization tab is empty for Equipment specifications that have not been assigned
to a category. For example, if you are configuring a chassis, you can define its
arrangement of slots and cards.

4. (For the CARD category only) In Required Holders, select the number of holders required
for instances of this specification.

This number defines the number of equipment holders (slots) the card occupies. For
example, if you set the value to 2, the card requires two contiguous slots. This requirement
is enforced in both Design Studio and UIM.

5. (Optional) In the Vendor, Model Number, and Part Number fields, enter appropriate
information.

6. From the File menu, select Save.

Related Topics

Configuring Equipment Specifications in the Visualization Tab

About Equipment Specification Ports, Connectors, and Equipment Holders

Equipment Specification Editor
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Configuring Equipment Specifications in the Visualization Tab

You use the Equipment Specification editor Visualization tab to configure an Equipment
specification that has been assigned to the card, shelf, or rack category. If you configure a rack
to have shelves and cards, the shelves and cards are created automatically when you create
an instance of the rack specification.

When configuring an Equipment specification on the Visualization tab, see the following topics:

e Configuring a Card
e Configuring a Shelf

*  Configuring a Rack

Configuring a Card

A card is an equipment category to which you assign an Equipment specification. When you
configure a card specification, you assign a template that determines the card's orientation.
You can choose a vertical or a horizontal orientation.

# Note:

You must configure a Card specification in the Visualization tab before it can be
added to shelves.

To configure a card specification:

1. Create a new Equipment specification and assign it to the card category, or navigate to the
editor of an existing card specification.

See "Creating New Specifications" for more information.
2. Inthe Equipment Specification editor, click the Visualization tab.

The Visualization tab displays the Default Cards subtab in the Palettes tab.
3. From the Default Cards area, drag a card template to the canvas.

4, Select a card in the canvas, then enter information about it in the information area below
the Palettes area.

You may need to make the Visualization tab larger to see the information area. See
"Defining Visualization Tab Item Elements" for more information.

5. From the File menu, select Save.
Related Topics

Configuring Equipment Specifications in the Visualization Tab

Equipment Specification Editor

Configuring a Shelf

A shelf is an equipment category to which you assign an Equipment specification. You add
cards or empty slots to the shelf. When you add a card, you specify the slot that it should use.
If the card requires more than one slot, the shelf must have the appropriate number of
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contiguous slots available. For example, if the card requires two slots, the shelf must have at
least two contiguous slots available.

You can include card carriers in a shelf. Card carriers are subdivisions of spaces in the shelf
that enable you to add additional cards. Card carriers are not physical items, but rather a way
to divide the shelf in the visualization to accommodate varying numbers of cards. When you
add a card carrier, you specify the number of slots in the slotCount element. When you
configure a shelf specification, you define the shelf arrangement by choosing a template or an
existing shelf.

To configure a shelf:

1. Create a new Equipment specification and assign it to the shelf category, or navigate to the
editor of an existing shelf specification.

See "Creating New Specifications” for more information.
2. In the Equipment Specification editor, click the Visualization tab.
The Visualization tab displays four subtabs in the Palettes tab.
3. Do one of the following:
* From the Default Shelves area, drag a shelf template to the canvas.

* To start from an existing shelf, click the Shelves tab and drag an already configured
shelf to the canvas. The shelf includes any slots or cards defined in its Equipment
specification.

4. (Optional) Drag the card carrier template from the Default Shelves area to the desired
location in the shelf template.

The card carrier template is the template that is not surrounded by a heavy black line.

5. (Optional) Click the Empty Slots tab and drag an item to the desired location in the shelf
template or card carrier within the shelf template.

6. (Optional) Add cards to the shelf configuration.
To add a card:

a. Click the Cards tab and drag an item to the desired location in the shelf template or
card carrier within the shelf template.

The Select Slot Specification dialog box appears.
b. Select a slot specification and click OK.

The card appears in the visualization. If the card requires more than one slot, the card
graphic is shown in one slot. The other required slots are shaded and marked as
occupied.

7. Enter information about items in the shelf in the information area below the Palettes area.

You may need to make the Visualization tab larger to see the information area. See
"Defining Visualization Tab Iltem Elements” for more information.

8. (Optional) Right-click a slot or card in the canvas area and select Remove Item to remove
slots or cards.

9. From the File menu, select Save.

Related Topics
Configuring Equipment Specifications in the Visualization Tab

Equipment Specification Editor
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Configuring a Rack

A rack is an equipment category to which you assign an Equipment specification. A rack
includes one or more shelves. You can include any of the shelves that have already been
defined in the workspace.

To configure a rack:

1. Create a new Equipment specification and assign it to the Rack category, or navigate to
the editor of an existing rack specification.

See "Creating New Specifications" for more information.
2. In the Equipment Specification editor, click the Visualization tab.

The Visualization tab displays the Shelves subtab in the Palettes tab.
3. From the Shelves tab, drag one of the available shelves to the canvas.
4. (Optional) Add additional shelves, as needed.

5. Enter information about items in the shelves in the information area below the Palettes
area.

You may need to make the Visualization tab larger to see the information area. See
"Defining Visualization Tab Item Elements" for more information.

6. From the File menu, select Save.

Related Topics
Configuring Equipment Specifications in the Visualization Tab

Equipment Specification Editor

Defining Visualization Tab Item Elements

ORACLE

You can define information about shelves, empty slots, cards, and card carriers in the
Equipment Specification editor Visualization tab. The information is in the form of name-value
element pairs.

To enter elements for items in the Visualization tab:

1. Open an Equipment specification in the Equipment Specification editor.
2. Click the Visualization tab.
3. Inthe canvas, click a card, card carrier, or empty slot to select it.

To select a shelf, click its perimeter. The selected item is highlighted in the canvas and
information about it appears in the information area.

4. Enter or select values for the relevant elements.

The elements you can specify depend on the item selected in the canvas. See the
following topics for information about the slotNumber and nativeEMSName elements:

*  Numbering Slots Automatically
*  Numbering Slots Individually
e Assigning Native EMS Names Automatically to Slots

e Assigning Native EMS Names Individually to Slots
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5. From the File menu, select Save.

Related Topics
Working with Equipment Specifications

Equipment Specification Editor

Numbering Slots Automatically

You can automatically number all occupied slots. When you automatically number slots,
Design Studio assigns integers beginning with 1, overwriting existing slot numbers.

To number slots automatically:

1. Open an Equipment specification in the Equipment Specification editor.
2. Click the Visualization tab.

3. Inthe canvas area, click an occupied slot.

The selected slot is highlighted in the canvas, and information about it appears in the
information area.

4. Inthe canvas, click the Auto Numbering icon in the toolbar.
Design Studio numbers all the occupied slots, beginning with 1.
5. Click OK in the confirmation dialog box.

6. From the File menu, select Save.

Related Topics
Defining Visualization Tab Item Elements

Equipment Specification Editor

Numbering Slots Individually

ORACLE

You can specify slot numbers individually and assign any alphanumeric value.
To number slots individually:

1. Open an Equipment specification in the Equipment Specification editor.

2. Click the Visualization tab.

3. Inthe canvas area, click an occupied slot.

The selected slot is highlighted in the canvas, and information about it appears in the
information area.

4. In the information area, enter a value for the selected slot in the slotNumber field.
5. From the File menu, select Save.

Related Topics

Defining Visualization Tab Item Elements

Equipment Specification Editor
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Assigning Native EMS Names Individually to Slots

You can assign alphanumeric names to slots by using the nativeEMSName data element. You
can use this element as a network-facing slot name that is independent of the slot number.

To assign names individually:

1. Open an Equipment specification in the Equipment Specification editor.
2. Click the Visualization tab.

3. Inthe canvas area, click an occupied slot.

The selected slot is highlighted in the canvas, and information about it appears in the
information area.

4. In the information area, enter a value for the selected slot in the nativeEMSName field.
5. From the File menu, select Save.

Related Topics

Defining Visualization Tab Item Elements

Equipment Specification Editor

Assigning Native EMS Names Automatically to Slots

ORACLE

You can assign alphanumeric names to slots by using the nativeEMSName element. You can
use this element as a network-facing slot name that is independent of the slot number.

You can assign names automatically to all occupied slots, beginning with a value that you
select. If the starting value ends with an alphabetic character, the names increment by
appending an integer to the value, beginning with 0. If the value ends with an integer, the
names increment starting at that number.

To assign names automatically:

1. Open an Equipment specification in the Equipment Specification editor.
2. Click the Visualization tab.

3. Inthe canvas area, click an occupied slot.

The selected slot is highlighted in the canvas, and information about it appears in the
information area.

4. Inthe canvas, click the Native EMS Naming button in the toolbar.
The Enter NativeEMSName dialog box appears.

5. Enter a starting value and click OK.

6. From the File menu, select Save.

Related Topics

Defining Visualization Tab Item Elements

Equipment Specification Editor
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Equipment Specification Editor

Use the Equipment Specification editor to model physical items of hardware.

When working with the Equipment Specification editor, see the following topics:

Specification Editor Characteristics Tab
Specification Editor Specification Properties Tab
Equipment Specification Editor Properties Tab
Equipment Specification Editor Visualization Tab
Equipment Specification Editor Related Specifications Tab
Specification Editor Configuration Spec Usage Tab
Specification Editor Rules Tab

Specification Editor Layouts Tab

Specification Editor Media Tab

Specification Editor Extends Tab

Specification Editor Tags Tab

Equipment Specification Editor Properties Tab

Use the Properties tab to define an Equipment category and enter information about the

equipment.
Field Use
Equipment Category Select a category for the equipment. You can
select CARD, SHELF, or RACK.
Required Holders Select the number of holders required for instances
of this specification. This field is applicable to the
CARD category only.
Vendor Lets you enter the name of the vendor of the
equipment.
Model Number Enter the model number of the equipment.
Part Number Enter the part number of the equipment.

Related Topics

Defining Equipment Specification Properties

Equipment Specification Editor

Equipment Specification Editor Visualization Tab

Use the Visualization tab to configure an Equipment specification that has been assigned to a
Card, Shelf, or Rack category.

ORACLE
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Field

Use

Palettes

Use the templates on this tab to define the basic
structure of the equipment. The Palettes tab
contains subtabs that depend on whether the
Equipment specification is defined as a card, a
rack, or a shelf.

Hierarchy

View Equipment configuration in a tree view. The
tree view reflects the configuration in the canvas,
so it updates as you add new items to the
visualization. When you select an item in the
canvas, the corresponding item in the tree view is
highlighted; when you select an item in the tree
view, the corresponding item in the canvas is
highlighted.

Canvas

Configure the equipment by dragging items from
the Palettes tab.

Default Cards

Displays the default selection of card templates.

This subtab appears if the Equipment specification
is defined as a card.

Default Shelves

Displays the default selection of shelf templates.

This subtab appears if the Equipment specification
is defined as a shelf.

Shelves

Displays a list of the shelves (Equipment
specifications in the Shelf category) that have been
defined in the workspace.

This subtab appears if the Equipment specification
is defined as a shelf.

Cards

Displays a list of the cards (Equipment
specifications in the Card category) that have been
defined in the workspace.

This subtab appears if the Equipment specification
is defined as a shelf.

Empty Slots

Displays a list of the slots (Equipment Holder
specifications) that have been defined in the
workspace.

This subtab appears if the Equipment specification
is defined as a shelf.

Shelves

Displays a list of the shelves (Equipment
specifications in the Shelf category) that have been
defined in the workspace.

This subtab appears if the Equipment specification
is defined as a rack.

Related Topics

Configuring Equipment Specifications in the Visualization Tab

Defining Visualization Tab Item Elements

Equipment Specification Editor
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Equipment Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or

behavior based on those relationships.

Section

Use

Inventory Groups

Lists the specifications of inventory groups to
which equipment based on this specification can
belong.

Roles

Lists roles to which entities based on this
Equipment specification can be assigned.

Physical Connectors

Lists specifications of physical connectors that can
be provided by equipment based on this
specification.

Network Nodes

Lists specifications of network nodes that can
represent equipment based on this specification.

Physical Ports

Lists specifications of physical ports that can be
provided by equipment based on this specification.

Equipment Holders

Lists specifications of equipment holders that can
be provided by equipment based on this
specification.

Others

Lists specifications of entities that have a
customized relationship with entities based on this
specification.

Related Topics

Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Equipment Holder Specifications

An Equipment Holder specification defines a slot into which cards can be installed. Equipment
holders are provided by equipment and can in turn contain other equipment. For example, a
LAN card can be installed in a slot that is installed in a shelf. An equipment holder cannot exist
on its own. It must always be provided by equipment.

ORACLE

You create Equipment Holder specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.

You can configure an Equipment specification so that instances of the specification
automatically include physical ports, physical connectors, and equipment holders. See "About
Equipment Specification Ports, Connectors, and Equipment Holders" for more information.

You can configure Equipment Holder specifications so that slots based on those specifications
can contain only cards based on particular specifications. If you establish a parent-to-child
relationship between an Equipment Holder specification and one or more Card specifications,
UIM limits which cards a slot can contain. See "Defining Specification Relationships" for
information about establishing these relationships.
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See "Equipment Holder Specification Editor" for reference information about the tabs you use
to define an Equipment Holder specification.

Equipment Holder Specification Editor

Use the Equipment Holder Specification editor to model Equipment Holder specifications.
When working with the Equipment Holder Specification editor, see the following topics:

*  Specification Editor Characteristics Tab

*  Specification Editor Specification Properties Tab

*  Specification Editor Related Specifications Tab

*  Specification Editor Configuration Spec Usage Tab
e Specification Editor Rules Tab

*  Specification Editor Layouts Tab

*  Specification Editor Media Tab

*  Specification Editor Extends Tab

*  Specification Editor Tags Tab

Working with Physical Port Specifications

A Physical Port specification defines a point of entry for communication. A physical port is
where communication begins or ends on a physical device or unit of equipment. Unlike a
physical connector, a physical port performs basic processing, such as reading transmission
data. A physical port cannot exist on its own. It must be provided by either a physical device or
an equipment.

You can configure a Physical Device specification or an Equipment specification to create
physical port instances automatically when you create a physical device or equipment
instance. See and "About Physical Device Specification Ports and Connectors" and "About
Equipment Specification Ports, Connectors, and Equipment Holders" for more information.

You create Physical Port specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.

See "Physical Port Specification Editor" for reference information about the tabs you use to
define a Physical Port specification.

Physical Port Specification Editor

ORACLE

Use the Physical Port Specification editor to model points of entry for communication.
When working with the Physical Port Specification editor, see the following topics:

e Specification Editor Characteristics Tab

e Specification Editor Specification Properties Tab

« Physical Port Specification Editor Related Specifications Tab

e Specification Editor Configuration Spec Usage Tab

e Specification Editor Rules Tab

e Specification Editor Layouts Tab
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e Specification Editor Media Tab
e Specification Editor Extends Tab
»  Specification Editor Tags Tab

Physical Port Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or
behavior based on those relationships.

Section Use

Physical Devices Lists the specifications of physical devices that can
provide physical ports based on this specification.

Roles Lists roles to which entities based on this Physical
Port specification can be assigned.

Equipment Lists specifications of Equipment entities that can
provide physical ports based on this specification.

Others Lists specifications of entities that have a
customized relationship with entities based on this
specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Physical Connector Specifications

You use Physical Connector specifications to model hardware used to physically link or
connect hardware units for the transmission of signals or power. Unlike physical ports, physical
connectors have no built-in intelligence and they simply conduct a signal.

You can configure a Physical Device specification or an Equipment specification to create
physical connector instances automatically when you create a physical device or equipment
instance. A physical connector cannot exist on its own. It must be provided by either a physical
device or equipment. See "About Physical Device Specification Ports and Connectors" and
"About Equipment Specification Ports, Connectors, and Equipment Holders" for more
information.

You create Physical Connector specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.

See "Physical Connector Specification Editor" for reference information about the tabs you use
to define a Physical Connector specification.

Physical Connector Specification Editor

ORACLE

Use the Physical Connector Specification editor to model hardware used to physically link or
connect hardware units for the transmission of signals or power.

When working with the Physical Connector Specification editor, see the following topics:
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Specification Editor Characteristics Tab
Specification Editor Specification Properties Tab
Specification Editor Related Specifications Tab
Specification Editor Configuration Spec Usage Tab
Specification Editor Rules Tab

Specification Editor Layouts Tab

Specification Editor Media Tab

Specification Editor Extends Tab

Specification Editor Tags Tab

Chapter 9
Working with Physical Connector Specifications
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Working with Network Specifications

In Oracle Communications Unified Inventory Management (UIM), a network represents a
collection of other related entities, such as equipment, logical devices, and other networks.

You define Network specifications to model various types of networks based on topology and
technology. In addition to the Network specification itself, you can define two related types of
specifications:

* Network Node specifications define specific nodes in the network. In UIM, you can
associate network nodes with other entities, such as logical devices, device interfaces, flow
interfaces, equipment, places, and parties.

* Network Edge specifications define connections between nodes in the network. In UIM,
you can associate network edges with Connectivity entities and Pipe entities that represent
connections between entities represented as nodes.

When working with Network specifications, see the following topics:
*  Working with Network Specifications

*  Working with Network Configuration Specifications

*  Working with Network Node Specifications

*  Working with Network Edge Specifications

*  Working with Diagram Specifications

Working with Network Specifications

You use a Network specification to define a network as a whole. There are many different
types of networks that you can model with Network specifications:

e ATM network
e Ethernet VLAN
e Frame Relay network

You can add characteristics to capture information that is specific to the type of network
described by the specification.

In UIM, you create an instance of a network from a network specification, then you build a
topological view of the network, its nodes, and its edges. You build the network by adding
nodes and edges and then associating resources to them.

You create Network specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.

See "Network Specification Editor" for reference information about the tabs you use to define a
Network specification.
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Defining the Network Type and Technology

When you create a Network specification, you must select a network type and a technology.
The network type is not displayed in Network entities in UIM, but is used to configure the
network.

ORACLE

There are three types of network, defined by selecting a value for the Entity Type data
element:

Use the Network type for physical and logical transport networks, such as SDH, Frame
Relay, MetroE, or MPLS.

Use the Service Network type for networks that provide a unified view of a service that
delivers packet connectivity. Service networks include service locations, network access
connectivity, and supporting virtual networks. Network specifications of this type require
that you associate a Network Configuration specification.

Use the Packet Virtual Network (PVN) type for virtual networks, such as Ethernet Virtual
Circuits (EVCs), that support packet-based services. A PVN can include flow interfaces,
packet network connectivity, and cross connects. Network specifications of this type
require a Network Configuration specification.

The network type and the network technology (defined by selecting a value for the Technology
data element) are interdependent:

The Undefined technology is available for Network and Service Network types.

Packet technologies, such as ATM, Frame Relay, MPLS and Ethernet, are available for
Packet Virtual Network and Service Network types.

All other technologies are available for the Network type.

To define the network type and technology:

1.

6.

Open a Network Specification entity in the Network Specification editor.

See "Creating New Specifications" for information about creating new Network
specifications.

Click the Network Properties tab.
In the Entity Type field, select a network type.
In the Technology field, click Select.

The Select Technology dialog box appears. Only the technologies applicable to the Entity
Type value are included.

Select a technology and click OK.
The Technology field is updated.

From the File menu, select Save.

Related Topics

Network Specifications Editor Network Properties Tab

Adding Configuration Items

Network Specification Editor
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Network Specification Editor

Use the Network Specification editor to model Network specifications.
When working with the Network Specification editor, see the following topics:

*  Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab

* Network Specifications Editor Network Properties Tab
* Network Specifications Editor Network Configurations Tab
e Specification Editor Related Specifications Tab

*  Specification Editor Configuration Spec Usage Tab

e Specification Editor Rules Tab

*  Specification Editor Layouts Tab

*  Specification Editor Media Tab

*  Specification Editor Extends Tab

*  Specification Editor Tags Tab

Network Specifications Editor Network Properties Tab

ORACLE

Use the Network Properties tab to enter network properties.

Field Use

Technology Select the technology for this Network
specification. The Technology and Entity Type
data elements are dependent on each other.

*  The Undefined technology is available for
Network and Service Network types.

*  Packet technologies, such as ATM, Frame
Relay, MPLS and Ethernet, are available for
Packet Virtual Network and Service
Network types.

»  All other technologies are available for the
Network type.

The technology is set to Undefined by default.

Entity Type Select the entity type for this Network specification.
The Technology and Entity Type data elements
are dependent on each other.

*  The Service Network types can use the
Undefined technology and packet
technologies, such as ATM, Frame Relay,
MPLS and Ethernet.

*  The Packet Virtual Network type can use
packet technologies, such as ATM, Frame
Relay, MPLS and Ethernet.

*  The Network type can use the Undefined
technology as well as all other non-packet
technologies.

The entity type is set to Network by default.
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Related Topics

Defining the Network Type and Technology

Network Specifications Editor Network Configurations Tab

Use the Network Configurations tab to select, add, and remove a network configuration.

Field Use

Network Configuration Displays the name of the Network Configuration
specification.

Cartridge Displays the name of the cartridge project into
which the Network Configuration specification is
built.

Select Click to select an existing Network Configuration.

Open Click to open the selected configuration in the
Network Configuration Specification editor.

Remove Click to remove a Network Configuration.

Add Click to add a new Network Configuration. See

"Adding Existing Configurations to a Network
Specification" for more information.

Related Topics
Network Specification Editor

Working with Network Specifications

Network Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or
behavior based on those relationships.

Section Use

Network Edges Lists specifications of network edges that can be
included in networks based on this specification.

Network Nodes Lists specifications of network nodes that can be
included in networks based on this specification.

Roles Lists roles to which entities based on this Network
specification can be assigned.

Others Lists specifications of entities that have a
customized relationship with entities based on this
specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab
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Working with Network Configuration Specifications

Network Configuration specifications capture the details about the resources used by the
network. As these details can change frequently, network configurations provide a versioning
capability that enables the management of changes to the facts about the network over time.
As the facts about a network change over time, new versions of the network configuration can
be created.

In UIM, packet virtual networks and service networks rely on the versioning capabilities of
network configurations to manage changes. For this reason, a network configuration is created
automatically when you create a Network entity based on a specification with the network type
of Packet Virtual Network or Service Network. To support this behavior, you must associate
one Network Configuration specification with each Service Network and Packet Virtual Network
specification you create.

You can associate Custom Network Address, Custom Object, and Logical Device
specifications to the Network Configuration specification.

When working with Network Configuration specifications, see the following topics:

e Adding Existing Configurations to a Network Specification
e Adding New Configurations to a Network Specification

«  Network Configuration Specification Editor

Adding Existing Configurations to a Network Specification

ORACLE

You can add existing network configurations to a Network specification. The network
configuration and the Network specification do not have to be in the same project.

To add an existing network configuration to a Network specification:

1. Open a Network Specification entity in the Network Specification editor.

See "Creating New Specifications" for information about creating new Network
specifications.

2. Click the Network Configurations tab.
3. Click Select.
The Add Entity dialog box appears.
4. Select the network configuration and click OK.

The Network Configuration specification is added to the Network specification's Network
Configurations tab.

5. From the File menu, select Save.

Related Topics

Adding New Configurations to a Network Specification
Adding Configuration Items

Network Configuration Specification Editor
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Adding New Configurations to a Network Specification

You can add new network configurations to a Network specification. The network configuration
and the Network specification do not have to be in the same project.

To add a new network configuration to a Network specification:

1. Open a Network Specification entity in the Network Specification editor.

See "Creating New Specifications" for information about creating new Network
specifications.

2. Click the Network Configurations tab.
3. Click Add.
The Network Configuration Specification Wizard appears.

4. In the Project field, select the name of the project to which the new specification should be
added.

5. In the Name field, enter a name for the new specification.
This is the name that will appear in UIM.
6. (Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.
b. Navigate to the directory in which to save the entity.
c. Click OK.

7. Click Finish.

The Network Configuration specification is added to the Network specification's Network
Configurations tab.

8. From the File menu, select Save.

Related Topics

Adding Existing Configurations to a Network Specification
Adding Configuration Items

Network Configuration Specification Editor

Network Configuration Specification Editor

ORACLE

Use the Network Configuration Specification editor to capture the details about the resources
used by the network.

When working with the Network Configuration Specification editor, see the following topics:

e Configuration Specification Editor Details Tab
»  Configuration Specification Editor Specification Options Subtab
»  Configuration Specification Editor Layouts Tab

«  Configuration Specification Editor Rules Tab
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* Network Configuration Specification Editor Network Specs Tab

e Specification Editor Tags Tab

Network Configuration Specification Editor Network Specs Tab

Use the Network Specs tab to select, add, and remove the Network specifications that use the
Network Configuration specifications. This tab identifies the Network specifications that use the
selected Network Configuration specification. You must use this tab to relate a Network
specification to its Network Configuration specification only when the Network specification and
Network Configuration specification need to be in separate cartridges, and the Network
specification can exist without the Network Configuration specification. If both the Network
specification and Network Configuration specification are in the same cartridge, make the
association on the Network specification.

Field Use

Network Specification Displays the name of the Network specification.

Cartridge Displays the name of the cartridge project into
which the Network specification is built.

Select Click to select an existing Network specification.

Open Click to open the selected specification in the
Network Specification editor.

Remove Click to remove a Network specification.

Add Click to add a new Network specification.

Related Topics
Adding Existing Configurations to a Network Specification
Adding New Configurations to a Network Specification

Network Configuration Specification Editor

Working with Network Node Specifications

You use Network Node specifications to define nodes for the various Network specifications in
your inventory. When you add a network node to a network, you can associate a resource to a
node. In UIM, nodes and the resources that they represent are modeled separately. This
strategy gives you the flexibility required to keep your inventory up to date as equipment
changes. A network can consist of nodes that represent a variety of different entities, or no
entity at all.

You create Network Node specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.

When working with Network Node specifications, see the following topics:

e About Network Node Entity Type Limitations

* Network Node Specification Editor

About Network Node Entity Type Limitations

You can limit the kinds of entities that a network node can represent. UIM uses the list of
specifications with which a Network Node specification has relationships to restrict the entity
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types to which a node instance can be associated. If a relationship exists between a Network
Node specification and a specification of any of the entity types a network node can represent,
UIM allows the network node instance to be associated only with instances of the related
specifications.

If a Network Node specification does not include any relationships to the entity types a network
node can represent, then UIM allows node instances to be associated with any of the allowable
entity types. See "Defining Specification Relationships" for more information about
relationships.

Related Topics

Working with Network Node Specifications

Network Node Specification Editor

Use the Network Node Specification editor to define nodes for the various Network
specifications in your inventory.

When working with the Network Node Specification editor, see the following topics:

e Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab

* Network Node Specification Editor Related Specifications Tab
e Specification Editor Rules Tab

»  Specification Editor Layouts Tab

»  Specification Editor Media Tab

»  Specification Editor Extends Tab

e Specification Editor Tags Tab

Network Node Specification Editor Related Specifications Tab

ORACLE

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or
behavior based on those relationships.

Section Use

Other Supported Entities Lists specifications of entities that network nodes
based on this specification can represent. Network
nodes can represent Custom Network Address,
Custom Object, Device Interface, Equipment,
Logical Device, Network, Physical Device, and
Physical Port entities.

Roles Lists roles to which entities based on this Network
Node specification can be assigned.

Others Lists specifications of entities that have a
customized relationship with entities based on this

specification.
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Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Network Edge Specifications

A Network Edge specification describes the behavior and attributes of the edges that connect
nodes in a network. You create different Network Edge specifications for the different kinds of
edges in your inventory.

You can associate a network edge to one or more pipes if the connectivity is known. You can
leave the network edge unassociated if the connectivity is not known, or if the reachability is
through a dynamic route in another network. A network edge can also be associated to one or
more custom object instances that define a type of connectivity not available in the default
model.

You create Network Edge specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.

When working with Network Edge specifications, see the following topics:

e About Network Edge Entity Type Limitations
* Network Edge Specification Editor

About Network Edge Entity Type Limitations

By relating Pipe specifications and Custom Object specifications to a Network Edge
specification, you can restrict the types of pipes and custom objects that can be represented by
a Network Edge specification.

If no relationship exists between the Network Edge specification and pipe or custom object
specification, then UIM does not limit the entity a network edge may represent to any
specification.

Related Topics
Working with Network Edge Specifications

Network Edge Specification Editor

ORACLE

Use Network Edge Specification editor to describe the behavior and attributes of the edges
that connect nodes in a network.

When working with the Network Edge Specification editor, see the following topics:

*  Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab

* Network Edge Specification Editor Related Specifications Tab
e Specification Editor Rules Tab

*  Specification Editor Layouts Tab

*  Specification Editor Media Tab
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Specification Editor Extends Tab
Specification Editor Tags Tab

Network Edge Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or
behavior based on those relationships.

Section Use

Custom Objects Lists specifications of custom objects that network

edges based on this specification can represent.

Networks Lists specifications of networks to which network

nodes based on this specification can belong.

Pipes Lists specifications of pipes that network edges

based on this specification can represent.

Others Lists specifications of entities that have a

customized relationship with entities based on this
specification.

Related Topics

Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Diagram Specifications

Diagram Specifications filter the related specifications, which are displayed in the UIM Diagram
Pallet. You can create a diagram template that helps in displaying all the devices in the
Planning Diagram page in the runtime application.

You can perform the following tasks on the Diagram Specification:

Create a new Diagram Specification. To create a new Diagram Specification, you need to
add the following dependency cartridges:

— ora_uim_model
— ora_uim_basetechnologies
— ora_uim_basetags

Add diagramnetwork tag to the newly created Diagram Specification, which helps to
display the specification in runtime application

Add base project to the specification

Add related specifications to control the specification drop-down list in the runtime
application

Add required rules to the specification

Create Diagram Specification

To create capacity types:

ORACLE
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From the Studio menu, select New, then select Inventory, then select Resources, then
select Diagram Specification.

The Diagram Specification Wizard appears. An icon for the specification type appears in
the upper-right corner.

In the Project field, select the name of the project to which the new diagram specification
should be added.

In the Name field, enter a name for the capacity type.
This is the name that will appear in UIM.
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.

b. Navigate to the directory in which to save the entity.
c. Click OK.

Click Finish.

Design Studio creates the diagram specification and displays the information in Diagram
Specification editor.
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In Oracle Communications Unified Inventory Management, you can represent connectivity in
your network with Connectivity entities. Connectivity entities provide built-in support for a
variety of technologies and can be customized to suit your business needs.

You can create Connectivity specifications for three types of Connectivity entities:

«  Multiplexed Connectivity entities support technologies such as E-Carrier, T-Carrier, J-
Carrier, SDH, and SONET, and WDM.

« Packet Connectivity entities support technologies such as Ethernet, Frame Relay, ATM,
and MPLS.

*  Service Connectivity entities represent the connectivities that delivers services to end
customers. Service connectivity consumes other types of connectivity and resources, but
cannot be consumed itself.

The specifications for the three connectivity types include different default characteristics. In
UIM, you see a different set of tabs in Connectivity Summary pages depending on the
connectivity type.

You can also use Pipe entities to model connectivity. For example, pipes are recommended for
modeling physical connectivity such as ducts and cables. Because pipe entities do not require
end locations and terminations, they can also be useful in situations in which you do not need
to model all the details of a connectivity. See "Working with Pipe and Capacity Specifications"
for more information.

Pipe entities and Connectivity entities are not mutually exclusive: you can include them both in
the same network. For example, pipes can enable channelized connectivity.

When working with Connectivity specifications, see the following topics:

»  Connectivity Specification Editor
*  Working with Connectivity Signal Termination Point Specifications

*  Working with Flow Identifier Specifications

Connectivity Specification Editor

ORACLE

Use the Connectivity Specification editor to model connectivities.
When working with the Connectivity Specification editor, see the following topics:

*  Specification Editor Characteristics Tab

*  Specification Editor Specification Properties Tab

*  Connectivity Specification Editor Connectivity Properties Tab
*  Specification Editor Related Specifications Tab

*  Specification Editor Configuration Spec Usage Tab

e Specification Editor Rules Tab

*  Specification Editor Layouts Tab
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e Specification Editor Tags Tab
»  Specification Editor Extends Tab

Chapter 11
Connectivity Specification Editor

Connectivity Specification Editor Connectivity Properties Tab

Use the Connectivity Properties tab to define the properties of Connectivity specifications.

Field

Use

Connectivity Classification

Select one of the following to set the connectivity
type:

*  Multiplexed

e Packet

e Service

Along with the value for Entity Type, the
Connectivity Classification selection drives UIM
functionality for entities based on this specification.

Entity Type

For Multiplexed and Service connectivity types,
displays the predefined entity type (Channelized
Connectivity or Service Connectivity).

For Packet connectivity, select one of the following
entity types, which determines what role the entity
plays in a packet network:

*  Ethernet UNI Connectivity

*  Ethernet I-NNI Connectivity

*  Ethernet E-NNI Connectivity

*  Packet Network Access Connectivity
(network access connectivity for ATM, Frame
Relay, and other non-Ethernet technologies)

*  Packet Network Connectivity (network
connectivity for ATM, Frame Relay, and other
non-Ethernet technologies)

Along with the value for Connectivity

Classification, the Entity Type selection

determines UIM functionality for entities based on

this specification.

Technology

Displays the technology type or types assigned to
the connectivity. Use the Select or Add button to
create a technology that applies to the connectivity.
The technology you select must be valid for the
connectivity type. For Service Connectivity
specifications, the technology must be set to
Undefined.

Service Connectivity Controlled

For service connectivities only. If enabled,
connectivities based on this specification can be
created only as a part of a service configuration.

Open Click to open the editor for the selected technology.
The editor opens in a new tab.

Add Not used

Remove Click to remove the selected technology.

Select Click to open a dialog box in which you select from

the technologies that are valid for this combination
of connectivity type and entity type.

ORACLE
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Working with Connectivity Signal Termination Point Specifications

Connectivity Signal Termination Point specifications define the multiplexing options for a
channelized transmission facility. Connectivity Signal Termination Point specifications are
related hierarchically to other Connectivity Signal Termination Point specifications (and
Processing Signal specifications, for SONET and SDH).

A number of Connectivity Signal Termination Point specifications are included in the
ora_uim_basetechnologies cartridge. These signals include Synchronous Digital Hierarchy
(SDH), Synchronous Optical Network (SONET), E-Carrier, T-Carrier, and J-Carrier
technologies.

For more information about Connectivity Signal Termination Point specifications, see UIM
Concepts, UIM Cartridge Guide, and UIM Information Model Reference.

When working with Connectivity Signal Termination Point specifications, see the following
topics:

e Connectivity Signal Termination Point Specification Editor
* Rate Code Editor

e Technology Editor

e Connectivity Function Editor

e Processing Signal Specification Editor

Connectivity Signal Termination Point Specification Editor

Use the Connectivity Signal Termination Point Specification editor to review the connectivity
signal structures that UIM uses to determine the multiplexing options for channelizing entities.
These signal structures are read-only.

See UIM Concepts and UIM Information Model Reference for more information about signal
structures.

When working with the Connectivity Signal Termination Point Specification editor, see the
following topics:

e Connectivity Signal Termination Point Specification Editor Properties Tab

*  Connectivity Signal Termination Point Specification Editor Child Signal Relationships Tab

Connectivity Signal Termination Point Specification Editor Properties Tab

Use the Properties tab to review details about a Connectivity Signal Termination Point
specification, including its type and rate code. This information is read-only.
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Field

Use

Display Name

Enter the name that appears in Design Studio
editors and in UIM.

Design Studio supports multiple languages for this
field. The field adjacent to Display Name displays
your list of languages. You can define a display name
for any language you select from the list.

If your preferences are set to use one language only,
the system displays only the [default] option. See
“Defining Language Preferences"” for more
information.

Name

Displays the name of the connectivity signal
specification.

Termination Point Signal Type

Displays the type of the signal. Values are:

*  PACKET: Signal type used in packet
technologies such as Ethernet, ATM, Frame
Relay, and MPLS.

*  SYNCHRONOUS_TRANSPORT_MODULE
(STM): Signal type used in the SDH technology.

*  CONTAINER: Signal type used in the SDH
technology.

*  OPTICAL_CARRIER (OC): Signal type used in
the SONET technology.

*  SYNCHRONOUS_TRANSPORT_SIGNAL
(STS): A signal type used in the SONET
technology.

*  SYNCHRONOUS_PAYLOAD_ENVELOPE
(SPE): A signal type used in the SONET
technology.

*  PDH_SIGNAL: Plesiochronous Digital Hierarchy
(PDH) signal. Applicable to T-Carrier, E-Carrier,
and J-Carrier signals.

Transmission Signal Type

Displays the physical nature of the transmission
signal, such as Optical or Electrical.

Rate Code

Displays the rate code that identifies the technology
and bit rate for the signal.

Valid for Facility

Indicates whether the signal can be mapped to a
connectivity through the associated rate code.

Connectivity Signal Termination Point Specification Editor Child Signal Relationships

Tab

ORACLE

Use the Child Signal Relationships tab to review details about the hierarchical relationships
of a Connectivity Signal Termination Point specification. See UIM Concepts and UIM
Information Model Reference for more information about these relationships.

This tab is relevant only for channelized (non-packet) Connectivity Signal Termination Point

specifications.
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Field Use

Supports Child Signals Lists child signals that can be enabled by the signal
defined by this specification. (The supported signals
are sometimes called riders.) For example, a VT-6
SPE channel signal can support (enable) a T-Carrier
DS2 transmission facility.

Aligns to Child Signals Lists child signals that are not located in a fixed
position within an SDH or SONET frame signal. For
example, in the SONET technology, a VT-1.5
processing signal aligns to a VT-1.5 SPE signal
termination point.

Maps to Child Signals Lists child signals that are mapped to this signal with
the same rate. For example, in the SDH technology,
a VC-2 processing signal maps to a C-2 signal
termination point.

Multiplexes to Child Signals Lists child signals into which this signal can be
multiplexed. For example, in the SDH technology, a
TUG-2 processing signal multiplexes to four TU-11
processing signals.

Rate Code Editor

You use the Rate Code editor to review information about the system-provided rate codes in
Design Studio for Inventory. Rate codes are associated to Connectivity Signal Termination
Point specifications and Processing Signal specifications to define the technology and
transmission bit rate of the signals.

See UIM Concepts, UIM Cartridge Guide, and UIM Information Model Reference for more
information.

Field Use

Name Displays the rate code designation as an acronym or
mnemonic, and which describes a technology-
specific transmission rate for a signal, service,
connectivity, transmission facility, or device interface.
For example, a SONET technology STS-192 signal
that operates at a transmission rate of 9,953.230
Mb/s can be referred to as STS192. A device
interface that supports an STS-192 signal
termination can be described as supporting the
STS192 rate code.

Description Displays additional information about the rate code,
when necessary.

Nominal Bit Rate Displays the transmission bit rate associated with
the rate code.

Unit of Measure Displays the unit of measure of the nominal bit rate.

Connectivity Function Displays the connectivity function associated with
the rate code.
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Field Use

Technology Displays the technologies that the rate code
supports. Examples of communication technologies
include:
*  Ethernet
« SDH

*  Frame Relay
*  T-Carrier
A set of technologies is supplied in the

ora_uim_basetechnologies cartridge.

Related Topics
Connectivity Function Editor
Technology Editor

Device Interface Specification Editor Properties Tab

Technology Editor

Use the Technology editor to review the signal technologies that are applicable to connectivity
and devices. A selection of Technology specifications is included in the
ora_uim_basetechnologies cartridge. You cannot create Technology specifications yourself.

See UIM Concepts, UIM Cartridge Guide, and UIM Information Model Reference for more
information.

Field Use

Name Displays the name of the technology, such as
SONET, SDH, Ethernet, and so on.

Description Describes the associated technology.

A technology provides specific kinds of capabilities
and is bound by specific types of standards,
requirements, behaviors, information, and impact

across the business and the use of the technology.

Related Topics

About Rate Codes

Connectivity Function Editor

ORACLE

Use the Connectivity Function editor to create and view connectivity functions. A connectivity
function represents how a connectivity is used. There are two types of connectivity functions:

e The Facility connectivity function applies to connectivity facilities inventoried by the service
provider. For example, the T1 connectivity function signifies that the connectivity is a T-
Carrier transmission facility operating at a DS1 rate. Facility functions are always
associated with rate codes. Predefined Facility connectivity functions are included in the
ora_uim_basetechnologies cartridge. You cannot create connectivity functions of this type.

e The Service connectivity function applies to service connectivity and is not associated to a
rate code. For example, you can assign the connectivity VPN to a VPN service connectivity
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or VOIP to a VOIP service connectivity. Predefined Service connectivity functions are
included in the ora_uim_basetechnologies cartridge. You can also create connectivity
functions of this type.

The rate codes delivered with Design Studio for Inventory have one associated connectivity
function. You can extend Design Studio for Inventory to include additional connectivity
functions. See UIM Developer's Guide for more information about extending the application.

See UIM Concepts and UIM Information Model Reference for more information.

Field Use

Name Displays the name of the connectivity function.

Description Describes the connectivity function.

Category Displays Service or Facility. When you create a
connectivity function, Service is displayed by default.

Related Topics
About Rate Codes

Processing Signal Specification Editor

Use the Processing Signal Specification editor to review the processing signal specification
information delivered with Design Studio for Inventory.

Processing Signal specifications define processing signals in the signal structure for a SONET
or SDH transmission facility. Processing signals multiplex to, align with, or map to other signals
in a SONET or SDH signal structure, but they are not facility or channel signals, because they

are not directly associated with a channelized connectivity or channel.

Processing signal specifications are provided in the ora_uim_basetechnologies cartridge.
These specifications are associated with Connectivity Signal Termination Point specifications
to form the connectivity signal architecture for the SONET and SDH technologies. For
information about the signal specifications in the ora_uim_basetechnologies cartridge,
including the specification relationships, see UIM Information Model Reference.

When working with the Processing Signal Specification editor, see the following topics:

e Processing Signal Specification Editor Details Tab

e Processing Signal Specification Editor Child Signal Relationships Tab

Processing Signal Specification Editor Details Tab

Use the Details tab to review details about a Processing Signal specification, including its type
and rate code. This information is read-only.

Field Use

Name Displays the name of the processing signal
specification.

Transmission Signal Type Displays the physical nature of the transmission
signal, such as Optical or Electrical.
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Field

Use

Processing Signal Type

Displays the name of the processing signal.
Processing signal types for SDH are:

*  ADMINISTRATIVE_UNIT_GROUP (AUG):
Groups a set of Administrative Unit (AU) signals.

*  ADMINISTRATIVE_UNIT (AU): A pointer with
alignment to a Virtual Container (VC) signal.

¢ TRIBUTARY_UNIT_GROUP (TUG): Groups a
set of Tributary Unit (TU) signals in the STM-1
frame signal.

*  TRIBUTARY_UNIT (TU): A pointer with
alignment to a Virtual Container (VC) signal in
the STM-1 frame signal.

*  VIRTUAL_CONTAINER (VC): Adapts (maps to)
a Container (C) signal.

Processing signal types for SONET are:

*  VIRTUAL_TRIBUTARY_GROUP (VTG): Groups
a set of Virtual Tributary (VT) signals within the
STS-1 frame signal.

*  VIRTUAL_TRIBUTARY (VT): A pointer with
alignment to a Synchronous Payload Envelope
(SPE) signal within the STS-1 frame signal.

*  SYNCHRONOUS_TRANSPORT_SIGNAL
(STS): A pointer with alignment to a
Synchronous Payload Envelope (SPE) signal.

Rate Code

Displays the rate code that identifies the technology
and bit rate for the processing signal.

Processing Signal Specification Editor Child Signal Relationships Tab

ORACLE

Use the Child Signal Relationships tab to review details about the hierarchical relationships
of a Processing Signal specification. See UIM Concepts and UIM Information Model for more

information about these relationships.

Field

Use

Supports Child Signals

Lists child signals that can be enabled by the signal
defined by this specification. (The supported signals
are sometimes called riders.) For example, a VT-6
SPE channel signal can support (enable) a T-Carrier
DS2 transmission facility.

Aligns to Child Signals

Lists child signals that are not located in a fixed
position within an SDH or SONET frame signal. For
example, in the SONET technology, a VT-1.5
processing signal aligns to a VT-1.5 SPE signal
termination point.

Maps to Child Signals

Lists child signals that are mapped into this signal
with the same rate. For example, in the SDH
technology, a VC-2 processing signal maps to a C-2
signal termination point.

Multiplexes to Child Signals

Lists child signals into which this signal can be
multiplexed. For example, in the SDH technology, a
TUG-2 processing signal multiplexes to four TU-11
signals processing signals.
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Working with Flow Identifier Specifications

The various packet connectivity technologies have a variety of ways of identifying network
traffic to make it visible to only the appropriate devices. By isolating network traffic in this way,
the same physical or infrastructure network can support multiple virtual networks. For example,
the Ethernet technology uses VLAN IDs (or tags) for this purpose. Similarly, ATM uses VPI and
VCI; Frame Relay uses DLCI; and MPLS uses VPLS IDs. In UIM, you use flow identifiers to
represent these various types of network addresses.

You can define Flow Identifier specifications to fit your business and technological
requirements. UIM provides a number of Flow Identifier specifications in the Ethernet reference
cartridge.

When working with Flow Identifier specifications, see the following topics:

*  Flow Identifier Specification Editor

Flow Identifier Specification Editor

Use the Flow Identifier Specification editor to model flow identifiers. When working with the
Flow Identifier Specification editor, see the following topics:

e Specification Editor Characteristics Tab

e Specification Editor Specification Properties Tab

« Flow Identifier Specification Editor Properties Tab
e Specification Editor Related Specifications Tab

e Specification Editor Configuration Spec Usage Tab
e Specification Editor Rules Tab

e Specification Editor Layouts Tab

e Specification Editor Extends Tab

e Specification Editor Tags Tab

Flow Identifier Specification Editor Properties Tab

ORACLE

Use the Properties tab to enter information about the Flow Identifier specification.

Field Use

Technology Click Select to select the technology that applies to
the flow identifier. Only packet technologies are
available.
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Field

Use

Provider Managed

Select if this specification represents a provider-
managed flow identifier.

In UIM, provider-managed flow identifiers are
grouped into network address domains and
resource pools from which they can be assigned.
For example, an SP-VLANID is a provider-
managed flow identifier.

Unmanaged flow identifiers are not managed by
service provers. They are typically received on an
order and referenced with a service location on the
service. For example, a CE-VLANID is unmanaged
by the service provider.

A number of Flow Identifier specifications are
provided in the Ethernet reference cartridge.
The identifier value must be unique across all flow

identifiers associated with the same network
address domain.

Stacking Level

Enter a stacking level for flow identifiers based on
this specification. The stacking level is used in UIM
to implement Q-in-Q stacking. Flow identifiers with
lower stacking level values can be stacked within
flow identifiers with higher values.

Q-in-Q stacking enables VLAN IDs to be
encapsulated (stacked) within each other to allow
customer traffic with the same VLAN ID to travel
safely through the same service provider network.

Stacking levels are oriented from the customer site
looking into the service provider network. A CE-
VLANID is level 0 and an SP-VLAIND is level 1.

Stacking levels are used in packet technologies
other than Ethernet. For example, stacking levels
support VPIs (virtual path identifiers) and VCls
(virtual channel identifiers) for ATM and DLCIs
(data link connection identifiers) for Frame Relay.

Identifier Value Type

Select Numeric or Alphanumeric.

Untagged

For Ethernet flow identifiers, select to indicate that
the specification can be used to create untagged
flow identifiers. Untagged flow identifiers allow
untagged frames to pass through an interface.

Note: If this check box is selected, the specification
can be used to create both tagged and untagged
flow identifiers. If the check box is not selected, the
specification can be used to create only tagged
flow identifiers.

Untagged flow identifiers must be named
Untagged and cannot have an identifier. Otherwise,
the identifier is required.

11-10



ORACLE

Chapter 11
Working with Flow Identifier Specifications

Field

Use

Minimum Identifier Value

Flow Identifier specifications include an Identifier
characteristic. UIM users can use this
characteristic to define a numeric tag that identifies
data as it flows through the network.

UIM users can create ranges of flow identifiers.
Enter a minimum value to specify the lower
boundary of ranges.

If you enter a Minimum Identifier Value, you must
also enter a Maximum ldentifier Value.

Maximum ldentifier Value

Flow Identifier specifications include an Identifier
characteristic. UIM users can use this
characteristic to define a numeric tag that identifies
data as it flows through the network.

UIM users can create ranges of flow identifiers.
Enter a maximum value to specify the upper
boundary of ranges.

If you enter a Maximum Identifier Value, you must
also enter a Minimum Identifier Value.
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Pipes are the fundamental entities that underlay the connectivity functionality in UIM. They are
generic and are designed to be as flexible as possible.

# Note:

Most common telecommunications connectivity scenarios can be implemented by
using Connectivity entities, which are extensions of Pipe entities. Connectivity entities
include more advanced functionality than pipes.

You can still implement solutions by using pipes directly, however. For example, pipes are
recommended for modeling physical connectivity such as ducts and cables. Because pipe
entities do not require end locations and terminations, they can also be useful in situations in
which you do not need to model all the details of a connectivity.

If you previously modeled connectivity using pipes, you can continue to use those entities.
Pipes and Connectivity entities can co-exist in the same inventory. Pipes can enable
Connectivity entities and Connectivity entities can enable pipes.

When working with Pipe specifications, see the following topics:
*  Working with Pipe Specifications

*  Working with Pipe Configuration Specifications

*  Working with Pipe Signal Termination Point Specifications

*  Working with Pipe Termination Point Specifications

e Working with Capacity Types

*  Working with Capacity Provided Specifications

*  Working with Capacity Required Specifications

e Working with Measurement Types

e Working with Units of Measure

Working with Pipe Specifications

ORACLE

Pipes are a generalized representation of any kind of connectivity in the inventory. A pipe
enables the transfer of information between two termination points. Both physical connectivity,
such as cables, and logical connectivity, such as traffic flows, can be represented by pipes.

Pipes belong to the following categories:

* Trails: Pipes that are enabled by some other connectivity, such as another trail or a
connection.

* Connections: Stand-alone, point-to-point pipes that can enable trails.
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You use Pipe specifications to define both trails and connections. You use pipe termination
points to define the end points of pipes. Pipe specifications can be used to model layered
connectivity, such as a local loop that is enabled in the network by a series of interconnected
cable pairs and cross-connects. Pipes can also be used to model hierarchical relationships of
pipes. When you create a Pipe Termination Point specification, you can include characteristics
for information you want to collect.

When working with Pipe specifications, see the following topics:

e About Pipe Models

«  Configuring Pipe Specifications

¢ Adding Pipe Termination Point Specifications to a Pipe Specification

¢ Pipe Specification Editor

About Pipe Models

UIM supports three different pipe models. The models are defined by how a pipe provides
other pipes and by the way the capacity is structured. Path analysis and other processes are
designed to support these models.

# Note:

Pipe models other than those described in this section are not supported by path
analysis.

When you define Pipe specifications, you should keep these models in mind. For example, if
you are defining a specification for a TDM facility, you must consider that it has a signal
structure but does not have any child pipes.

The following pipe models are supported in UIM:

e Cable/Pair Model: A parent pipe represents a copper or fiber cable that provides child
pipes to represent twisted pairs or fiber strands. The cable pipe is configured in the
following way:

— Minimum and maximum quantities for the child pipes are identical, so they are created
automatically when the parent pipe is created in UIM.

— No capacity is required or provided.
— No signal structure is present.

- Packet Facility Model: Supports Layer 2 links, such as ATM, Frame Relay and Ethernet.
Facility pipes provide capacity in bulk to pipes that they enable. This capacity can be
consumed completely by one pipe or in smaller quantities by multiple pipes. The facility
pipe can enable any number of pipes if its maximum capacity and usage percentage are
not exceeded.
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# Note:

The packet model is directly supported by Connectivity entities. Except in
backward compatibility scenarios, you should use Connectivity entities to model
packet connectivity.

Pipes based on the packet facility model are configured as follows:
— No signal structure is defined.

— The capacity required reflects the capacity that the pipe must be enabled by another
pipe.

— The capacity provided is the total capacity provided by the facility.

— No child pipes are defined.

- TDM Facility Model: Supports channelized technologies, such as TDM/PDH and SONET/
SDH. Facility pipes provide channels that are used to enable service trails. A signal
structure is associated with the facility pipe to define the pipe's capacity and
channelization.

# Note:

The TDM model is directly supported by Connectivity entities. Except in
backward compatibility scenarios, you should use Connectivity entities to model
TDM connectivity.

A TDM facility pipe is structured in the following way:
— The capacity required is the capacity that is required when enabled by another pipe.

— The pipe includes a signal structure that defines the pipe's capacity provided and how
the signal is channelized. Channels are created either automatically or as needed in
UIM depending on how the signal structure is organized.

— No child pipes are defined.
See UIM Concepts for more information about pipes.
Related Topics
Configuring Pipe Specifications
Adding Pipe Termination Point Specifications to a Pipe Specification
Pipe Specification Editor
Working with Pipe Specifications

Configuring Pipe Specifications

In UIM, you can describe where the pipe terminates in general terms (a network) or at a high
level of specificity (on a particular sub-interface). This section provides the procedure on how
to configure a Pipe specification.

To configure a Pipe specification:
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1. Create a new Pipe specification or navigate to the editor of an existing one.
See "Creating New Specifications” for more information.

2. Inthe Pipe Specification editor, click the Capacities Required tab.

3. Do one of the following:

« Click Select to select an existing Capacity Required specification. The Add Entities
dialog box appears, listing all available Capacity Required specifications.

» Click Add to create a new Capacity Required specification. See "Creating New
Specifications" for more information.

4. (Optional) If this Pipe specification is associated with a signal structure, click the Signal
Structure tab and do one of the following:

» Click Select to select an existing Pipe Signal Termination Point specification. The Pipe
Signal Termination Point Specification dialog box appears, listing all available Pipe
Signal Termination Point specifications.

»  Click Signal Structure to create a new Signal Termination specification. See "Creating
New Specifications" for information about creating a new Pipe Signal Termination Point
specification. When you have completed working on the new specification, return to
the editor of the original Pipe Signal Termination Point specification.

The specification that you selected or created is displayed in the Signal Structure tab.
The number of child signals is also displayed.

5. (Optional) If the Specification is not associated with a signal structure, click the Capacity
Provided tab and do one of the following:

» Click Select to select an existing Capacity Provided specification. The Add Entities
dialog box appears, listing all available Capacity Provided specifications.

« Click Add to create a new Capacity Provided specification. See "Creating New
Specifications" to create the specification. When you have completed working on the
new specification, return to the editor of the original Pipe specification.

The specification you selected or created appears in the Capacities Provided tab.

6. From the File menu, select Save.

Related Topics

About Pipe Models

Adding Pipe Termination Point Specifications to a Pipe Specification
Pipe Specification Editor

Working with Pipe Specifications

Adding Pipe Termination Point Specifications to a Pipe Specification

ORACLE

You can add a Pipe Termination Point specification to a Pipe specification. A Pipe Termination
Point specification is required only to add characteristics. You add the Pipe Termination Point
specification by including it on the Related Specifications tab of the Pipe specification editor.
See "Working with Pipe Termination Point Specifications" and "Defining Specification
Relationships" for more information.

Related Topics
About Pipe Models
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Configuring Pipe Specifications
Pipe Specification Editor

Working with Pipe Specifications

Pipe Specification Editor

Use the Pipe Specification editor to define trails and connections, to model layered
connectivity, and to model hierarchical relationships of pipes.

When working with the Pipe Specification editor, see the following topics:

e Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab

»  Pipe Specification Editor Pipe Configurations Tab

* Pipe Specification Editor Capacity Provided Tab

«  Pipe Specification Editor Capacity Required Tab

» Pipe Specification Editor Signal Structure Tab

« Pipe Specification Editor Related Specifications Tab
e Specification Editor Configuration Spec Usage Tab
e Specification Editor Rules Tab

e Specification Editor Layouts Tab

e Specification Editor Media Tab

e Specification Editor Extends Tab

e Specification Editor Tags Tab

Pipe Specification Editor Pipe Configurations Tab

ORACLE

Use the Pipe Configurations tab to select, add, and remove a pipe configuration.

Field Use

Pipe Configuration Displays the name of the Pipe Configuration
specification.

Cartridge Displays the name of the cartridge project into
which the Pipe Configuration specification is built.

Select Click to select an existing pipe configuration.

Open Click to open the selected configuration in the Pipe
Configuration Specification editor.

Remove Click to remove a pipe configuration.

Add Click to add a new pipe configuration. See "Adding
a Configuration to a Pipe Specification” for more
information.

Related Topics
Configuring Pipe Specifications

Adding Pipe Termination Point Specifications to a Pipe Specification
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Pipe Specification Editor
About Pipe Models

Pipe Specification Editor Capacity Provided Tab

Use the Capacity Provided tab to create a new Capacity Provided specification or select an
existing one.

Field Use

Capacity Provided Displays the selected Capacity Provided
specification.

Select Click to select an existing Capacity Provided
specification.

Open Click to open the selected specification in the
Capacity Provided Specification editor.

Remove Click to remove a Capacity Provided specification.

Add Click to create a new Capacity Provided
specification.

Related Topics

Configuring Pipe Specifications

Adding Pipe Termination Point Specifications to a Pipe Specification
Pipe Specification Editor

About Pipe Models

Pipe Specification Editor Capacity Required Tab

ORACLE

Use the Capacity Required tab to create a new Capacity Required specification or select an
existing one.

Field Use

Capacity Required Displays the selected Capacity Required
specification.

Select Click to select an existing Capacity Required
specification.

Open Click to open the selected specification in the
Capacity Required Specification editor.

Remove Click to remove a Capacity Required specification.

Add Click to create a new Capacity Required
specification.

Related Topics
Configuring Pipe Specifications
Adding Pipe Termination Point Specifications to a Pipe Specification

Pipe Specification Editor
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Use the Signal Structure tab to create a new Pipe Signal Termination Point specification or

select an existing one.

Field

Use

Signal Structure

Displays the name of the selected Pipe Signal
Termination Point specification. Click this link to
create and associate a new Pipe Signal
Termination Point specification.

Select Click to select an existing Pipe Signal Termination
Point specification.
Clear Click to remove a previously selected Pipe Signal

Termination Point specification.

Related Topics

Configuring Pipe Specifications

Adding Pipe Termination Point Specifications to a Pipe Specification

Pipe Specification Editor
About Pipe Models

Pipe Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or

ORACLE

behavior based on those relationships.

Section

Use

Inventory Groups

Lists the specifications of inventory groups to
which pipes based on this specification can belong.

Pipes Lists specifications of pipes than can be provided
by pipes based on this specification.
Roles Lists roles to which entities based on this Pipe

specification can be assigned.

Pipe Termination Points

Lists specifications of pipe termination points than
can be provided by pipes based on this
specification.

Others

Lists specifications of entities that have a
customized relationship with entities based on this
specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab
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Working with Pipe Configuration Specifications

A Pipe Configuration captures details about how a pipe is enabled and on what resources the
pipe terminates.

When working with Pipe Configuration specifications, see the following topics:
e About Pipe Configuration Specifications

* Creating Pipe Configuration Specifications

* Adding a Configuration to a Pipe Specification

e Adding Configuration Items

* Place Configuration Specification Editor

About Pipe Configuration Specifications

A pipe configuration can include one instance of each of the following four types of
configuration items:

* Termination (Originating): Defines the kinds of resources on which the pipe's originating
termination point can terminate. Associating a specification option with the configuration
item limits the resources from which the pipe can originate to instances of the selected
specifications.

*  Termination (Terminating): Defines the kinds of resources on which the pipe's terminating
termination point can terminate. Associating a specification option with the configuration
item limits the resources on which the pipe can terminate to instances of the selected
specifications.

e Transport: Defines the kinds of pipes by which the pipe can be enabled. The pipe
specifications that are selected as specification options for this item are used in Path
Analysis to find the available pipe instances to enable the pipe in its end-to-end
connectivity path.

* Intermediate Node: Defines a resource, such as logical device, through which the pipe's
connectivity must route. This is a child configuration item that can be created under the
Transport item. A specification option associated with this item is used in Path Analysis to
find an instance of the specified resource through which the pipes that enable the
configured pipe must be routed.

# Note:

Although Design Studio allows you to include more than one of each of these types
of configuration items in a pipe configuration, doing so causes errors in UIM.

Creating Pipe Configuration Specifications

ORACLE

You can create a Pipe Configuration specification independently or create a new Pipe
Configuration specification in the processing of adding it to a Pipe specification.

To create a Pipe Configuration specification:

1. Do one of the following:
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« If you are creating the Pipe Configuration specification independently, select New from
the Studio menu, then select Inventory, then select Resources, then select Pipe
Configuration Specification.

« If you are creating a Pipe Configuration specification while adding it to a Pipe
specification, click Add in the Pipe Configurations tab of the Pipe Specification editor.

In the Project field, select the name of the project to which the new Pipe Configuration
specification should be added.

In the Name field, enter a name for the new Pipe Configuration specification.
This is the name that appears in UIM.
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.

b. Navigate to the directory in which to save the entity.

c. Click OK.

Click Finish.

In the Pipe Configuration Specification editor, click the Details tab.

(Optional) Right-click in the Details tab data tree area and from the Configuration Items
menu select Add Termination (Originating), Add Termination (Terminating), or Add
Transport to add configuration items.

If you added a Transport configuration item, right-click the Transport configuration item,
and then from the Configuration Items menu select Add Intermediate Node.

For Transport configuration items, you must create an Intermediate Node child
configuration item. Intermediate Node is the only required child configuration item.

(Optional) To limit the resources associated with configuration items to instances of
particular specifications:

a. Select a configuration item.
b. In the Specification Options tab, add specifications for the valid resources.

See "Configuration Specification Editor Specification Options Subtab" for more
information.

10. From the File menu, select Save.

Related Topics
Adding a Configuration to a Pipe Specification

Place Configuration Specification Editor

Adding a Configuration to a Pipe Specification

ORACLE

You can add an already existing pipe configuration or create one in the process of adding it.
The pipe configuration and the Pipe specification do not have to be in the same project.

To add a pipe configuration to a Pipe specification:

Create a new Pipe specification or navigate to the editor of an existing one.
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See "Creating New Specifications" for more information.

2. Inthe Pipe Specification editor, click the Pipe Configurations tab and do one of the
following:

» Click Select to add an existing configuration. The Add Entities dialog box appears,
listing the available specifications.

* Click Add to create and add a new configuration. See "Creating Configuration
Specifications" to create the configuration. When you have completed working on the
new configuration, return to the Pipe Specification editor.

The Pipe Configuration specification is added to the Pipe specification's Pipe
Configurations tab.

3. From the File menu, select Save.

Related Topics
Creating Pipe Configuration Specifications

Pipe Configuration Specification Editor

Pipe Configuration Specification Editor

Use the Pipe Configuration Specification editor to capture details about how a pipe is enabled
and on what resources the pipe terminates.

When working with the Pipe Configuration Specification editor, see the following topics:

e Configuration Specification Editor Details Tab

»  Configuration Specification Editor Layouts Tab

«  Configuration Specification Editor Rules Tab

*  Pipe Configuration Specification Editor Pipe Specs Tab
e Specification Editor Tags Tab

Pipe Configuration Specification Editor Pipe Specs Tab

Use the Pipe Specs tab to select, add, and remove the Pipe specifications that use the Pipe
Configuration specifications. This tab identifies the Pipe specifications that use the selected
Pipe Configuration specification. You must use this tab to relate a Pipe specification to its Pipe
Configuration specification only when the Pipe specification and Pipe Configuration
specification need to be in separate cartridges, and the Pipe specification can exist without the
Pipe Configuration specification. If both the Pipe specification and Pipe Configuration
specification are in the same cartridge, make the association on the Pipe specification.

Field Use

Pipe Specification Displays the name of the Pipe specification.

Cartridge Displays the name of the cartridge project into
which the Pipe specification is built.

Select Click to select an existing Pipe specification.

Open Click to open the selected specification in the Pipe

Specification editor.

Remove Click to remove a Pipe specification.
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Field Use

Add Click to add a new Pipe specification.

Working with Pipe Signal Termination Point Specifications

You use Pipe Signal Termination Point specifications to define signal structures. A signal
structure defines a multiplexing hierarchy where data streams are separated into multiple lower
data communication links. For example, a DS1 signal structure can define a 1.536 Mbps data
stream as 24 DSO signals, each supporting 64 Kbps. The signal structure defines the channel
hierarchy for a pipe facility that supports time division multiplexing (TDM), such as a T1 or an
E1 facility.

You create a hierarchy of Pipe Signal Termination Point specifications to define the signal
structure. The highest-level Pipe Signal Termination Point specification in the hierarchy (the
parent) represents a trail termination point (TTP). You associate this parent specification to a
Capacity Provided specification to define the total bandwidth capacity provided by the signal
structure.

The child Pipe Signal Termination Point specifications represent connection termination points
(CTP). A signal structure can have multiple levels of child Pipe Signal Termination Point
specifications, each representing a further breakdown of the data stream defined by the
preceding specification in the hierarchy.

You associate the highest-level Pipe Signal Termination Point specification (the parent) of a
signal structure to a Pipe specification to define the channel hierarchy and capacity provided
by the pipe facility.

When working with Pipe Signal Termination Point specifications, see the following topics:

e Configuring Child Signal Termination Points
e Configuring Parent Signal Termination Points

«  Pipe Signal Termination Point Specification Editor

About Child Signal Termination Points

ORACLE

A child signal termination point represents a child signal level in a signal structure, such as the
DSO signals in a DS1 signal structure. Although you can create the specifications in any order,
it is generally a good practice to begin with the child signal termination points and then move to
the parent. Having the child termination points already created makes it easier to create the
parent termination points. When you configure a child Pipe Signal Termination Point
specification, you define the capacity unit amount, unit of measure, and number of child
signals.

You can optionally define compatible signals. These are Pipe Signal Termination Point
specifications that define capacity unit amounts that the signal can support even though they
are not an exact match for the main capacity unit amount. For example, you can configure, a
SONET STS1 51.840 Mbps channel to support a DS3 facility at a rate of 44.736 Mbps in
addition to an STS transmission facility of exactly 51.840 Mbps.

Related Topics
Configuring Child Signal Termination Points

Pipe Signal Termination Point Specification Editor
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Configuring Child Signal Termination Points

To configure a child Pipe Signal Termination Point specification:

1.

6.

Create a new Pipe Signal Termination Point specification or navigate to the editor of an
existing one.

See "Creating New Specifications" for more information.
In the Pipe Signal Termination Point Specification editor, click the Properties tab.
In the Capacity Unit Amount field, enter an amount for the capacity.

The value is relative to the selection in the Unit of Measure field. When you enter a value
in the Capacity Unit Amount field, the Capacity Provided field is disabled. Capacity
provided information is not required for child signal termination points.

In the Unit of Measure field, select a unit of measure relative to the Capacity Unit
Amount field.

See "Creating Units of Measure" for information about creating a new Unit of Measure.
In the Number of Child Signals field, select the appropriate value.

For example, select 0 if this signal termination point will not have any child signal
termination points. If the signal termination point will have children, this value will be
greater than 0. For example, in a SONET or SDH signal structure, there can be more than
two levels of signal termination points.

From the File menu, select Save.

Related Topics

Pipe Signal Termination Point Specification Editor

Configuring Parent Signal Termination Points

Configuring Parent Signal Termination Points

You define the total bandwidth for the signal structure by relating a Capacity Provided
specification to the highest-level Pipe Signal Termination Point specification in the structure. A
parent signal termination point represents the top level of a signal structure, such as the DS1
signal in DS1 signal structure. You define the signal hierarchy below the parent signal
termination point by selecting a succession of child termination point specifications.

ORACLE

To configure a parent Pipe Signal Termination Point specification:

1.

Create a new Pipe Signal Termination Point specification or navigate to the editor of an
existing one.

See "Creating New Specifications" for more information.
In Pipe Signal Termination Point Specification editor, click the Properties tab.
In the Capacity Provided field, do one of the following:

e Click Capacity Provided to create and model a new specification. See "Creating New
Specifications" for more information. When you have completed working on the new
Capacity Provided specification, return to the editor of the original Pipe Signal
Termination Point specification.

e Click Select to select an existing Capacity Provided specification.
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e Click Clear to remove any previous selections.

The specification that you select or create is displayed in the Capacity Provided field, and
the Capacity Unit Amount and Unit of Measure fields are disabled. This information is
not required for parent signal termination points.

4. In the Number of Child Signals field, enter or select the appropriate number of signals.
For example, for a DS1 signal structure, enter 24.

5. Click the Signal Structure tab.

6. Right-click the icon in the tab and do one of the following:

* Select Select Child Signal to select an existing Pipe Signal Termination Point
specification.

* Select Create New Child Signal to create a new Pipe Signal Termination Point
specification.

See "Creating New Specifications" for information about creating a new Pipe Signal
Termination Point specification. When you have completed working on the new
specification, return to the editor of the original Pipe Signal Termination Point
specification.

The specification that you select or create is displayed in the Signal Structure tab. The
number of child signals is also displayed.

7. From the File menu, select Save.
Related Topics
Pipe Signal Termination Point Specification Editor

Configuring Child Signal Termination Points

Pipe Signal Termination Point Specification Editor

ORACLE

Use the Pipe Signal Termination Point Specification editor to define signal structures.

When working with the Pipe Signal Termination Point Specification editor, see the following
topics:

»  Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab

*  Pipe Signal Termination Point Specification Editor Signal Structure Tab
*  Pipe Signal Termination Point Specification Editor Properties Tab

*  Pipe Signal Termination Point Specification Editor Compatible Signals Tab
»  Specification Editor Specification Properties Tab

e Specification Editor Rules Tab

»  Specification Editor Layouts Tab

»  Specification Editor Media Tab

»  Specification Editor Extends Tab

e Specification Editor Tags Tab
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Pipe Signal Termination Point Specification Editor Signal Structure Tab

Use the Signal Structure tab to create a new Pipe Signal Termination Point specification or
select an existing one.

Field Use

Select Child Signal Right-click the specification box and select this
option to add an existing Pipe Signal Termination
Point specification.

Create New Child Signal Right-click the specification box and select this
option to create a new Pipe Signal Termination
Point specification.

Related Topics
Configuring Child Signal Termination Points
Configuring Parent Signal Termination Points

Pipe Signal Termination Point Specification Editor

Pipe Signal Termination Point Specification Editor Properties Tab

Use the Properties tab to define the capacity unit amount, unit of measure, and number of

child signals.

Field Use

Capacity Provided Displays the name of the selected Capacity
Provided specification.

New Click to create a new Capacity Provided
specification.

Select Click to select an existing Capacity Provided
specification.

Clear Click to remove a Capacity Provided specification.

Capacity Unit Amount Enter a value relative to the selection in the Unit of
Measure field. When you enter a value in the
Capacity Unit Amount field, the Capacity Provided
area is removed from the tab. Capacity provided
information is not required for child signal
termination points.

Unit of Measure Click New to create a new unit of measure or click
Select to use an existing one.

Number of Child Signals Define this value as 0 if the signal termination point
will not have any child signal termination points.
Define this value as greater than 0O if the signal
termination point will have children.

Related Topics
Configuring Child Signal Termination Points

Configuring Parent Signal Termination Points
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Pipe Signal Termination Point Specification Editor

Pipe Signal Termination Point Specification Editor Compatible Signals Tab

You use the Compatible Signals tab to select Pipe Signal Termination Point specifications that
include compatible capacity unit amounts. These are capacities that the signal can support
even though they are not an exact match for the main capacity unit amount. For example, you
can configure a SONET STS1 51.840 Mbps channel to support a DS3 facility at a rate of
44.736 Mbps in addition to an STS transmission facility of exactly 51.840 Mbps.

Field Use

Supports Signals Displays all supported Pipe Signal Termination
Point specifications.

Supported By Signals Displays all Pipe Signal Termination Point
specifications that are supported by the selected
specification.

Select Click to select and add an existing Pipe Signal
Termination Point specification.

Open Click to open the selected Signal Termination Point
in the Pipe Signal Termination Point Specification
editor.

Remove Click to remove the selected Pipe Signal

Termination Point specification.

Add Click to create and add a new Pipe Signal

Termination Point specification.

Working with Pipe Termination Point Specifications

You can include Pipe Termination Point specifications in a Pipe specification. When you create
a Pipe Termination Point specification, you can include characteristics for information you want
to collect. Pipe Termination Point specifications enable you to include characteristics on the
termination points of a pipe and to add behaviors through rulesets. A pipe termination point
identifies where one end of a pipe terminates. If you use pipe termination points, each pipe
must have two, one for each end.

Defining Pipe Termination Point specifications is necessary only to add characteristics to
capture specific information about the termination point.

The application creates pipe termination points without a specification if there is no Pipe
Termination Point specification associated with the Pipe specification. See "Adding Pipe
Termination Point Specifications to a Pipe Specification" for more information.

You create Pipe Termination Point specifications in the same manner as you create other types
of specifications. See "Creating New Specifications" for more information.

See "Pipe Termination Point Specification Editor" for reference information about the tabs you
use to define a Pipe Termination Point specification.

Pipe Termination Point Specification Editor

ORACLE

Use the Pipe Termination Point Specification editor to identify where one end of a pipe
terminates, to include characteristics on the termination points of a pipe, and to add behaviors
through rulesets.
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When working with the Pipe Termination Point Specification editor, see the following topics:

e Specification Editor Characteristics Tab

e Specification Editor Specification Properties Tab

e Pipe Termination Point Specification Editor Related Specifications Tab

e Specification Editor Rules Tab

e Specification Editor Layouts Tab
e Specification Editor Media Tab

e Specification Editor Extends Tab
e Specification Editor Tags Tab

Pipe Termination Point Specification Editor Related Specifications Tab

Working with Capacity Types

ORACLE

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or

behavior based on those relationships.

Section

Use

Inventory Groups

Lists the specifications of inventory groups to
which pipe termination points based on this
specification can belong.

Pipes Lists specifications of pipes than provide pipe
termination points based on this specification.
Others Lists specifications of entities that have a

customized relationship with entities based on this
specification.

Related Topics

Defining Specification Relationships

Specification Editor Related Specifications Tab

In UIM, you can define various types of capacity and how they are measured. You can also
define how an entity provides or requires capacity in terms of its capacity type and the amount
it provides. Capacity types define the kind of capacity that an entity provides or consumes. You
associate a measurement type to a capacity type to specify how the capacity is measured. See
"Working with Measurement Types" for more information.

When working with capacity types, see the following topics:

e Creating Capacity Types
e Configuring Capacity Types
e Capacity Type Editor
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Creating Capacity Types

You create capacity types to define the kind of capacity that an entity provides or consumes.

To create capacity types:

1.

From the Studio menu, select New, then select Inventory, then select Resources, then
select Capacity Type.

The Model Entity Wizard appears. An icon for the specification type appears in the upper-
right corner.

In the Project field, select the name of the project to which the new capacity type should
be added.

In the Name field, enter a name for the capacity type.
This is the name that will appear in UIM.
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.

b. Navigate to the directory in which to save the entity.
c. Click OK.

Click Finish.

Design Studio creates the capacity type and displays the information in Capacity Type
editor.

Related Topics

Capacity Type Editor

Configuring Capacity Types

Configuring Capacity Types

You associate a measurement type to a capacity type to specify how the capacity is measured.

ORACLE

To configure a capacity type:

1.

Create a new capacity type or navigate to the editor of an existing one.
See "Creating Capacity Types" for more information.

In the Capacity Type editor Properties tab, enter a name for the capacity type in the Name
field.

In the Measurement Type area, do one of the following:

* Click Select to select an existing measurement type. The Measurement Type dialog
box appears, listing all available measurement types.

*  Click the Measurement Type link to create and add a new measurement type. See
"Creating Measurement Types" for information about creating a new measurement

type.
The measurement type you select or create is displayed in the Measurement Type field.
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4. In the Description field, enter a description of the capacity type.
5. From the File menu, select Save.

Related Topics
Capacity Type Editor

Capacity Type Editor

Use the Capacity Type editor to define the kind of capacity that an entity provides or
consumes.

When working with the Capacity Type editor, see the following topics:

e Capacity Type Properties Tab
*  Specification Editor Tags Tab

Capacity Type Properties Tab

Use the Properties tab to define the kind of capacity that an entity provides or consumes.

Field Use

Name Enter a name for the capacity type.

Measurement Type Displays the name of the measurement type. Click
the link to create a new measurement type.

Select Click to select an existing measurement type.

Clear Click to remove the measurement type.

Description Enter a description for the capacity type.

Related Topics
Creating Capacity Types
Configuring Capacity Types

Working with Capacity Provided Specifications

ORACLE

Capacity Provided specifications define the maximum capacity an entity can provide to other
entities that can consume the capacity, such as the maximum bandwidth capacity provided by
a pipe. An entity can offer multiple types of capacity, so its specification can have relationships
to multiple Capacity Provided specifications.

An entity specification can be related to only one Capacity Provided specification of a given
capacity type, however. Capacity types are required to create Capacity Provided specifications.
UIM supports defining capacity provided for pipes and signal termination points. See "Working
with Capacity Types" for more information.

When working with Capacity Provided specifications, see the following topics:
e Configuring Capacity Provided Specifications

e Capacity Provided Specification Editor
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Configuring Capacity Provided Specifications

You associate Capacity Provided specifications to specifications of entities that offer capacity
through the capacity framework.

To configure a Capacity Provided specification:

1.

7.

Create a new Capacity Provided specification or navigate to the editor of an existing one.
See "Creating New Specifications" for more information.

In the Capacity Provided editor, click the Properties tab.

In the Capacity Type field, do one of the following:

» Click Capacity Type to create and add a new capacity type. See "Creating Capacity
Types" for more information.

* Click Select to select an existing capacity type. The Capacity Type dialog box
appears, listing all available capacity types.

* Click Clear to remove a previous selection.
In the Total Amount field, enter the amount of the capacity provided.
In the Unit of Measure field, do one of the following:

e Click Unit of Measure to create and add a new unit of measure. See "Creating Units
of Measure" for more information.

* Click Select to select an existing unit of measure. The Unit of Measure dialog box
appears, listing all available units of measure.

e Click Clear to remove a previous selection.

In the Consumable Percentage field, enter the percentage of the total amount that can be
consumed.

From the File menu, select Save.

Related Topics

Capacity Provided Specification Editor

Capacity Provided Specification Editor

Use the Capacity Provided Specification editor to define the capacity an entity offers in terms of
a total amount and a consumable percentage.

ORACLE

When working with the Capacity Provided Specification editor, see the following topics:

Specification Editor Specification Properties Tab
Capacity Provided Specification Editor Properties Tab
Specification Editor Related Specifications Tab
Specification Editor Rules Tab

Specification Editor Media Tab

Specification Editor Tags Tab
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Capacity Provided Specification Editor Properties Tab

Use the Properties tab to create a new capacity type or select an existing one.

Field

Use

Capacity Type

Determines the type of capacity offered, defined by

a capacity type.

Do one of the following:

*  Click Capacity Type to create a new capacity
type.

*  Click Select to select from existing capacity

types.
*  Click Clear to remove a previous selection.

Clear

Click to remove a new capacity type.

Total Amount

Enter the amount of the capacity type that an entity
can provide.

Unit of Measure

Select the units by which the total amount is
measured, defined by a Unit of Measure
specification.

Do one of the following:

e Click the link to create a new unit of measure.

*  Click Select to select from existing units of
measure.

*  Click Clear to remove a previous selection.

Consumable Percentage

Select the percentage of the total amount that can
be consumed. A consumable percentage over
100% indicates that the capacity can be
oversubscribed.

Related Topics

Configuring Capacity Provided Specifications

Capacity Provided Specification Editor

Working with Capacity Required Specifications

Capacity Required specifications define the amount of capacity entities require when they

ORACLE

consume a type of capacity.

An entity can require multiple types of capacity, so its specification can have relationships to
multiple Capacity Required specifications. An entity specification can be related to only one
Capacity Required specification of a given capacity type, however. Capacity types are required
to create Capacity Required specifications. See "Working with Capacity Types" for more

information.

When working with Capacity Required specifications, see the following topics:

e Configuring Capacity Required Specifications

e Capacity Required Specification Editor
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Configuring Capacity Required Specifications

You associate Capacity Required specifications to specifications of entities that offer capacity
through the capacity framework.

To configure a Capacity Required specification:

1. Create a new Capacity Required specification or navigate to the editor of an existing one.
See "Creating New Specifications" for more information.

2. Inthe Capacity Required Specification editor, click the Properties tab.

3. Inthe Capacity Type field, do one of the following:

* Click Capacity Type to create and add a new capacity type. See "Creating Capacity
Types" for more information.

« Click Select to select an existing capacity type. The Capacity Type dialog box
appears, listing all available capacity types.

* Click Clear to remove any previous selections.
4. In the Total Amount field, enter the total capacity provided.
5. In the Unit of Measure field, do one of the following:

*  Click Unit of Measure to create and add a new unit of measure. See "Creating Units
of Measure" for more information.

* Click Select to select an existing unit of measure. The Unit of Measure dialog box
appears, listing all available units of measure.

* Click Clear to remove a previous selection.

6. Inthe Consumable Percentage field, enter the percentage of the total amount that can be
consumed.

7. From the File menu, select Save.

Related Topics

Capacity Required Specification Editor

Capacity Required Specification Editor
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Use the Capacity Required Specification editor to define the capacity that an entity requires.
When working with the Capacity Required Specification editor, see the following topics:

e Specification Editor Specification Properties Tab

e Capacity Required Specification Editor Properties Tab

e Specification Editor Related Specifications Tab

e Specification Editor Rules Tab

e Specification Editor Layouts Tab

e Specification Editor Media Tab

e Specification Editor Tags Tab
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Capacity Required Specification Editor Properties Tab

Use the Properties tab to create a new capacity type or select an existing one.

Field

Use

Capacity Type

Determines the type of capacity offered, defined by

a capacity type.

Do one of the following:

*  Click Capacity Type to create a new capacity
type.

*  Click Select to select from existing capacity

types.
*  Click Clear to remove a previous selection.

Required Amount

Enter the amount of the capacity type that an entity
requires.

Unit of Measure

Select the units by which the total amount is
measured, defined by a Unit of Measure
specification.

Do one of the following:

e Click the link to create a new unit of measure.

*  Click Select to select from existing units of
measure.

*  Click Clear to remove a previous selection.

Quantity

Specify the quantity of the required amount.
Typically, this value is set to 1. If the capacity
required must be consumed as a set of units, such
as channels provided by a facility pipe, set the
Quantity to the number of units required. The
capacity required of each unit is equal to the value
set in the Required Amount field. The total
amount of capacity required is equal to the value
defined in the Required Amount field times the
value defined in the Quantity field.

Related Topics
Configuring Capacity Required Specifications

Capacity Required Specification Editor

Working with Measurement Types

A measurement type classifies related groups of units of measure. For example, a bit rate
measurement type classifies units of measure such as bits per second (bps), kilobits per
second (kbps), and so on. Other possible measurement types include weight and amperage.
Measurement types and units of measure are required to create capacity types. See "Working

ORACLE

with Capacity Types" for more information.

When working with measurement types, see the following topics:

e Creating Measurement Types

e Measurement Types Editor
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Creating Measurement Types

You create measurement types to classify related groups of units of measure.
To create measurement types:

1. From the Studio menu, select New, then select Inventory, then select Resources, then
select Measurement Type.

The Model Entity Wizard appears. An icon for the specification type appears in the upper-
right corner.

2. Inthe Project field, select the name of the project to which the new measurement type
should be added.

3. Inthe Name field, enter a name for the measurement type.
This is the name that will appear in UIM.
4. (Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.
b. Navigate to the directory in which to save the entity.
c. Click OK.

5. Click Finish.

Design Studio creates the measurement type and displays its information in the
Measurement Type editor.

Related Topics

Measurement Types Editor

Measurement Types Editor

Use the Measurement Types editor to model related groups of units of measure.
When working with measurement types, see the following topics:

e Measurement Type Properties Tab

e Specification Editor Tags Tab

Measurement Type Properties Tab

Use the Properties tab to name and describe related groups of units of measure.

Field Use

Name Enter a name for the specification.

Description Enter a description for the specification. This field
is optional.
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Related Topics

Creating Measurement Types

Working with Units of Measure

Units of measure define the units used to measure a type of capacity in UIM. A unit of measure
is a quantity or increment by which something is divided, counted, or described. For example,
Kbps is a unit that measures a bit rate.

When working with units of measure, see the following topics:

Creating Units of Measure
Configuring Units of Measure

Inventory Unit of Measure Editor

Creating Units of Measure

You create units of measure to define the units used to measure capacity in UIM.

ORACLE

To create a unit of measure:

1.

From the Studio menu, select New, then select Inventory, then select Resources, then
select Unit of Measure.

The Model Entity Wizard appears. An icon for the specification type appears in the upper-
right corner.

In the Project field, select the name of the project to which the new unit of measure should
be added.

In the Name field, enter a name for the unit of measure.
This is the name that will appear in UIM.
(Optional) Select a location.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.

b. Navigate to the directory in which to save the entity.
c. Click OK.

Click Finish.

Design Studio creates the unit of measure and displays the information on the Properties
tab.

Related Topics

Configuring Units of Measure

Inventory Unit of Measure Editor
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Configuring Units of Measure

After you have created a unit of measure, you must configure its properties.

To configure unit of measure properties:

1.

8.
9.

Create a new unit of measure or navigate to the editor of an existing one.
See "Creating Units of Measure" for more information.

The Unit of Measure editor appears, displaying the Properties tab.

In the Name field, enter a name that identifies the unit of measure.

In the Display Unit Value field, enter the value that you want to be displayed in UIM
menus and lists.

In the Type of Measurement area, click Select and select a measurement type.

The Selection Dialog dialog box appears. See "Creating Measurement Types" to create a
new measurement type.

Select a measurement type, then click OK.

The measurement type that you selected is displayed in the Type of Measurement field.
Click the Type of Measurement link to open the measurement type in the Measurement
Type editor.

In the Description field of the Conversion area, enter a description of the conversion
required to convert this unit of measure to the base unit of measure.

In the Conversion Factor field, enter the multiple used to convert this unit of measure to
the base unit of measure.

In the main Description field, enter a description of this unit of measure.

From the File menu, select Save.

Related Topics

Creating Units of Measure

Inventory Unit of Measure Editor

Inventory Unit of Measure Editor

Use the Inventory Unit of Measure editor to model the units used to measure capacity in UIM.

When working with the Inventory Unit of Measure editor, see the following topics:

Inventory Unit of Measure Properties Tab

Specification Editor Tags Tab

Inventory Unit of Measure Properties Tab

Use the Properties tab to model the units used to measure capacity in UIM.

Field Use

Name Enter the name of the unit.

ORACLE
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Field

Use

Display Unit Value

Enter the text to be displayed in menus and lists for
this unit of measure. This is usually a shortened
version of the name.

Type of Measurement

Specify the measurement type to which this unit of
measure belongs. You specify this property by
selecting or creating a measurement type.

Conversion Description

Enter a description of the conversion required to
convert this unit of measure to the base unit of
measure.

Conversion Factor

A multiplier used to convert a unit of measure to
another unit of measure. For example, for a Mbps
unit of measure, you could enter 1000000 as the
conversion factor to bps.

Note: Use a conversion factor that converts to the
same base unit of measure for all units of measure
for any given measurement type.

Description

Enter a description of this unit of measure.

Related Topics
Creating Units of Measure

Configuring Units of Measure
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Working with Telephone Number, Custom
Network Address, and Custom Object
Specifications

In Oracle Communications Unified Inventory Management (UIM), you use Telephone Number
specifications to define the types of telephone numbers that your inventory includes and how
they are managed in the business process, Custom Network Address specifications to define a
network address that is not modeled by default in UIM, and Custom Object specifications to
define entities that do not fit into one of the pre-defined categories in UIM.

When working with Telephone Number, Custom Network Address, and Custom Object
specifications, see the following topics:

*  Working with Telephone Number Specifications
e Working with Custom Network Address Specifications

*  Working with Custom Object Specifications

Working with Telephone Number Specifications

You use Telephone Number specifications to define the types of telephone numbers that your
inventory includes and how they are managed in the business process. A Telephone Number
specification is a blueprint for the various kinds of telephone numbers you might use. In
addition to the standard aspects of a specification, you need to define how telephone numbers
based on the specification are formatted for display and storage.

You create Telephone Number specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.

See "Telephone Number Specification Editor" for reference information about the tabs you use
to define a Telephone Number specification.

Telephone Number Specification Editor

Use Telephone Number Specification editor to define the types of telephone numbers included
in your inventory.

When working with the Telephone Number Specification editor, see the following topics:

e Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab

* Telephone Number Specification Editor Related Specifications Tab
»  Specification Editor Configuration Spec Usage Tab

e Specification Editor Rules Tab

e Specification Editor Layouts Tab

e Specification Editor Media Tab
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»  Specification Editor Extends Tab
»  Specification Editor Tags Tab

Telephone Number Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review related specifications. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or
behavior based on those relationships.

Section Use

Inventory Groups Lists the specifications of inventory groups to
which custom network addresses based on this
specification can belong.

Others Lists specifications of entities that have a
customized relationship with entities based on this

specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Custom Network Address Specifications

A network address is a name, label, or number identifying a location in storage or a device in a
system or network. You use a Custom Network Address specifications to define a network
address that is not modeled by default in UIM. The network addresses that are modeled by
default in the UIM framework are telephone numbers and logical device accounts. See
"Working with Telephone Number Specifications" and "Working with Logical Device Account
Specifications" for more information.

You create Custom Network Address specifications in the same manner as you create other
types of specifications. See "Creating New Specifications" for more information.

See "Custom Network Address Specification Editor" for reference information about the tabs
you use to define a Custom Network Address specification.

Custom Network Address Specification Editor
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Use the Custom Network Address Specification editor to define network addresses that are not
modeled by default in UIM.

When working with the Custom Network Address Specification editor, see the following topics:

e Specification Editor Characteristics Tab

e Specification Editor Specification Properties Tab

e Custom Network Address Specification Editor Related Specifications Tab
e Specification Editor Configuration Spec Usage Tab

e Specification Editor Rules Tab

e Specification Editor Layouts Tab
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e Specification Editor Media Tab
e Specification Editor Extends Tab
»  Specification Editor Tags Tab

Custom Network Address Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review related specifications. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or
behavior based on those relationships.

Section Use

Inventory Groups Lists the specifications of inventory groups to
which custom network addresses based on this
specification can belong.

Network Nodes Lists specifications of network nodes that can
represent custom network addresses based on this
specification.

Others Lists specifications of entities that have a
customized relationship with entities based on this

specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Custom Object Specifications

You use Custom Object specifications to define entities that do not fit into one of the predefined
categories in UIM. Custom Object specifications enable you to extend the inventory model
without having to create a custom schema or redeploy UIM.

All of the standard features of specifications, such as characteristics, relationships, and rules
are available for custom objects. UIM manages the life cycle of custom objects the same way it
manages other entities. Custom objects can also be included in involvement relationships. See
"Working with Involvement Specifications" for more information.

You create Custom Object specifications in the same manner as you create other types of
specifications. See "Creating New Specifications” for more information.

See "Custom Object Specification Editor" for reference information about the tabs you use to
define a Custom Object specification.

Custom Object Specification Editor

ORACLE

Use Custom Object Specification editor to define entities that do not fit into one of the
predefined categories in UIM.

When working with the Custom Object Specification editor, see the following topics:

*  Specification Editor Characteristics Tab

*  Specification Editor Specification Properties Tab
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e Specification Editor Related Specifications Tab

«  Specification Editor Configuration Spec Usage Tab
e Specification Editor Rules Tab

e Specification Editor Layouts Tab

»  Specification Editor Media Tab

e Specification Editor Extends Tab

e Specification Editor Tags Tab

Custom Object Editor Related Specifications Tab

ORACLE

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or
behavior based on those relationships.

Section Use

Inventory Groups Lists the specifications of inventory groups to
which custom objects based on this specification
can belong.

Roles Defines the roles to which custom objects based
on this specification can be assigned.

Network Nodes Lists specifications of network nodes that can
represent custom objects based on this
specification.

Network Edges Lists specifications of network edges that can
represent custom objects based on this
specification.

Others Lists specifications of entities that have a
customized relationship with entities based on this
specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab
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Working with Inventory Group, and
Involvement Specifications

In Oracle Communications Unified Inventory Management (UIM), you use Inventory Group
specifications to organize and correlate entities in the inventory, and you use Involvement
specifications to define associations between entities that are not related in the inventory
model.

When working with Business Interaction, Inventory Group, and Involvement specifications, see
the following topics:

*  Working with Inventory Group Specifications

*  Working with Involvement Specifications

Working with Inventory Group Specifications

You use Inventory Group specifications to organize and correlate entities in the inventory. You
can define inventory groups to organize entities based on criteria such as geographic area,
serving area, billing area, IP address pool, and so forth.

For example, an inventory group containing locations and telephone numbers enables you to
specify the telephone numbers that can be selected from a specific serving area.

You create Inventory Group specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.

See "Inventory Group Specification Editor" for reference information about the tabs you use to
define an Inventory Group specification.

Inventory Group Specification Editor

ORACLE

Use the Inventory Group Specifications editor to organize and correlate entities in the
inventory.

When working with the Inventory Group Specifications editor, see the following topics:
e Specification Editor Characteristics Tab

e Specification Editor Specification Properties Tab

e Inventory Group Specification Editor Related Specifications Tab

e Specification Editor Configuration Spec Usage Tab

e Specification Editor Rules Tab

e Specification Editor Layouts Tab

e Specification Editor Media Tab

e Specification Editor Extends Tab

e Specification Editor Tags Tab
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Inventory Group Specification Editor Related Specifications Tab

Use the Related Specifications tab to define and review specification relationships. Only
relationships with the entity types listed in this tab are meaningful by default in UIM. If you add
specifications to the Others section, you must define custom rulesets that trigger actions or
behavior based on those relationships.

Section Use

Inventory Groups Lists inventory groups that can be children of
inventory groups based on this specification.

Others Lists specifications of entities that have a
customized relationship with entities based on this
specification.

Related Topics
Defining Specification Relationships

Specification Editor Related Specifications Tab

Working with Involvement Specifications

Involvement specifications enable you to define associations between entities for relationships
that are not currently supported in UIM. The Involvement specifications that you create enable
you to capture characteristics on the relationship and to specify the roles played by the entities
participating in the involvement. In order to give the relationship behaviors, you must use
rulesets and extension points.

For example, you can use involvements to establish associations involving custom objects.
See "Working with Custom Object Specifications" for information about custom objects. By
definition, custom objects have no implicit relationships with other entities, so you can use

involvements to associate them to other entities.

Two resources can be preconfigured using the PreconfigureSpec Involvement specification
(provided by Oracle). Preconfigured resources share the same life cycle in that when one of
the resources is reserved or assigned to a service or resource, the other is automatically
reserved or assigned with it. This behavior applies only to involvements created using the
PreconfigureSpec specification. This specification does not appear in Design Studio; rather, it
is installed in UIM as base data.

You create and configure an Involvement specification in the same way that you do most other
types of specifications. See "Working with Specifications" for more information.

When working with Involvement specifications, see "Involvement Specification Editor" for more
information.

Involvement Specification Editor

ORACLE

Use the Involvement Specification editor to define associations between entities that are not
related in the inventory model.

When working with the Involvement Specification editor, see the following topics:

e Specification Editor Characteristics Tab

»  Specification Editor Specification Properties Tab
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Specification Editor Related Specifications Tab
Specification Editor Rules Tab

Specification Editor Layouts Tab

Specification Editor Media Tab

Specification Editor Extends Tab

Chapter 14
Working with Involvement Specifications
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Working with IP Address Resource Extension
Specifications

You use IP Address Resource Extension specifications to model content for IP address
management. IP Address Resource Extension specifications represent networks, subnets, and
IP addresses for both IPv4 and IPv6 address management.

When you define IP Address Resource Extension specifications, you can add characteristics to
supplement the default data elements. See "About IP Address Resource Extensions" for more
information.

When working with IP Address Resource Extension specifications, see "IP Address Resource
Extension Specification Editor" for reference information about the tabs you use to define an IP
Address Resource Extension specification.

About IP Address Resource Extensions

ORACLE

You create IP Address Resource Extension specifications by extending inventory entities. See
"Extending Predefined Specifications" for more information.

When extending an IP resource entity, you select an IP resource type of:

o IPv4Network
¢ IPv4Subnet
* IPv4Address
* IPv6Network
* IPv6Subnet
* IPv6Address

UIM also provides the following base specifications in the ora_uim_basespecifications
cartridge. If IP resources are not extended through the IP address resource extension
specifications and deployed into UIM, the base specifications are deployed into UIM by default.

* IPv4NetworkBase
* IPv4SubnetBase
* IPv4AddressBase
* IPv6NetworkBase
* IPv6SubnetBase
* IPv6AddressBase

The IPv4NetworkBase and IPv6NetworkBase base specifications define a unique set of
characteristics that pertain to an IPv4 and IPv6 network respectively. The IPv4Network and
IPv6Network resource extension specifications define the same unique set of characteristics,
but also provide the ability to extend the specification by adding custom characteristics. Both
types of specifications (base and resource extension) are used to define IPv4Subnet and
IPv6Subnet entities in UIM.
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# Note:

Both IP networks and IP subnets are defined in the UIM database as IPv4Subnet or
IPv6Subnet entities, but are differentiated with the isIPNetwork boolean attribute;
when set to true, the entity is an IP network, and when set to false, the entity is an IP
subnet.

The IPv4SubnetBase and IPv6SubnetBase base specifications define a unique set of
characteristics that pertain to an IPv4 and IPv6 subnet respectively. The IPv4Subnet and
IPv6Subnet resource extension specifications define the same unique set of characteristics,
but also provide the ability to extend the specification by adding custom characteristics. Both
types of specifications (base and resource extension) are used to define IPv4Subnet and
IPv6Subnet entities in UIM.

The IPv4AddressBase and IPv6AddressBase base specifications define a unique set of
characteristics that pertain to an IPv4 and IPv6 address respectively. The IPv4Address and
IPv6Address resource extension specifications define the same unique set of characteristics,
but also provide the ability to extend the specification by adding custom characteristics. Both
types of specifications (base and resource extension) are used to define IPv4Address and
IPv6Address entities in UIM.

IP Address Resource Extension Specification Editor

ORACLE

You use the IP Address Resource Extension Specification editor to extend the predefined IP
Address Resource specification for IPv4 and IPv6 networks, subnets, and IP addresses. When
working with the IP Address Resource Extension Specification editor, see the following topics:

e Specification Editor Characteristics Tab

e Specification Editor Layouts Tab

e Specification Editor Rules Tab

e Specification Editor Related Specifications Tab

e Specification Editor Configuration Spec Usage Tab

e Specification Editor Extends Tab
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Working with Network Address Domain
Specifications

In Oracle Communications Unified Inventory Management (UIM) network address domains
define a context for the uniqueness of network addresses. For example, you can use network
address domain to define private routing domains for IP addresses.

In UIM, you can use network address domains with the following entities:

e Flow identifiers
e |P subnets
e Telephone numbers

Network Address Domain entities are based on specifications that you define in Oracle
Communications Service Catalog and Design - Design Studio. When you define a Network
Address Domain specification, you define which entity type it covers. Predefined specifications
are included in some reference cartridges. For example, the Carrier Ethernet cartridge includes
a specification for VLAN domains.

When working with Network Address Domain specifications, see the following topics:

e Network Address Domain Specification Editor

Network Address Domain Specification Editor

Use the Network Domain Specification editor to model Network Address Domain
specifications.

When working with the Network Specification editor, see the following topics:
e Specification Editor Characteristics Tab

«  Specification Editor Specification Properties Tab

*  Network Address Domain Properties Tab

e Specification Editor Rules Tab

»  Specification Editor Layouts Tab

«  Specification Editor Media Tab

»  Specification Editor Tags Tab

Network Address Domain Properties Tab

Use the Network Properties tab to enter network properties.
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Network Address Domain Specification Editor

Field

Use

Network Address Type

Determines the entity types to which the network
address domain applies. Select from the following:
* |IP Subnet

*  Flow Identifier

*  Telephone Number
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Working with Media Stream Specifications

You use Media Stream specifications to model content such as audio or video media delivered
over cable, satellite, radio, or streaming IP. Media Stream specifications represent provisional
or subscription video services such as tiered services and a la carte packages.

When you define Media Stream specifications, you can add characteristics to supplement the
default data elements.

You create Media Stream specifications in the same manner as you create other types of
specifications. See "Creating New Specifications" for more information.

When working with Media Stream specifications, see "Media Stream Specification Editor" for
reference information about the tabs you use to define a Media Stream specification.

Media Stream Specification Editor

ORACLE

You use the Media Stream Specification editor to model media streams. When working with the
Media Stream Specification editor, see the following topics:

e Specification Editor Characteristics Tab

e Specification Editor Specification Properties Tab

e Specification Editor Related Specifications Tab

e Specification Editor Configuration Spec Usage Tab
e Specification Editor Rules Tab

e Specification Editor Layouts Tab

e Specification Editor Media Tab

e Specification Editor Extends Tab

e Specification Editor Tags Tab
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Working with Sequence and Entity
|dentification Specifications

In Oracle Communications Service Catalog and Design - Design Studio, you can customize
business entity identification generation using Entity Identification specifications. You can use
Sequence specifications to customize the sequence of an ID for an entity, by defining the
maximum, minimum and increment values for the sequence.

Additionally, you can define and use Sequence specifications independent of Entity
Identification specifications. You can create sequence specifications to define sequences used
in custom logic (in rulesets and extension points) that you write to generate numeric identifiers.

When working with Entity Identification and Sequence specifications, see the following topics:

*  Working with Entity Identification Specifications

*  Working with Sequence Specifications

Working with Entity Identification Specifications

Using Design Studio, you can configure business entities so that when instances are created in
Oracle Communications Unified Inventory Management (UIM), the entity IDs are generated
automatically. By default, the ID is a numeric sequence number. You can also customize the 1D
generation by defining an Entity Identification specification and associating it to an entity
specification.

Entity Identification specifications enable you to define alphanumeric prefixes and suffixes,
which are added to numeric sequence values to form ID values for entities.

An Entity Identification specification must be associated with a Sequence specification. The
Sequence specification defines the minimum, maximum, and increment values that UIM uses
to generate the numeric sequence value segment of the entity ID. See "Working with
Sequence Specifications” for more information.

You can associate an Entity Identification specification to one or multiple entity specifications to
define how UIM creates entity IDs when you create an entity using those specifications.

When working with Entity Identification specifications, see the following topics:

«  Configuring an Entity Identification Specification

«  Entity Identification Specification Editor

Configuring an Entity Identification Specification

After you create an Entity Identification specification, you must configure it.
To configure an entity identification specification:

1. Open an existing Entity Identification or create a new Entity Identification specification.
See "Creating New Specifications" for more information.

2. Inthe Entity Identification Specification editor, click the Specification Properties tab.
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Enter the start date, end date, and description.
Click the Properties tab.

(Optional) In the Prefix field, enter an alphanumeric sequence of characters to append to
the beginning of the numeric sequence of the ID value.

(Optional) In the Suffix field, enter an alphanumeric sequence of characters to append to
the end of the numeric sequence of the ID value.

Do any one of the following:

» Click Sequence Specification to create a new Sequence specification.
« Click Select to select an existing Sequence specification.

» Click Clear to remove a previously associated Sequence specification.

From the File menu, select Save.

Related Topics

Entity Identification Specification Editor

Entity Identification Specification Editor

Use the Entity Identification Specification editor to define how ID values are created for an
entity when the ID is generated automatically.

When working with the Entity Identification Specification editor, see the following topics:

Specification Editor Specification Properties Tab

Entity Identification Specification Editor Properties Tab

Entity Identification Specification Editor Properties Tab

ORACLE

Use the Properties tab to create, select, and remove a Sequence specification. This tab also
enables you to specify a prefix or a suffix for an entity specification.

Field Use

Prefix Specify an alphanumeric sequence of characters

to append to the beginning of the numeric
sequence of the ID value.

Suffix Specify an alphanumeric sequence of characters
to append to the end of the numeric sequence of
the ID value.

Sequence specification Displays the name of the Sequence specification.
Click to create a new Sequence specification.

Select Click to select an existing Sequence specification.

Clear Click to remove the association of Sequence
specification.

Related Topics

Configuring an Entity Identification Specification

Entity Identification Specification Editor
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Working with Sequence Specifications

You use Sequence specifications with Entity Identification specifications to customize the
sequence of an ID for an entity, by defining the maximum, minimum and increment values for
the sequence.

Additionally, you can define and use Sequence specifications independent of Entity
Identification specifications. You can create sequence specifications to define sequences used
in custom logic (in rulesets and extension points) that you write to generate numeric identifiers.
For example, you can create sequence specifications for serial numbers or connection IDs.
See UIM Developer's Guide for more information.

When working with Sequence specifications, see the following topics:

»  Configuring a Sequence Specification

e Sequence Specification Editor

Configuring a Sequence Specification

After you create a sequence specification, you must configure it.
To configure a sequence specification:

1. Open an existing Sequence specification or create a new Sequence specification.
See "Creating New Specifications" for more information.

In the Sequence Specification editor, click the Specification Properties tab.
Enter the start date, end date, and description.

Click the Properties tab.

Enter the minimum value, maximum value, and increment value.

© g & w Db

From the File menu, select Save.

Related Topics

Sequence Specification Editor

Sequence Specification Editor

Use the Sequence Specification editor to customize the sequence of an ID for an entity.
When working with the Sequence Specification editor, see the following topics:

e Specification Editor Specification Properties Tab
e Sequence Specification Editor Properties Tab

e Specification Editor Media Tab

Sequence Specification Editor Properties Tab

Use the Properties tab to set a minimum, maximum, and an increment value for a sequence.
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Field Use
Minimum Value Enter a minimum value for the sequence.
Maximum Value Enter a maximum value for the sequence.

Retain the default value 0 to define the sequence
value as unbounded.

Increment Value Enter an increment value for the sequence.

Related Topics
Configuring a Sequence Specification

Sequence Specification Editor
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Working with Rulesets and Extension Points

In Oracle Communications Unified Inventory Management (UIM), rulesets and extension points
are used to extend or customize UIM behavior at run time. Rulesets contain application
business logic, and extension points define where in the application (which methods on
classes) rulesets can be run.

For example, if you are working with related specifications, you can add rulesets that
automatically create entity instances from a child specification when an instance of the entity is
created from a parent specification.

You can create combinations of rulesets and extension points and apply the combinations to
UIM specifications so a ruleset runs at the associated extension point if it is acting on an entity
created from one of the specifications. See "Associating Specification-Based Extension Points
to Rulesets” for more information.

You can also create combinations of rulesets and extension points that apply globally. In this
scenario, the ruleset always runs at the associated extension point (for all specifications). See
"Associating Global Extension Points with Rulesets" for more information.

When working with rulesets and extension points, see the following topics:

¢ Working with Rulesets
e Working with Extension Points

¢ Working with Ruleset Extension Points

Working with Rulesets

You use rulesets to control actions on certain entities at certain times and when conditions are
met. You code business logic in a ruleset and you can run a ruleset at multiple extension
points. For example, you might define a ruleset to make a telephone number field's edit mask
to be ### - ### - #### at creation time for all telephone numbers based on the North American
Telephone Number specification.

You use rulesets to extend and customize UIM by associating an extension point to a ruleset.
Rulesets provide a capability to modify the business logic at run time.

When working with rulesets, see the following topics:

e Creating Rulesets
¢ Configuring Rulesets

¢ Ruleset Editor

Creating Rulesets

ORACLE

You create rulesets to control actions on entities at specific times and under specific conditions.
To create a ruleset:

1. From the Studio menu, select New, then select Inventory, then select Administration,
and then select Ruleset.
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The Ruleset Wizard dialog box appears.
2. From the Project drop-down list, select the project where the entity is to reside.

3. In the Name field, enter the name of the ruleset.

# Note:

For a ruleset entity, the text editor forces you to enter all capitals. Use
underscores for readability, such as MY_RULE_SET.

4. (Optional) Select a location for the new ruleset.

By default, Oracle Communications Service Catalog and Design - Design Studio saves the
entity to your default workspace location. You can enter a folder name in the Folder field or
select a location different from the system-provided default. To select a different location:

a. Click the Folder field Browse button.
b. Navigate to the directory in which to save the entity.
c. Click OK.

5. Click Finish.

Related Topics
Configuring Rulesets

Ruleset Editor

Configuring Rulesets

After you create a ruleset, you must configure it.
To configure a ruleset:

1. Open an existing ruleset or create a new one.
See "Creating Rulesets" for more information.

2. Click the Run Extension Language list arrow and select DROOLS or GROOVY,
depending on which extension language you plan to use.

3. Click Edit Drools Code or click Edit Groovy Code, depending on which extension
language you plan to use.

An empty DRL or GROOQOVY file opens.

# Note:

Oracle recommends that you download the Drools or Groovy text editor and
configure Design Studio to use the editor. The text editors can catch syntax
errors that can be corrected as you write the ruleset, rather than waiting to catch
the errors at compilation.

4, Write the ruleset.

See UIM Developer's Guide for detailed information about writing a ruleset.
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5. From the File menu select Save, then close the DRL or GROOVY file.

6. From the File select Save again to save the ruleset.

Ruleset Editor

Use the Ruleset editor to create and configure rulesets.

When using the Ruleset editor to create or configure a ruleset, see the following topics:

¢ Ruleset Editor Code Tab

¢ Ruleset Editor Realization Tab

Ruleset Editor Code Tab

Use the Ruleset editor Code tab to create rulesets in a DRL or GROOVY file.

Field

Use

Run Extension
Language

Click to select which extension language to run at runtime. Your choices are
DROOLS or GROOVY.

Edit Drools Code

Click to write a ruleset in a DRL file.

Edit Groovy Code

Click to write a ruleset in a GROOQVY file.

Related Topics
Working with Rulesets
Creating Rulesets
Configuring Rulesets

Ruleset Editor

Ruleset Editor Realization Tab

Use the Ruleset editor Realization tab to associate rulesets with a conceptual model service

ORACLE

action.
Field Use
Realizes Click to open the selected service action in the Action editor.
Select Associates the ruleset with a conceptual model service action. To select from

the available conceptual model service actions, there must be a dependency
defined between your Inventory cartridge project and the Model project in
which your conceptual model is saved. See “Managing Project Dependencies"
for more information.

Related Topics

Working with Conceptual Models

Working with Rulesets

Creating Rulesets

Configuring Rulesets
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Ruleset Editor

Working with Extension Points

An extension point represents a method on a Java class where a ruleset can be run. These
methods can be extended by associating an executable ruleset to the extension point.

When working with extension points, see the following topics:

*  About Extension Points

* Creating Extension Points

e Configuring Extension Points

* Associating Specification-Based Extension Points to Rulesets
e Associating Global Extension Points with Rulesets

«  Extension Point Editor

About Extension Points

An extension point represents a method on a Java class where a ruleset can be run. These
methods can be extended by associating an executable ruleset to the extension point. UIM
provides several extension points, and a way for you to create new extension points.

There are two types of extension points that you can create in Design Studio:

e Specification-based extension points define methods where an associated ruleset can be
run, but only when working with entities created from specific specifications.

e Global extension points define methods where an associated ruleset can be run, and
which do not pertain to any particular specification. Rulesets associated with global
extension points are triggered by all specifications.

Related Topics

Creating Extension Points

Configuring Extension Points

Associating Specification-Based Extension Points to Rulesets

Associating Global Extension Points with Rulesets

Creating Extension Points

ORACLE

An extension point represents a method on a Java class where a ruleset can be run. These
methods can be extended by associating an executable ruleset to the extension point.

To create an extension point:

1. From the Studio menu, select New, then select Inventory, then select Administration,
and then select Extension Point.

The Extension Point Wizard dialog box appears.
2. From the Project drop-down list, select the project where the entity is to reside.
3. Inthe Name field, enter the name of the extension point.

4. (Optional) Select a location for the new extension point.
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By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.
b. Navigate to the directory in which to save the entity.
c. Click OK.

5. Click Finish.

Related Topics
About Extension Points

Configuring Extension Points

Extension Point Editor

Configuring Extension Points

ORACLE

After you create an extension point, you must configure it. When you configure an extension
point in Design Studio, the data you enter is saved to the cartridge.

To configure an extension point:

1. Open an existing Extension Point entity or create a new one.
See "Creating Extension Points" for more information.
2. Inthe Point Name field, enter the name of the extension point.

Oracle recommends the point name be represented as ClassName_methodName. Eclipse
does not allow a period in a text field, so the standard notation of
ClassName.methodName cannot be entered.

3. Inthe Description field, enter a brief description of the extension point.
The description describes the method defined by the point name.

4. (Optional) Select Global if the extension point will not be associated with a specific
specification type (or with a specific set of specifications).

5. Inthe Signature field, enter the signature of the method defined by the point name.
e The signature includes the return value, method name, and all parameters.
e The signature requires that all objects be fully qualified.
e The signature must be an abstract interface.

e Signatures that define arrays must use the notation of “[]" to represent the array of
objects. The notation of “..." to represent an array of objects is not recognized by the
AspectJ framework.

e Signatures that define an array of objects as a parameter must contain the keyword
transient. The AspectJ framework requires this keyword to retrieve the extension point.

6. From the File menu, select Save.
7. Create an aop.xml file and define the extension point within the file.

See UIM Developer's Guide for more information on creating the aop.xml file.
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Related Topics

About Extension Points

Associating Specification-Based Extension Points to Rulesets
Associating Global Extension Points with Rulesets

Extension Point Editor

Associating Specification-Based Extension Points to Rulesets

You can create combinations of rulesets and extension points and associate the combinations
to UIM specifications so that a ruleset runs at the associated extension point only if it is acting
on an entity created from one of the associated specifications.

To associate specification-based extension points to rulesets:

1. Create and configure a ruleset.
See "Working with Rulesets" for more information.
2. Create an extension point.
See "Creating Extension Points" for more information.
3. Create and configure enabled extension points for one or multiple specification classes.
See "Working with Enabled Extension Points" for more information.
4. Create and configure a ruleset extension point.
See "Working with Ruleset Extension Points" for more information.

After you associate a specification-based extension point to a ruleset, you associate the ruleset
extension point to a specific instance of a specification in Design Studio. See "Associating
Specification-Based Ruleset Extension Points to Specifications" for more information.

Working with Enabled Extension Points

An enabled extension point identifies the specification entity class on which a specification-
based extension point can be used. You must create an enabled extension point for each type
of entity specification for which you use the extension point. For example, if you plan to use an
extension point on equipment specifications and logical device specifications, you must create
two enabled extension points for the extension point; one that identifies the
EquipmentSpecification class, and one that identifies the LogicalDeviceSpecification class.

When working with enabled extension points, see the following topics:

e Creating Enabled Extension Points
e Configuring Enabled Extension Points

* Enabled Extension Point Editor

Creating Enabled Extension Points

An enabled extension point associates a Java class entity specification to an extension point.
You can create an enabled extension point in Design Studio.

To create an enabled extension point:
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1. From the Studio menu, select New, then select Inventory, then select Administration,
and then select Enabled Extension Point.

The Enabled Extension Point Wizard dialog box appears.
2. From the Project drop-down list, select the project where the entity is to reside.
3. Inthe Name field, enter the name of the enabled extension point.
4. (Optional) Select a location for the new enabled extension point.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.
b. Navigate to the directory in which to save the entity.
c. Click OK.

5. Click Finish.

Related Topics
Configuring Enabled Extension Points

Enabled Extension Point Editor

Configuring Enabled Extension Points
After you create an enabled extension point, you must configure it.
To configure an enabled extension point:

1. Inthe Solution view, double-click an enabled extension point.
The Enabled Extension Point editor appears.
2. From the Specification Class Name list, select a Java class for the specification.

When configuring an enabled extension point for a configuration specification, you must
select the InventoryConfigurationSpec Java class, which enables the Configuration
Version Instance Type field to identify the configurable entity.

See "Enabled Extension Point Editor" for more information.

3. (Optional) If you selected InventoryConfigurationSpec from the Specification Class
Name list and you want to enable the extension point for a specific configurable entity,
select a configuration version Java DAO class from the Configuration Version Instance
Type list. If you do not select a class, all configurable entities are enabled.

See "Enabled Extension Point Editor" for more information.

4. In the Point field, select an existing extension point or create a new one.
See "Creating Enabled Extension Points" for more information.

Related Topics

Enabled Extension Point Editor

Enabled Extension Point Editor

Use to define the specification entity class on which a specification-based extension point can
be used.
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Field

Use

Specification Class Name

Select the fully qualified entity specification Java class.

Nearly all Inventory entities are recognizable by their Java
class name. For example, the Telephone Number Specification
entity appears in the list as
oracle.communications.inventory.api.entity.TelephoneNu
mberSpecification, and the Equipment Specification entity
appears in the list as
oracle.communcations.inventory.api.entity.EquipmentSpe
cification.

The only exceptions to this recognizable naming convention
are the configuration specifications, which are:

*  Flow Interface Configuration specification

e Logical Device Configuration specification

e Logical Device Account Configuration specification

e Network Configuration specification

*  Pipe Configuration specification

*  Place Configuration specification

e Service Configuration specification

To enable an extension point for a configuration specification,
you must select the
oracle.communications.inventory.api.entity.lnventoryConfi
gurationSpec class, which enables the Configuration
Version Instance Type list.

Configuration Version Instance Type

The Configuration Version Instance Type list is enabled only
when you select
oracle.communications.inventory.api.entity.InventoryConfi
gurationSpec from the Specification Class Name field.

(Optional) To enable an extension point for a specific entity
configuration specification, select the configuration version
DAO class for the configurable entity, which is recognizable by
its Java class name. For example, the Logical Device
Configuration specification entity appears in the list as
oracle.communications.platform.entity.impl.LogicalDevice
ConfigurationVersionDAO, and the Service Configuration
specification entity appears in the list as
oracle.communications.platform.entity.impl.ServiceConfig
urationVersionDAO.

If enabled, and you do not select a value for Configuration
Version Instance Type, the extension point is enabled for all
entity configuration specifications.

Point Displays the name of the selected extension point. Click Point
to create a new extension point.

Select Click to select an existing extension point.

Clear Click to remove a previously selected extension point.

Related Topics

Configuring Enabled Extension Points

Associating Specification-Based Extension Points to Rulesets
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Associating Global Extension Points with Rulesets

You can create combinations of global extension points and ruleset associations if you want
rulesets to run at the associated extension point for all specifications.

To associate global extension points to rulesets:

1. Create and configure a ruleset.

See "Working with Rulesets" for more information.
2. Create an extension point.

See "Creating Extension Points" for more information.
3. Create and configure a ruleset extension point.

See "Working with Ruleset Extension Points" for more information.

Extension Point Editor

Use the Extension Point editor to define point names, descriptions, and method signatures for
extension points.

Field Use

Point Name Enter a name for the extension point.

Description Enter a description for the extension point.

Global Select if the extension point will not be associated with a
specific specification type (or with a specific set of
specifications).

Signature Define a method signature for an extension point.

Related Topics
Configuring Enabled Extension Points
Associating Specification-Based Extension Points to Rulesets

Associating Global Extension Points with Rulesets

Working with Ruleset Extension Points

ORACLE

A ruleset extension point associates a ruleset with an extension point and defines whether the
ruleset runs before, after, or instead of the method defined by the extension point.

To define an ruleset extension point, see the following:

e About Ruleset Extension Points

e Creating Ruleset Extension Points

*  Configuring Ruleset Extension Points

* Associating Specification-Based Ruleset Extension Points to Specifications
* Ruleset Extension Point Editor

¢ Ruleset Extension Point-Global Editor
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About Ruleset Extension Points

A ruleset extension point associates a ruleset with an extension point and defines whether the
ruleset runs before, after, or instead of the method defined by the extension point.

There are two types of ruleset extension points, and the type determines which of the two
Ruleset Extension Point editors you use.

»  Specification-based ruleset extension points associate a ruleset with a specification-based
extension point. You use the "Ruleset Extension Point Editor" when configuring these types
of ruleset extension points.

* Global ruleset extension points associate a ruleset with a global extension point. You use
the "Ruleset Extension Point-Global Editor" when configuring these types of ruleset
extension points.

Related Topics
Creating Ruleset Extension Points
Configuring Ruleset Extension Points

Working with Extension Points

Creating Ruleset Extension Points

ORACLE

The ruleset extension point associates an extension point to a ruleset, and defines the
placement of the ruleset.

To create a ruleset extension point:

1. From the Studio menu, select New, then select Inventory, then select Administration,
and then do one of the following:

» Select Ruleset Extension Point to associate a ruleset with a specification-based
extension point.

* Select Ruleset Extension Point-Global to associate a ruleset with a global extension
point.

Depending on your selection, the Ruleset Extension Point Wizard or Ruleset Extension
Point-Global Wizard appears.

2. From the Project drop-down list, select the project where the entity is to reside.
3. Inthe Name field, enter the name of the ruleset extension point.
4. (Optional) Select a location for the new ruleset extension point.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.
b. Navigate to the directory in which to save the entity.
c. Click OK.

5. Click Finish.

19-10



Chapter 19
Working with Ruleset Extension Points

Related Topics

Configuring Ruleset Extension Points

Ruleset Extension Point Editor

Ruleset Extension Point-Global Editor

Configuring Ruleset Extension Points

After you create a ruleset extension point, you must configure it.

To configure a ruleset extension point:

1.

Open an existing ruleset extension point or create a new one.

See "Creating Ruleset Extension Points" for more information.

In the Ruleset field, do one of the following:

e Click Ruleset to create a new ruleset. See "Creating Rulesets" for more information.

e Click Select to select an existing ruleset. The Ruleset dialog box appears, displaying
all available rulesets.

In the Point field, do one of the following:

e Click Point to create a new extension point. See "Creating Extension Points" for more
information.

e Click Select to select an existing extension point. The Extension Point dialog box
appears, displaying all available extension points. The list displays only those
extension points that are applicable to the type of ruleset extension point. For example,
if you are configuring the ruleset in the Ruleset Extension Point-Global editor, only
those extension points defined as global appear in the list. See "Working with
Extension Points" for more information.

In the Placement field, define whether the ruleset runs before, after, or instead of the
method defined by the extension point.

See "Ruleset Extension Point Editor"or "Ruleset Extension Point-Global Editor" for more
information about this field.

From the File menu, select Save.

Associating Specification-Based Ruleset Extension Points to Specifications

Ruleset extension points must be associated with an instance of a specification in order to run.
This is not applicable to global ruleset extension points (rulesets at a global extension point
can run without being associated to a specification).

ORACLE

To associate specification-based ruleset extension points to specifications:

1.

Navigate to the editor of an existing specification to which you want to associate a ruleset
extension point.

Click the Rules tab.
Do one of the following:
* Click Select to select an existing ruleset extension point.

« Click Add to create and select a new ruleset extension point. See "Creating Ruleset
Extension Points" for more information. When you have completed working on the new
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ruleset extension point, return to the editor of the specification to which you want to
associate this ruleset.

*  Select a ruleset extension point in the table and click Open to view the ruleset
extension point in the Ruleset Extension Point editor.

» Select a ruleset extension point in the table and click Remove to delete the
association.

4, From the File menu, select Save.

See UIM Developer's Guide for more information.

Ruleset Extension Point Editor

Use to associate a ruleset with a specification-based extension point, and to define the custom
code placement.

Field Use

Ruleset Do one of the following:

e Click Ruleset to create a new ruleset.

e Click Select to select an existing ruleset.

e Click Clear to remove a previously selected ruleset.

Point Do one of the following:
e Click Point to create a new specification-based extension
point.

*  Click Select to select an existing specification-based
extension point.

e Click Clear to remove a previously selected specification-
based extension point.

See "Working with Extension Points" for more information.

Placement Define whether the ruleset runs before, after, or instead of the
method defined by the extension point.

e Select Before to run the ruleset before the method
specified by the signature. For an extension point of type
call, the custom code is weaved before the call to the
method. For an extension point of type execution, the
custom code is weaved within the method before the first
line of executable code.

e Select After to run the ruleset after the method specified
by the signature. For an extension point of type call, the
custom code is weaved after the call to the method. For
an extension point of type execution, the custom code is
weaved within the method after the last line of executable
code.

e Select Instead to run the ruleset instead of the method
specified by the signature. For an extension point of type
call, the custom code is weaved in place of the call to the
method. For an extension point of type execution, the
custom code is weaved within the method in place of the
executable code.

Related Topics
Configuring Ruleset Extension Points

Associating Specification-Based Extension Points to Rulesets
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Use to associate a ruleset with a global extension point, and to define the custom code

ORACLE

placement.
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Field

Use

Ruleset

Do one of the following:

Click Ruleset to create a new ruleset. See "Creating
Ruleset Extension Points" for more information.

Click Select to select an existing ruleset. The Ruleset
dialog box appears, displaying all available rulesets.
Click Clear to remove a previously selected ruleset.

Point

Do one of the following:

See "Working with Extension Points" for more information.

Click Point to create a new global extension point. See
"Creating Extension Points" for more information.

Click Select to select an existing global extension point.
The Extension Point dialog box appears, displaying all
available global extension points.

Click Clear to remove a previously selected extension
points.

Placement

Define whether the ruleset runs before, after, or instead of the
method defined by the global extension point.

Select Before to run the ruleset before the method
specified by the signature. For an extension point of type
call, the custom code is weaved before the call to the
method. For an extension point of type execution, the
custom code is weaved within the method before the first
line of executable code.

Select After to run the ruleset after the method specified
by the signature. For an extension point of type call, the
custom code is weaved after the call to the method. For
an extension point of type execution, the custom code is
weaved within the method after the last line of executable
code.

Select Instead to run the ruleset instead of the method
specified by the signature. For an extension point of type
call, the custom code is weaved in place of the call to the
method. For an extension point of type execution, the
custom code is weaved within the method in place of the
executable code.

Related Topics

Associating Global Extension Points with Rulesets

Configuring Ruleset Extension Points
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Managing and Extending Cartridge Packs and
Cartridges

Oracle Communications Service Catalog and Design - Design Studio packages project
information into cartridges that can be deployed into Oracle Communications Unified Inventory
Management (UIM). Cartridges can contain small amounts of data, such as one specification,
or can be large collections of many specifications.

Cartridges can be developed by customers, systems integrators, Professional Services staff,
and third-party vendors. In addition, Oracle provides cartridge packs, which are packages of
one or more cartridges that model inventory for a particular technology.

When managing and extending cartridge packs and cartridge projects, see the following topics:

e About Cartridge Packs and Cartridges
« Extending Cartridge Packs and Cartridges
e Working with UIM Cartridge Projects

About Cartridge Packs and Cartridges

ORACLE

A cartridge is an application component delivered with a product, cartridge pack, or solution.
Cartridges are typically packaged in a JAR format. Cartridge packs are packages of cartridges
developed by Oracle.

Technology Pack Description

Base cartridges Provide basic content required by many other cartridges and cartridge packs.
Delivered in the core UIM package and installed at the following location:

UIM_Home/cartridges/base folder
See UIM Cartridge Guide for more information.

Sample cartridges Include sample specifications, extensions, rulesets, and code. You can use
them as a reference or as a starting point for your own development. Installed at
the following location:

UIM_Home/cartridges/sample folder

Product cartridge Separately licensed products developed and supported by Oracle

packs Communications to model inventory for specific technology domains, such as
Consumer VolP or MPLS L3 VPNSs. Available on the Oracle software delivery
website.

You can install cartridge packs without modification into UIM. This is usually the case for base
cartridges. Cartridge packs include multiple cartridges, and these cartridges may have
dependencies on each other. In this case, they must be installed in a particular order. See UIM
Installation Guide, the UIM online Help, and the guides for individual product cartridge packs
for more information about installation.

You can also extend cartridge packs and cartridges. See "Extending Cartridge Packs and
Cartridges" for more information.
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Extending Cartridge Packs and Cartridges

You can extend cartridge packs and cartridges to include new specifications, characteristics,
and rulesets. You can also introduce new behaviors into the model provided by a cartridge
pack by taking advantage of stub rulesets.

# Note:

To ensure that extensions are upgradeable and supportable, follow the guidelines
and policies described in UIM Developer's Guide. In most cases, you extend
cartridge packs by adding content in supplemental cartridges that you create.

When extending cartridge packs, see the following topics:

Extending Cartridge Packs and Cartridges by Adding Content
Extending Cartridge Packs and Cartridges by Replacing Stub Rulesets
Extending Cartridge Packs and Cartridges by Renaming

Extending Cartridge Packs and Cartridges by Adding Content

You can extend cartridge packs and cartridges by creating new, related content in a separate
project. When you install the cartridge pack or cartridge into UIM and then install your
supplemental cartridge, the additional content becomes available.

ORACLE

There are several ways to add content:

By creating new specifications to represent additional resources in the model. For
example, if the cartridge pack or cartridge does not include specifications for all of the
specific types of equipment and physical devices you use, you can create specifications for
them. If the new specifications are similar to specifications in the cartridge pack or
cartridge, you can copy the existing specifications into your project and make any
necessary modifications. Design Studio forces you to rename the copies. See "Copying
Specifications" for more information.

By creating new specifications that are upwardly related to specifications in the cartridge
pack or cartridge. Three types of upward relationships are possible:

— From an entity specification to another entity specification in a cartridge pack or
cartridge. For example, you can create an upward relationship from a Device Interface
specification you create to a Logical Device specification in a cartridge pack or
cartridge.

— From an entity specification to a configuration item in the cartridge pack or cartridge.
For example, you can create an upward relationship from a Telephone Number
specification you create to a configuration item in a configuration specification that is
part of a cartridge pack or cartridge. See "Defining Configuration Specification Usage"
for more information.

— From an configuration specification to a parent entity specification in a cartridge pack.
For example, you can create an ADSL2Plus Service Configuration specification and
relate it to a DSL Service specification in a cartridge pack.

See "Defining Specification Relationships" for more information about relating
specifications.
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* By creating new entity-level characteristics for an IP Address Resource or Property
Location Extension entity. When you define entity-level characteristics for these extension
entities, those characteristics apply to all instances of the entity in the run-time
environment. See "Extending Predefined Specifications" for more information.

When you create a dependency between a specification in your own cartridge and a
specification in a cartridge pack or cartridge, both cartridges must exist in the same workspace.
Additionally, you must import into the workspace all cartridges on which the cartridge pack or
cartridge depends.

Extending Predefined Specifications

ORACLE

Some UIM entities are defined by a single predefined specification rather than by specifications
that you design. To extend these entities, you can define entity-level characteristics. You add
the entity-level characteristics to extension specifications for these entities:

e Channelized Connectivity Extension (included for backward compatibility with previous
versions)

e Managed Project Extension
* IP Address Resource Extension
e Property Location Extension entities

When you define entity-level characteristics for these specifications and deploy the cartridge
that contains them to UIM, the characteristics apply to all entities based on the specifications.

# Note:

You must import the ora_uim_basespecifications cartridge before you define
characteristics for the extension entities. See UIM Cartridge Guide for information
about the ora_uim_basespecifications cartridge.

To extend Design Studio for Inventory entities:

1. From the Studio menu, select New, then select Inventory, then select Extend Entity, and
then select the type of entity to extend.

You can extend Channelized Connectivity Extension, IP Address Resource Extension, or
Property Location Extension entities. After you make a selection, the Entity Extension
Wizard appears.

2. Inthe Project field, select the name of the project to which the new specification should be
added.

3. (IP Address Resource Extension only) From the IP Resource Type list, select
IPv4Network, IPv4Subnet, IPv4Address, IPv6Network, IPv6Subnet, or IPv6Address.

4. (Optional) Select a location for the new specification.

By default, Design Studio saves the entity to your default workspace location. You can
enter a folder name in the Folder field or select a location different from the system-
provided default. To select a different location:

a. Click the Folder field Browse button.
b. Navigate to the directory in which to save the entity.
c. Click OK.
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Click Finish.

Design Studio creates the new entity and displays its information in an Entity Extension
editor.

In the Entity Extension editor Characteristics tab, right-click and select Add
Characteristic or Select Characteristic.

See "Creating Characteristics from the Specification Editor" for information about creating
new characteristics, and see "Adding Characteristics to Specifications" for information
about selecting existing characteristics.

(Optional) Define the layout for the entity extension.
See "Specification Editor Layouts Tab" for more information.

(Optional) Define user interface hints for the entity-level characteristics for the entity
extension.

See "Specification Editor Layouts Tab" for more information.

(Optional) If a characteristic is defined with enumerations, define a set of data values for
the entity-level characteristic.

You can exclude enumerations defined at the schema level or add additional
enumerations. See "Characteristics Tab Data Values Subtab" for more information.

(Property Location Extension only) In the Entity Extension editor Rules tab, do one of the
following:

* Click Select to select an existing ruleset extension point.

« Click Add to create and select a new ruleset extension point. See "Creating Ruleset
Extension Points" for more information.

*  Select a ruleset extension point in the table and click Open to view the ruleset
extension point in the Ruleset Extension Point editor.

» Select a ruleset extension point in the table and click Remove to delete the
association.

Click Save.

Entity Extension Editor

You use the Entity Extension editor to create new entity-level characteristics for a Channelized
Connectivity Extension, IP Address Resource Extension, or Property Location Extension entity.

When extending these entities, see the following topics:

Specification Editor Characteristics Tab
Specification Editor Layouts Tab
Specification Editor Rules Tab
Specification Editor Tags Tab

(The Rules tab is not available for Channelized Connectivity Extension.)

Extending Cartridge Packs and Cartridges by Replacing Stub Rulesets

You can extend a cartridge pack or cartridge by replacing stub rulesets with rulesets you
create. Stub rulesets have no default logic associated with them. When you replace a stub,
your logic runs at the extension point associated with the ruleset. Stub rulesets typically
provide opportunities to extended validation and auto-allocation.

ORACLE
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You give your ruleset the same name as the original in the cartridge pack. When you install

your cartridge into UIM, your version of the stub ruleset overwrites the stub ruleset installed

with the cartridge pack. Because Design Studio requires uniqgue names within a workspace,
you must create your ruleset in a workspace that does not include the cartridge pack project
with the stub.

Alternatively, instead of having a separate workspace, you can just close the other project that
includes the entity with the same name.

See "Working with Rulesets" for more information about working with rulesets.

Extending Cartridge Packs and Cartridges by Renaming

ORACLE

You can extend cartridge packs and cartridges by renaming the original cartridge pack or
cartridge and refactoring all existing objects. Oracle recommends that you use this method
only when you are not able to extend the cartridge pack or cartridge by adding new content to
your own project.

# Note:

When you intend to rename a cartridge pack or cartridge, do not deploy the original
cartridge pack or cartridge into UIM.

To extend cartridge packs and cartridges by renaming:

1. Create a backup of the cartridge pack or cartridge.

2. Import all dependent projects into the workspace, then import the cartridge pack or
cartridge.

See “Importing Projects" for more information.

3. Build the cartridge pack or cartridge and all dependent projects and resolve all problem
markers.

See “Building and Packaging Projects" for more information.
4. From the Studio menu, select Show Design Perspective.

5. From the Studio Projects view, double-click the Project entity for the cartridge pack or
cartridge.

The entity opens in the Project editor.
6. On the Properties tab, click Unseal.

The Unseal Project confirmation dialog box appears.
7. Click OK.
8. Build the unsealed cartridge pack or cartridge project.

9. From the Studio Projects view, right-click the cartridge pack or cartridge and select
Rename.

The Refactoring dialog box appears.
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# Note:

Always rename cartridge packs or cartridges from the Studio Projects view.

10. In the Name field, enter a new name for the cartridge pack or cartridge then click Next.

Design Studio lists all of the changes to be performed. Ensure that all of the instances are
selected.

11. Click Finish and when prompted click OK.
Design Studio closes and restarts.

12. After Design Studio reopens, build all sample and dependent cartridges and fix all problem
markers.

13. Change the package reference to remove “Oracle" from the class packaging.
Removing this reference ensures that there are no collisions at run time.
a. From the Window menu, select Open Perspective and then select Java.
The Java perspective appears.
b. Inthe Package Explorer view, navigate to and open the cartridge src folder.
c. Remove the Oracle reference from the class packaging.

14. (Optional) If projects in the workspace have dependencies on the original cartridge, import
the original cartridge back into the workspace.

Working with UIM Cartridge Projects

In Design Studio, a cartridge is a collection of components that you deploy into a run-time
environment to support your business processes. You create Cartridge projects to contain the
specifications and code that you develop. Each Cartridge project is mapped to directories in
the file system and is a collection of files and folders.

You can import existing Cartridge projects into your workspace (for example, you can import
Cartridge projects from a cartridge pack) or you can create new Cartridge projects in Design
Studio.

When working with Inventory Cartridge projects, see the following topics:
e About Imported Inventory Cartridge Projects

e About New UIM Cartridge Projects

e About Inventory Cartridge Project Dependencies

» Deploying Inventory Cartridge Projects

e Configuring the UIM Project Library List

About Imported Inventory Cartridge Projects

ORACLE

You can import existing Cartridge projects into Design Studio. Cartridges that include
customizable Java source code are packaged in a ZIP file. You can import the ZIP file or
extract the ZIP file to a folder and import the Cartridge project from the folder. When you import
a cartridge, it becomes a Cartridge project in the current workspace. See “Importing Projects"
for more information about importing Inventory Cartridge projects.

20-6



Chapter 20
Working with UIM Cartridge Projects

If you import a cartridge from a cartridge pack or a cartridge that has been protected by its
creator, it will be sealed. Sealed cartridges cannot be modified without first being unsealed.
See “Sealing Projects” and “Unsealing Projects" for more information.

Cartridges with dependencies will display errors when you import them without the required
cartridges already being present in the workspace. For example, if you import a cartridge that
requires one of the base cartridges, you will see errors. After all the cartridges have been
imported, you can clean all the projects to remove the errors. See “Reviewing the Error Log",
“Problems View", and “Running Clean Builds" for more information. See “Importing Projects
into Design Studio using Root Directories" for more information about importing existing
projects into a workspace.

About New UIM Cartridge Projects

You can create new Cartridge projects in Design Studio. For example, you may create a
Cartridge project that contains all characteristics, another that contains all specifications, and
so forth. Everything you create in Design Studio (characteristics, specifications, and rulesets,
for example) resides in a project. The name you choose for a Cartridge project becomes the
name of a JAR file, and everything you create within that project is automatically placed in the
JAR file.

See “Creating New Cartridge Projects" for more information about creating cartridge projects in
Design Studio.

See “Project Editor" for information about the tabs you use to define an Inventory cartridge
project. See “Reviewing the Error Log" and “Problems View" for more information about
resolving project errors and warnings.

About Inventory Cartridge Project Dependencies

Inventory projects have dependencies on other projects when entities in one project reference
entities in a different project. For example, an Inventory project might reference data elements
defined in a common model project.

If you configure a project to reference content in other projects without declaring project
dependencies, Design Studio creates an error or a warning, depending on how you configured
the diagnostic level (see “Project Editor Dependency Tab" for more information about
configuring the diagnostic level). Design Studio filters data that appears in dialog boxes and
views based on project dependencies.

All Inventory cartridge projects have a dependency on the ora_uim_maodel project. You must
import and open the ora_uim_model and ora_uim_mds projects in your workspace before
modeling UIM entities in Design Studio.

# Note:

Import the ora_uim_mds_cartproj.zip and ora_uim_model_cartproj.zip cartridge
project archive files from the UIM_Homelcartridges/base directory.

The ora_uim_model project is a read-only project that represents the UIM model. It supports
the ability to define specifications and characteristics and is also used to validate which entity
types can be assigned or referenced by configuration items.
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When you create a new Inventory cartridge project, Design Studio adds the ora_uim_model
project to the dependency list on the Inventory Project editor Dependency tab. Do not remove
this dependency.

# Note:

Inventory cartridge projects must be defined with the same target version as the
required model projects in a workspace. Ensure that you import the correct version of
the required model projects into a workspace. See “Defining Cartridge Project Target
Versions" for more information.

See UIM Cartridge Guide for more information about the ora_uim_model project and
the ora_uim_mds project.

Related Topics

Managing Project Dependencies

Deploying Inventory Cartridge Projects

You deploy Design Studio Inventory cartridge projects from the Environment perspective. The
method that you use to deploy cartridge projects is the same for all Design Studio features.
See “Deploying Cartridge Projects" for more information.

If you are deploying into a UIM environment that is a clustered server or where UIM is running
on a managed server that is separate from the administration server, you must define the
wladmin.host.name and wladmin.host.port cartridge management variables. See "Design
Studio for Inventory Cartridge Management Variables Tab" for more information.

Design Studio for Inventory Cartridge Management Variables Tab

ORACLE

Use the Project editor Cartridge Management Variables tab to define the Oracle WebLogic
Server Admin Server IP address and port values. Before you deploy Design Studio for
Inventory Cartridge projects, you must define the default cartridge management variables
wladmin.host.name and wladmin.host.port.

This topic describes the cartridge management variables that are specific to Design Studio for
Inventory. For general information about how to use the tab to add variables, see “Project
Editor Cartridge Management Variables Tab".

Field Use

wladmin.host.name Enter the host name where the WebLogic Server
software resides. Contact your UIM system
administrator to obtain this information.

If you are deploying to an environment where there is
only one server (for example, the application is
deployed to the WebLogic Admin server, use the
same value that you used for the IP address of the
UIM server in the Studio Environment editor

Connection Information tab Address field.

20-8



Chapter 20
Working with UIM Cartridge Projects

Field Use

wladmin.host.port Enter the WebLogic Server port number. Contact your
UIM system administrator to obtain this information.

If you are deploying to an environment where there is
only one server (for example, the application is
deployed to the Admin Server, define this value with
the same value that you defined for port number of
the UIM server in the Studio Environment editor

Connection Information tab Address field.

Related Topics

Studio Environment editor Connection Information Tab

Configuring the UIM Project Library List

ORACLE

Depending on the imported project, you may need to configure the project library list. If the
imported project includes a library list of the files needed to compile the project, the project
library list must be configured to point to a location to pick up the cited files.

To configure the project library list within Design Studio:

1. Select the cartridge in the Studio Projects view.
2. From the Project menu, select Properties.
3. Select Java Build Path.
4. Click the Libraries tab.
The project library list contains all the files needed to compile the project.
The library path for each file starts with UIM_LIB. Therefore, you must:
a. Create a working directory. For example, UIM_LIB.
b. Copy the files from your UIM installation to the working directory you just created.

c. Add a new variable named UIM_LIB that points to this working directory. (The following
steps show how to add the new variable.)

5. Click Add Variable.
The New Variable Classpath Entry dialog box appears.
6. Click Configure Variables.
The Preferences dialog box appears.
7. Click New.
The New Variable Entry dialog box appears.
8. Inthe Name field, enter UIM_LIB.
9. Click Folder and browse to the directory you created in a previous step.
For example, the UIM_LIB directory.
10. Click OK.
The Preferences dialog box appears.
11. Click OK.
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14.
15.
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The Classpath Variables Changed dialog box appears, suggesting that you do a full build
now.

Click No.
The New Variable Classpath Entry dialog box appears.

# Note:

The OK button is not available, and an error displays stating “Variable points
to...". Click Cancel, and the new variable is added successfully.

Click Cancel.
The Properties dialog box appears.
Click OK.

Open the Properties dialog box again to refresh the library list and ensure that the variable
was added successfully.

You should now see the complete path in the build path.
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